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1.1. Getting Started

Welcome to PM Designer
The configuration software for PanelMaster and PanelExpress HMI products

Thank you for purchasing PM Designer. This manual describes PM Designer operation procedures and details about each
feature.

Notes

1) All programs and documentation included with PM Designer (“this product") are the copyright of Cermate Technologies
Incorporation, and are licensed to the user under the Software License Agreement. Any violation of the conditions
described in the Software License Agreement is prohibited under Taiwanese and international laws.

2) Cermate Technologies Incorporation makes every attempt to provide the user with functionality and usability of the
Product and accuracy of its documentation. However, if you should find any errors or omissions in this manual, please
contact Cermate Technologies Incorporation.

3) Regardless of the above provisions, Cermate Technologies Incorporation shall not be held responsible for any
damages or third party claims resulting from the use of this product.

4) Difference may occur between the descriptions found in this manual and the actual functioning of this product. For the
latest information, please refer to the provided data files (i.e. readme.txt files, etc) or other Cermate Technologies
Incorporation documentation.

5) Information recorded in or displayed by this product may include content related to intangible assets or intellectual
properties owned by Cermate Technologies Incorporation or by a third-party. However, this does not imply that
Cermate Technologies Incorporation grants the user or other third-parties any license or permits to use such assets or
properties.

Precautions

1) Do not use the touch panel switch as an emergency stop switch. For safety reasons, it is required that all industrial
machinery and systems must be equipped with a mechanical, manually-operated emergency stop switch.

2) Do not use the touch panel switch that could result in human injury or equipment damage. Failure with the touch panel,
the processing unit, and the cables that makes the output stuck at ON or OFF could result in a serious accident.

1.1.1. Documentation Conventions

Product-related Abbreviations and Terminology

This manual uses the following terminology.
Terminology Description

Controller Indicates controller, such as programmable logic controllers (PLCs), motion controllers, thermal
controllers, inverters, and so on.

Application The screen application created with the PM Designer on the PC.

Target Panel The HMI (Human-Machine Interface) unit or the computer that runs PanelExpress where the screen

application is downloaded to and displayed.

This manual uses the following abbreviations.
Abbreviations | Corresponding Target Panel

PM All PanelMaster Series

PE PanelExpress

LSK PLO37-LSK, PV037-LSK, PV037V-LSK,
PL057-LSK, PV057-LSK, PV057V-LSK

TSK PLO57-TSK, PV057-TSK, PV057V-TSK

WKT PLO70-WKT, PVO70-WKT
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1.3. Installing PM Designer

1.3.1. System Requirements

The following hardware / software is required to use PM Designer.

Free hard disk space
PM Designer, once installed, takes around 170 MB of hard disk space. The installation procedure (only at installation time)
requires twice as much (i.e. 340 MB).

RAM Working Memory
The memory requirements are as required by the OS. However minimum of 512MB RAM is recommended for decent
performance when user is having large projects with high color bitmaps.

Minimum OS requirements :
Windows 2000 ' SP4
Windows XP'" SP2 (for all flavors of XP such as Home, Media Center, Tablet PC)
Windows Server 2003™"
Windows Vista'

1.3.2. Software Installation PM Designer

m Installing PM Designer

To install PM Designer, you may do the followings:

1. Close all other programs.

2. Select and click setup.exe in the CD or PM Designer installation folder.

3. Follow the on screen prompts.

4. The default location for the PM Designer software is "c:\Program Files\PM Designer. If you prefer to change the
software at a different location on your hard drive, you have that option.

The installation procedure will create a program group entitled "PM Designer" within Windows' . A PM Designer icon
PP

BEEERE will be added to your desktop. PM Designer also appears on the Windows'" start menu under Start > All

Programs > PM Designer.

m Technical Support
For the questions about the PM Designer software, contact Cermate by sending an email to the following address:
service@cermate.com.

= How to Report a Bug

The PM Designer development team is proud to present a high quality program with minimal bugs. Despite their best
efforts, however, bugs do occasionally appear in the software. Should you notice a problem with the software that you think
may be a bug, please report it to PM Designer. Please e-mail to service@cermate.com.

Please include as much information as possible, including a description of the irregularity, the type of PC and panel that
you have, any other software that was running when the problem occurred, and the sequence of steps that led to the
problem.

m PM Designer Software License

This is a legal agreement between you (either an individual or a single entity) and Cermate for the PM Designer
SOFTWARE, which includes computer software and may include associated media, printed materials, and 'on-line’
electronic documentation.
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By installing, copying, downloading, accessing, or otherwise using the PM Designer SOFTWARE, you agree to be bound
by the terms of this License. If you do not agree to the terms of this agreement, do not install or use the PM Designer
SOFTWARE; you may, however, return it to your place of purchase for a full refund.

m Software License
The PM Designer SOFTWARE is protected by copyright laws and international copyright treaties, as well as other
intellectual property laws and treaties. The PM Designer SOFTWARE is licensed, not sold.

m Grant of License

With this License Cermate grants you the non-exclusive right to use the PM Designer SOFTWARE in accordance with the
following terms:

You may install, use, access, display, run, or otherwise interact with (RUN') one copy of the PM Designer SOFTWARE on
a single computer, workstation (COMPUTER'). The primary user of the COMPUTER on which the PM Designer
SOFTWARE is installed may make a second copy for his or her exclusive use on a portable computer.

You may also store or install a copy of the PM Designer SOFTWARE on a storage device, such as a network server, used
only to RUN the PM Designer SOFTWARE on your other COMPUTERS over an internal network; however, you must
acquire and dedicate a license for each separate COMPUTER on which the PM Designer SOFTWARE is RUN from the
storage device. A license for the PM Designer SOFTWARE may not be shared or used concurrently on different
COMPUTERS.

m Transfer of License
The initial licensee of the PM Designer SOFTWARE may make a one-time permanent transfer of this License and the PM
Designer SOFTWARE only directly to an end user. This transfer must include all of the PM Designer SOFTWARE
(including all component parts, the media and printed materials and this License). The transferee of such one-time transfer
must agree to comply with the terms of this License, including the obligation not to further transfer this License and the PM
Designer SOFTWARE.

m Limitations
You may not reverse engineer, decompile, or disassemble the PM Designer SOFTWARE, except and only the extent that
such activity is expressly permitted by applicable law notwithstanding this limitation.

The PM Designer SOFTWARE is licensed as a single product, its component parts may not be separated for use on more
than one COMPUTER.

m Copyright

All title and copyrights in and to the PM Designer SOFTWARE (including but not limited to any images, photographs,
animations, video, audio, music and text incorporated into the PM Designer SOFTWARE), the accompanying printed
materials, and any copies of the PM Designer are owned by Cermate or its suppliers. If this PM Designer SOFTWARE
contains documentation which is provided only in electronic form, you may print one copy of such electronic documentation.
You may not copy the printed materials accompanying the PM Designer SOFTWARE.

m Intellectual Property

The Intellectual Property of the PM Designer SOFTWARE (including but not limited to any images, photographs,
animations, video, audio, music and text incorporated into the PM Designer SOFTWARE) is owned by Cermate
International.

m Disclaimer (Limited Warranty)
The PM Designer SOFTWARE is provided 'as is' and without warranty of any kind, express, implied or otherwise, including
without limitation, any warranty of merchantability or fithess for a particular purpose.

In no event shall Cermate be liable for any special, incidental, indirect or consequential damages of any kind, or any

damages whatsoever resulting from loss of use, data or profits, whether or not advised of e possibility of damage, and on
any theory of liability, arising out of or in connection with the use of the PM Designer SOFTWARE.
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1.4. Using PM Designer

1.4.1. Main Menus

There are 11 menus you can select in the main menu: File, Edit, View, Screen, Draw, Object, Project, Panel, Tools,
Window, Help.

1.4.1.1. File Menu

Icon | Menu ltem Shortcut | Description

00 | New Ctrl+N Create a new PM Designer project.

= Open... Ctrl+O Open an existing PM Designer project.
Close Close the current project.

E | save Ctrl+S Save the current project.
Save As... Save the current project with a new name.
<Recently opened filename> Open the referred project.
Exit Quit PM Designer.

1.4.1.2. Edit Menu

Icon | Menu Iltem Popup Menu Iltem | Shortcut | Description
K7 Undo Ctrl+z Undo the last action.
Cu Redo Ctrl+Y Redo the previously undone action.
& Cut Ctrl+X Cut the selection and put it on the Clipboard.
Copy Ctrl+C Copy the selection and put it on the Clipboard.
ie] Paste Ctrl+Vv Place the Clipboard contents on the current screen.
Delete Del Delete the selection.
Duplicate... Duplicate the selected object.
Fine and Find... Find the specified text.
Replace Replace... Replace specific text with different text.
Show Grid Show or hide the grid.
Snap to Grid Se'lect or deselect the option of aligning objects to the grid
points.
Grid Settings... Opens the Grid Settings dialog box.
Select All Ctrl+A Select entire objects of the active screen.
:'ﬁ Group Group the selection.
:'-ﬁ Ungroup Ungroup the selected group.

Continued
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Icon

Menu Item

Popup Menu Item

Description

J< 4

Pin

Pin the selection so it can not move.

&

Unpin

Unpin the selection so it can move again.

Lodh,

Auto Text
Resizing

Select or deselect the option of automatic text resizing.

=
ID
=

Align

Left

Align the left sides of selected objects to the left side of the reference
object. All the objects move horizontally so their left sides are in line
with the left side of the reference object.

Vertical Center

Align the vertical centers of selected objects to the vertical center of
the reference object. All the objects move horizontally so their vertical
centers are in line with the vertical center of the reference object.

Right

Align the right sides of selected objects to the right side of the
reference object. All the objects move horizontally so their right sides
are in line with the right side of the reference object.

Top

Align the tops of the selected objects to the top of the reference object.
All the objects move vertically so their tops are in line with the top of
the reference object.

Horizontal Center

Align the horizontal centers of selected objects to the horizontal center
of the reference object. All the objects move vertically so their
horizontal centers are in line with the horizontal center of the reference
object.

Bottom

Align the bottoms of selected objects to the bottom of the reference
object. All the objects move vertically so their bottoms are in line with
the bottom of the reference object.

To Grid

Select or deselect the option of aligning objects to the grid points.

Make Same
Size

Width

Make the selected objects have the same width as the reference
object.

Height

Make the selected objects have the same height as the reference
object.

Both

Make the selected objects have the same width and height as the
reference object.

Nudge

Left

Nudge the selection left. When the Snap to Grid option is not selected,
all objects of the selection move one pixel left. When the Snap to Grid
option is selected, each object of the selection moves left to where its
upper-left corner aligns to the nearest grid point.

Right

Nudge the selection right. When the Snap to Grid option is not
selected, all objects of the selection move one pixel right. When the
Snap to Grid option is selected, each object of the selection moves
right to where its upper-left corner aligns to the nearest grid point.

Up

Nudge the selection up. When the Snap to Grid option is not selected,
all objects of the selection move one pixel up. When the Snap to Grid

option is selected, each object of the selection moves up to where its

upper-left corner aligns to the nearest grid point.

Down

Nudge the selection down. When the Snap to Grid option is not
selected, all objects of the selection move one pixel down. When the
Snap to Grid option is selected, each object of the selection moves
down to where its upper-left corner aligns to the nearest grid point.
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Icon | Menu ltem Popup Menu Item | Description
Lt Layer Bring to Top Bring the selection to the top.
) Bring Forward Bring the selected object one layer up.
& Send Backward Send the selected object one layer down.
By Send to Bottom Send the selection to the bottom.
Set Order Start the order setting process for the objects of the active screen.
Object Open the property sheet of the selected object.
Properties...
Save as Save the selected object as the default object for the type of that
Default object. Default objects are saved in the Objects category of the object
library.
Save to Object Save the selected object to the object library.
Library...
Save as Global Save the selected object as the global object which is saved in the
Object... Global category of the object library. Global Objects can be used for
the Global Object Containers.

Note:
1. To select a reference object from the selection, use [Ctrl+Click].
2. To add an object to the selection, use [Shift+Click].

1.4.1.3. View Menu

Icon | Menu ltem | Popup Menu Iltem | Description
Address Write/Monitor Display the Write address and Monitor address defined for each object of
all the opened screens.
Write Display the Write address defined for each object of all the opened
screens.
Monitor Display the Monitor address defined for each object of all the opened
screens.
Read Display the Read address defined for each object of all the opened
screens.
Notification Display the Notification address defined for each object of all the opened
screens.
Touch Operation Display the address of the Touch Operation Control bit defined for each
Control object of all the opened screens.
Visibility Control Display the address of the Visibility Control bit defined for each object of
all the opened screens.
Show Tips Select or deselect the option of displaying tip for the toolbar icon or the
object on which the cursor stays.

Continued
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Icon | Menu ltem Popup Menu Item | Description
Zoom 25% Display screens in 25% of their normal sizes.

50% Display screens in 50% of their normal sizes.
70% Display screens in 70% of their normal sizes.
80% Display screens in 80% of their normal sizes.
90% Display screens in 90% of their normal sizes.
100% Display screens in normal size.
150% Display screens in 150% of their normal sizes.
200% Display screens in 200% of their normal sizes.
300% Display screens in 300% of their normal sizes.

Q Normal Size Display screens in normal size.

Project Manager

Show or hide Project Manager.

Screen Manager

Show or hide Screen Manager.

Screen Overview

Show or hide Screen Overview.

Link Overview

Show or hide Link Overview.

Object Library

Show or hide Object Library.

Macro Command

Show or hide Macro Command Properties window.

Properties

Object List Show or hide Object List.

I/O List Show or hide I/O List.
Standard Toolbar Show or hide Standard toolbar.
Object Toolbar Show or hide Object toolbar.

Draw Toolbar

Show or hide Draw toolbar.

Text Toolbar

Show or hide Text toolbar.

Edit Toolbar

Show or hide Edit toolbar.

Address Toolbar

Show or hide Address toolbar.

Picture Toolbar

Show or hide Picture toolbar.

Status Bar

Show or hide Status bar.

Semi-transparent Object
Dialog View

Select or deselect the option of displaying the object
property dialog box in semi-transparent mode. A
semi-transparent dialog box allows you to see the objects
underlying the dialog box.

<Language name>

Display the text of objects in the selected language.

1-9
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1.4.1.4. Screen Menu

Icon

Menu Iltem

Description

B

New Screen...

Create a new screen for the current panel application.

Open Screen...

Open an existing screen of the current panel application.

Close Screen

Close the current screen.

Close All Screens

Close all the opened screens.

Cut Screen

Cut the current screen and put it on the Clipboard.

Copy Screen

Copy the current screen and put it on the Clipboard.

Paste Screen

Insert the screen on the Clipboard to the current panel
application.

Delete Screen

Delete the current screen.

Stretch Screen...

Stretch the current screen.

Export Screen...

Export the current screen to a file.

Import Screen...

Import a screen from a file for the current panel application.

Save Current Screen as Picture...

Save the current screen to a picture file.

Save Screens as Pictures...

Open the Save Screens as Pictures dialog box. You can save
each of the selected screens to a picture file using the dialog
box.

Screen Properties

Open the screen property dialog box for the current screen.
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1.4.1.5. Draw Menu
Icon | Menu ltem Description
. Dot Get ready to place a copy of the default dot on a screen.
~ Line Get ready to place a copy of the default line on a screen.
— Horizontal Line Get ready to place a copy of the default horizontal line on a screen.
| Vertical Line Get ready to place a copy of the default vertical line on a screen.
= Polyline Get ready to draw a polyline on a screen.
1 Rectangle Get ready to place a copy of the default rectangle on a screen.
— Round Rectangle Get ready to place a copy of the default round rectangle on a screen.
(_J) | Clipped Rectangle Get ready to place a copy of the default clipped rectangle on a screen.
() Circle Get ready to place a copy of the default circle on a screen.
] Ellipse Get ready to place a copy of the default ellipse on a screen.
™ Arc Get ready to place a copy of the default arc on a screen.
L Pie Get ready to place a copy of the default pie shape on a screen.
(" Polygon Get ready to draw a polygon on a screen.
Text Get ready to place a copy of the default text object on a screen.
E Picture Get ready to place a copy of the default picture object on a screen.
E Scale Get ready to place a copy of the default scale on a screen.
ﬁ Table Get ready to place a copy of the default table on a screen.

1-11
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1.4.1.6. Object Menu
Icon | Menu ltem Popup Menu Item Description
Bit Button Get ready to place a copy of the default bit button on a

screen.

@E

k=
]
n

Toggle Switch

Get ready to place a copy of the default toggle switch on
a screen.

(&

Screen Button

Get ready to place a copy of the default screen button
on a screen.

Function Button

Get ready to place a copy of the default function button
on a screen.

Get ready to place a copy of the default slide switch on

= | Slide Switch a screen

@ word Button 222 rrg:r(]jy to place a copy of the default word button on

o Multistate Switch Get. ready to place a copy of the default multistate
Switch on a screen.

- ) Get ready to place a copy of the default radio button

Radio Button Group group on a screen.

T Keypad Button Get ready to place a copy of the default keypad button

on a screen.
More buttons G d | f the defaul b

- Scroll Button Group et ready to place a copy of the default scroll button
group on a screen.

- Scroll Bar Get ready to place a copy of the default scroll bar on a
screen.

R Step Button Get ready to place a copy of the default step button on a
screen.

- Page Selector Get ready to place a copy of the default page selector

on a screen.

u

Numeric Entry

Get ready to place a copy of the default numeric entry
on a screen.

Numeric Display

Get ready to place a copy of the default numeric display
on a screen.

@ | |2

Advanced Numeric Display

Get ready to place a copy of the default advanced
numeric display on a screen.

1t

Character Entry

Get ready to place a copy of the default ASCII string
entry on a screen.

Character Display

Get ready to place a copy of the default ASCII string
display on a screen.

Bit Lamp

Get ready to place a copy of the default bit lamp on a
screen.

Multistate Lamp

Get ready to place a copy of the default multistate lamp
on a screen.

(o | w0 | E

Message Display

Get ready to place a copy of the default message
display on a screen.

Meter

Get ready to place a copy of the default meter on a
screen.

Continued
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on a screen.

Day-of-week Display

Icon | Menu ltem Popup Menu Item Description
Time Display Szgzggy to place a copy of the default time display on
& Time/Date Date Display Get ready to place a copy of the default date display

Get ready to place a copy of the default day-of-week
display on a screen.

Dynamic Graphic

Dynamic Circle

Get ready to place a copy of the default dynamic circle
on a screen.

Dynamic Rectangle

Get ready to place a copy of the default dynamic
rectangle on a screen.

GIF Display

Get ready to place a copy of the default GIF display on
a screen.

Picture Display

Get ready to place a copy of the default picture display
on a screen.

Animated Graphic

Get ready to place a copy of the default animated
graphic on a screen.

el "R AR

Get ready to place a copy of the default pipeline on a

Pipeline screen
iE Bar Graph Get ready to place a copy of the default bar graph on a
screen.
E:{?{ Line Chart Get ready to place a copy of the default line chart on a
screen.
Graph/Chart G q | f the default circular b
a Circular Bar Graph et ready to place a copy of the default circular bar
graph on a screen.
iQE Scatter Chart Get ready to place a copy of the default scatter chart
on a screen.
;E Alarm Display Get ready to place a copy of the default alarm display

on a screen.

B | (&

I3

Historic Display

Historic Data Table

Get ready to place a copy of the default historic data
table on a screen.

Historic Event Table

Get ready to place a copy of the default historic event
table on a screen.

Historic Trend Graph

Get ready to place a copy of the default historic trend
graph on a screen.

Single Record Data
Table

Get ready to place a copy of the default single record
data table on a screen.

Single Record Line
Chart

Get ready to place a copy of the default single record
line chart on a screen.

Operation Log Display

Get ready to place a copy of the default operation log
display on a screen.

i

Recipe Selector

Get ready to place a copy of the default recipe selector
on a screen.

msl

Recipe Table

Get ready to place a copy of the default recipe table on
a screen.

!

Sublink Table

Get ready to place a copy of the default sublink Table
on a screen.

Global Object Container

Get ready to place a copy of the default global object
container on a screen.

o

USB Camera View

Get ready to place a copy of the default USB camera
view on a screen.

1-13

CHAPTER 1

INTRODUCTION




4? - -
PM Designer Operation Manual

CHAPTER 1 INTRODUCTION 1-14



b, . .
PM Designer Operation Manual

1.4.1.7. Project Menu
Icon | Menu ltem Popup Menu Item Description

Information & Protection... Open the Project Information & Protection dialog box. This
dialog box shows the basic information of your project and
allows you to define how to protect it.

Languages... Open the Languages dialog box. You can specify up to 10
languages for your project to support with this dialog box.

Font Templates... Open the Font Templates dialog box. With this dialog
box, you can specify up 20 fonts as the frequently used
fonts for each language.

Text Database... Open the Text Database (dockable window). With Text
Database, you can import text, export text, and edit text for
your project.

Picture Database... Open the Picture Database (dialog box). You can import
pictures and organize them for your project in this dialog
box.

Sound Database... Open the Sound Database (dialog box). You can import
sounds for your project in this dialog box.

Global Tags... Open the Global Tags window. You can define the global
tags in this window.

Global Macro Add... Create a new macro.

Edit Select a macro to edit.
Delete Select a macro to delete.

Add New Panel Create a new panel application.

Application...

Import Panel Application... Import a panel application from a PLF file.

Delete Panel Application Select a panel application to delete.
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1.4.1.8.

Panel Menu

Icon

Menu Iltem

Popup Menu Item

Description

Current Panel

<Panel application

Select a panel application as the current application

Application name>

Link Add... Add a new communication link to the current application.

Properties Select a communication link to open its property sheet.

Delete Select a communication link to delete.

Driver List... Open communication driver list dialog box which lists all the
supported communication drivers. In the dialog box, you can
export the driver list to the .csv file.

Tags... Open the Tags window of the current application. You can
define tags for the application in this window.

Sound Table... Open the Sound Table (dialog box). You can collect sounds
for the current application in this dialog box.

General Setup... Open the Panel General Setup dialog box. You can define
the general settings for the current application in this dialog
box.

Command & Status... Open the Command & Status dialog box. You can define the
command block and the status words for the current
application in this dialog box.

Clock... Open the Clock dialog box. You can define the clock
operations for the current application in this dialog box.

Passwords... Open the Passwords dialog box. You can define passwords
and related settings for the application in this dialog box.

Discrete Alarm Block Add Add a new discrete alarm block to the current application.

Properties Select a discrete alarm block to open its property sheet.

Delete Select a discrete alarm block to delete.

Analog Alarm Block Add Add a new analog alarm block to the current application.

Properties Select an analog alarm block to open its property sheet.

Delete Select an analog alarm block to delete.

Recipe Block Add Add a new recipe block to the current application.

Properties Select a recipe block to open its property sheet.

Delete Select a recipe block to delete.

Data Logger Add Add a new data logger to the current application.

Properties Select a data logger to open its property sheet.

Delete Select a data logger to delete.

Operation Logging... Open the Operation Logging dialog box. You can define the
settings of operation logging for the current application in
this dialog box.

Macro Add... Add a new macro to the current application.

Edit Select a macro of the current application to edit.

Delete Select a macro of the current application to delete.

@] Compile... Compile the current application to build the runtime data.

You can download the runtime data to the target panel. With
the runtime data the target panel can perform exactly what
you programmed for the application.

Continued

CHAPTER 1 INTRODUCTION 1-16

1




b, . .
PM Designer Operation Manual

Icon | Menu Item Popup Menu Item

Description

Build Panel Runtime
Package (PRP)...

Build the panel runtime package (PRP) file for the current
application. The PRP file contains the runtime data and the
system programs. You can update the target panel without
the project file by downloading the PRP file to it. The target
panel can also update itself by loading the PRP file from a
USB mass storage device.

Build ROM Image...

Build the ROM image file for the current application. The
ROM image file contains the runtime data and the system
programs. The target panel can update itself by loading the
ROM image file from a micro SD card.

@ Download...

Download data to the target panel.

Upload... Upload data from the target panel.
Export Panel Export the current panel application to a PLF file.
Application...

1.4.1.9. Tools Menu

Icon | Menu ltem Popup Description
Menu Item
Language Selection Auto When this item is selected:
Default Language for Language Used for the U/l of
the Windows the PM Designer
Simplified Chinese Simplified Chinese
Traditional Chinese Traditional Chinese
Others English
English Select English as the language for the U/l of the PM
Designer.
Chinese Select simplified Chinese as the language for the U/l of the
(Simplified) PM Designer.
Chinese Select traditional Chinese as the language for the U/l of the
(Traditional) PM Designer.

@ Run Offline Simulation

Run offline simulation for the current application.

Run Online Simulation

Run online simulation for the current application.

Set Transparent
Communication...

Open the Set Transparent Communication dialog box.

Start Transparent
Communication

Start the transparent communication.

End Transparent
Communication

End the transparent communication.

Update OSO through BIOS

Update the system program OSO0 of the target panel through
its BIOS. This operation is useful when the system programs
of the target panel were destroyed.

Export Text...

Export the text of the current application to a PTX file.

Import Text...

Import the text in a PTX file for the selected application.

PM TextEditor

Run the PM TextEditor program to edit the text of a PTX file.
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1.4.1.10. Window Menu

Icon | Menu Item Description

Cascade Arrange windows so they overlap.

Tile Vertical Arrange windows as non-overlapping vertical tiles.

Tile Horizontal Arrange windows as non-overlapping horizontal tiles.

Arrange lcon Arrange icons at the bottom of the window.

Restore Restore the windows to their original sizes and positions.

Maximize Maximize the windows

Opened Window List Display a list of opened windows titles. You may click the window title to bring the
corresponding window to the top.

Windows... Open the Windows dialog box to activate or save or close the selected window.

1.4.1.11. Help Sub-menu

Icon | Menu ltem Description
About PM Designer... Open the About PM Designer dialog box. You can see the version number of the
R
PM Designer in this dialog box.
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1.4.2. Toolbars

1.4.2.1. Standard Toolbar

D E & BB « o« AEEE QL e v.EBEEBEH B
Icon Tool Tip Description

0 New Create a new PM Designer project.

= Open Open an existing PM Designer project.

= Save Save the current project.

& Cut Cut the selection and put it on the Clipboard.

Copy Copy the selection and put it on the Clipboard.

i Paste Place the Clipboard contents on the current screen.

KD Undo Undo the last edit action.

%] Redo Redo the previously undone edit action.

New Screen Create a new screen for the current panel application.

Screen Properties

Open the screen property dialog box for the current screen.

Previous Screen

Make the previous screen of the current screen in terms of screen number the
current screen.

Next Screen

Make the next screen of the current screen in terms of screen number the current
screen.

SN2 A E | E |

Zoom In Make the screen view one step bigger.
Zoom Out Make the screen view one step smaller.
Normal Size Restore the screen view to normal size.

o Off (State 0) Show the Off state of all the objects on the current screen.
o On (State 1) Show the On state of all the objects on the current screen.
1 State Select a state for the selected object to show.
Compile the current application to build the runtime data. You can download the
[E] Compile runtime data to the target panel. With the runtime data the target panel can
perform exactly what you programmed for the application.
[@ Download Download data to the target panel.
Download . . . . .
[@] Immediately Download data using the existing settings to the target panel immediately
2] Run Offline Run offline simulation for the current application.
Simulation
74 About Open the About PM Designer dialog box.
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1.4.2.2. Object Toolbar

3 = [ == o R R

- I S = S =R - I TR 3

CRE ARNSH & EFQle 2 8648088 ER Ba

Icon

Tool Tip

Description

Bit Button

Get ready to place a copy of the default bit button on a screen.

Word Button

Get ready to place a copy of the default word button on a screen.

G @ =

Screen Button

Get ready to place a copy of the default screen button on a screen.

E:

Page Selector

Get ready to place a copy of the default page selector on a screen.

Function Button

Get ready to place a copy of the default function button on a screen.

Keypad Button

Get ready to place a copy of the default keypad button on a screen.

E® | Scroll Button Group Get ready to place a copy of the default scroll button group on a screen.
G | Scroll Bar Get ready to place a copy of the default scroll bar on a screen.

¥ Radio Button Group Get ready to place a copy of the default radio button group on a screen.
= Step Button Get ready to place a copy of the default step button on a screen.
Z:’;G Toggle Switch Get ready to place a copy of the default toggle switch on a screen.

L | Multistate Switch Get ready to place a copy of the default multistate Switch on a screen.
= Slide Switch Get ready to place a copy of the default slide switch on a screen.

= Numeric Entry Get ready to place a copy of the default numeric entry on a screen.

ASCII String Entry

Get ready to place a copy of the default ASCII string entry on a screen.

Advanced Numeric Display

Get ready to place a copy of the default advanced numeric display on a screen.

Bit Lamp

Get ready to place a copy of the default bit lamp on a screen.

Multistate Lamp

Get ready to place a copy of the default multistate lamp on a screen.

Numeric Display

Get ready to place a copy of the default numeric display on a screen.

ASCII String Display

Get ready to place a copy of the default ASCII string display on a screen.

Message Display

Get ready to place a copy of the default message display on a screen.

3| E (o | o | |

Meter

Get ready to place a copy of the default meter on a screen.

Continued
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Icon | Tool Tip Description
Time Display Get ready to place a copy of the default time display on a screen.
Date Display Get ready to place a copy of the default date display on a screen.

Day-of-week Display

Get ready to place a copy of the default day-of-week display on a screen.

Dynamic Circle

Get ready to place a copy of the default dynamic circle on a screen.

Dynamic Rectangle

Get ready to place a copy of the default dynamic rectangle on a screen.

GIF Display

Get ready to place a copy of the default GIF display on a screen.

Picture Display

Get ready to place a copy of the default picture display on a screen.

Animated Graphic

Get ready to place a copy of the default animated graphic on a screen.

e abal TRV iCARE. AN R 7

Pipeline Get ready to place a copy of the default pipeline on a screen.
Bar Graph Get ready to place a copy of the default bar graph on a screen.
Eﬂ’k Line Chart Get ready to place a copy of the default line chart on a screen.

Circular Bar Graph

Get ready to place a copy of the default circular bar graph on a screen.

Scatter Chart

Get ready to place a copy of the default scatter chart on a screen.

Alarm Display

Get ready to place a copy of the default alarm display on a screen.

Historic Data Table

Get ready to place a copy of the default historic data table on a screen.

Historic Event Table

Get ready to place a copy of the default historic event table on a screen.

Historic Trend Graph

Get ready to place a copy of the default historic trend graph on a screen.

& || e | | s |55 |G

Operation Log Display

Get ready to place a copy of the default operation log display on a screen.

L]
-
<

Recipe Selector

Get ready to place a copy of the default recipe selector on a screen.

Recipe Table

Get ready to place a copy of the default recipe table on a screen.

Sublink Table

Get ready to place a copy of the default sublink Table on a screen.

| el | sl | I

USB Camera View

Get ready to place a copy of the default USB camera view on a screen.
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1.4.2.3. Draw Toolbar

N mls e Leo0R EEnB S HAR S
Icon | Tool Tip Description
. Dot Get ready to place a copy of the default dot on a screen.
™ Line Get ready to place a copy of the default line on a screen.
— Horizontal Line Get ready to place a copy of the default horizontal line on a screen.
| Vertical Line Get ready to place a copy of the default vertical line on a screen.
= Polyline Get ready to draw a polyline on a screen.
1 Rectangle Get ready to place a copy of the default rectangle on a screen.
— Round Rectangle Get ready to place a copy of the default round rectangle on a screen.
(] | Clipped Rectangle Get ready to place a copy of the default clipped rectangle on a screen.
(3 Polygon Get ready to draw a polygon on a screen.
) Circle Get ready to place a copy of the default circle on a screen.
i Ellipse Get ready to place a copy of the default ellipse on a screen.
™y Arc Get ready to place a copy of the default arc on a screen.
i Pie Get ready to place a copy of the default pie shape on a screen.
ﬁ Table Get ready to place a copy of the default table on a screen.
E Scale Get ready to place a copy of the default scale on a screen.
Text Get ready to place a copy of the default text object on a screen.
E Picture Get ready to place a copy of the default picture object on a screen.
;U Dot Style Select a dot style for the selected dot.
g Line Style Select a line style for the selected shape.
@ Border Color Select a color for the border of the selected shape.
% BG Color Select a color for the background of the selected solid shape.
% Pattern Style Select a pattern for the selected solid shape.
% FG/Pattern Color Select a color for the pattern of the selected solid shape.
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1.4.2.4. Text Toolbar

Inner Text + | Language 1 w | Arial w3 |a|START : @ {b— “w £ = = =
Icon Tool Tip Description
Inrer Text 3 Text Type Select the type of text you are working on.
Text Type Description
Inner Text Text displayed inside of an object.
External Text | Text of the external label of an object.

Language 1 w Language Select a language that you are defining the text for.
Arial w | | Font Select a font for the text here.

CIEY Size Select a font size for the text here.

START = | Text Edit the text here.
@ Text Color Select a color for the text.
Background Color Select a color for the background of the object.

$~ Center Position Position the text at the center location within the object.
A Horizontal Position Change the horizontal position of the text within the object.

1 Vertical Position Change the vertical position of the text within the object.
= Align Left Align the text to the left of the text body.

= Center Align the text to the center of the text body

= Align Right Align the text to the right of the text body

ty External Label Change the position of the external label.

Position
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1.4.2.5. Edit Toolbar
=RRNR= RO TR = = =Y - - e =Sy e R B~ S o P
Icon | Tool Tip Description

= Align Left Align the left sides of selected objects to the left side of the reference object. All the

a objects move horizontally so their left sides are in line with the left side of the
reference object.

2, Align Vertical Center Align the vertical centers of selected objects to the vertical center of the reference
object. All the objects move horizontally so their vertical centers are in line with the
vertical center of the reference object.

= Align Right Align the right sides of selected objects to the right side of the reference object. All the

= objects move horizontally so their right sides are in line with the right side of the
reference object.

— Align Top Align the tops of the selected objects to the top of the reference object. All the objects
move vertically so their tops are in line with the top of the reference object.

o Align Horizontal Align the horizontal centers of selected objects to the horizontal center of the

Center reference object. All the objects move vertically so their horizontal centers are in line
with the horizontal center of the reference object.

olls Align Bottom Align the bottoms of selected objects to the bottom of the reference object. All the

= objects move vertically so their bottoms are in line with the bottom of the reference
object.

Al Snap to Grid Select or deselect the option of aligning objects to the grid points.

— Make Same Width Make the selected objects have the same width as the reference object.

a[] | Make Same Height Make the selected objects have the same height as the reference object.

o4 Make Same Size Make the selected objects have the same width and height as the reference object.

yoin Nudge Left Nudge the selection left. When the Snap to Grid option is not selected, all objects of

= the selection move one pixel left. When the Snap to Grid option is selected, each
object of the selection moves left to where its upper-left corner aligns to the nearest
grid point.

ii-8 Nudge Right Nudge the selection right. When the Snap to Grid option is not selected, all objects of

= the selection move one pixel right. When the Snap to Grid option is selected, each
object of the selection moves right to where its upper-left corner aligns to the nearest
grid point.

ok Nudge Up Nudge the selection up. When the Snap to Grid option is not selected, all objects of
the selection move one pixel up. When the Snap to Grid option is selected, each
object of the selection moves up to where its upper-left corner aligns to the nearest
grid point.

b Nudge Down Nudge the selection down. When the Snap to Grid option is not selected, all objects of
the selection move one pixel down. When the Snap to Grid option is selected, each
object of the selection moves down to where its upper-left corner aligns to the nearest
grid point.

Continued
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Icon | Tool Tip Description

T Bring to Top Bring the selection to the top.

Lh Bring Forward Bring the selected object one layer up.

) Send Backward Send the selected object one layer down.

By Send to Bottom Send the selection to the bottom.

:'ﬁ Group Group the selection.

:'-ﬂ Ungroup Ungroup the selected group.

Jicd Pin Pin the selection so it can not move.

e ] Unpin Unpin the selection so it can move again.

[4ch | Auto Text Resizing Select or deselect the option of automatic text resizing.

1.4.2.6. Address Toolbar

ﬁe:|w1nn o | W33 = g|w1 ao
Icon Tool Tip Description
'i‘|W1 oo | [ Write Address Specifies the Write address of the selected object.
| W33 Read Address Specifies the Read address of the selected object.
E|W1 oo (@ | Monitor Address Specifies the Monitor address of the selected object.
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1.4.2.7. Picture Toolbar

Vertical Position

Change the vertical position of the picture within the object.

Background

wartesblwr | oh B8 @ 90" &K ‘i@ .éb_ o 2
Icon Tool Tip Description
vortesblar o Picture Name Specifies the picture name. You can select an imported picture here using the
drop-down list.
i Import from File Select a picture from a picture file.
g8 Select/import Select a picture from a PM Designer provided picture librar
= from Library P gnerp P y
Select or deselect the option that parts of the picture are transparent. The
g Transparent ; ; i
transparent parts are pixels having the specified transparent color.
@ Transparent Select a color as the transparent color.
Color
M EE Flip/Rotate Select a method to rotate/flip the picture.
Select or deselect the option that the picture is toned with the specified toning
J b Tone color.
@ Toning Color Select a color as the toning color.
Fit to Object Stretch the picture so it has the same size as the object.
1$\— Center Position the picture at the center location within the object.
had Horl_z_ontal Change the horizontal position of the picture within the object.
Position
t

Color

Select a color for the background of the object.

1.4.2.8. Status Bar

Coordinate of the cursor; (X, y)

v 531, 187

Size of the selected object; (width x height)

Murneric Enkry 391, 104 70 x 34 100%%

Type of the selected object

Coordinate of the selected object; (x, y)

Zooming factor of the screen view
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1.4.3. Project Manager

The Project Manager is a dockable window with a project tree. You can manage your project with it easily. To open the
Project Manager, check the Project Manager menu item in the View menu. The following is an example of the Project
Manager. In this example, the project MyProject has two panel applications: MyAP_1 and MyAp_2.

| Project node |_

| Global node i7

Panel Application node \\
\ |

Project Manager
¥=0 MyProject
= Global

) mynp 1

ﬁ Languages
Faont Templakes

Languages node

Font Templates node |

Picture Database node |

% Picture Database I

E(Eﬁ Sound Database
Ty Text Databas

@] Global Tags \
ZP Global Macrns\
R Links

g Internal Memary

L
Internal Memory node

Link node

Setup node L|;

L=

%

Screens node

Recipes node

| Data Loggers node L

| Operation Logging node I—

Macros node |E

—
| Panel Application node (

L

T PLC-1

] Sound Database node |
\| Text Database node |

| Global Tags node |

| Global Macros node |

T Inverter-1

Sound Table

@] Tags I

2

Setup
= General Setup

I
— Sound Table node |

J General Setup node |

T Command & Status ———=

@ Clock,

_
@ Passwords \
B Screens
Start-up (#1)
Menu (#2)
Operations (#£4)
A plarms
By DAB-0(0) ———

|

\| Command & Status node

Clock node

| Passwords node |

}Screen node

Wi AAB-64 (54\
ﬁ] Recipes

ﬁ RE-0(0)
q*_—| RE-1(1]
Data Loggers
& DL-O(0
& DL-1(13

—— (4 Operation LD:;E\

-} Macros

() MCR-000
() MCR-001

—

| @-E) ryap 2

| Discrete Alarm Block node |
Analog Alarm Block node |

| Recipe Block node |

§‘| Data Logger node |

:i Macro node
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W Project Node ( &F )
The label of the Project node is the project name. You can do the following with the Project node:
1) Double-click it to open the Project Information & Protection dialog box.

2) Right-click it to get a popup menu with the following menu items:

Menu ltem

Description

Add Panel Application...

Create a new panel application.

Import Panel Application...

Import a panel application from a PLF file.

Information

Open the Project Information & Protection dialog box.

Toggle All

Expand all the collapsed lists of sub-nodes and collapse all the expanded lists of
sub-nodes.

m Global Node ( 2 )

The Global node has seven sub-nodes. You can do the following with the Global node:
1) Double-click it to expand or collapse the list of its sub-nodes.

m Languages Node ( 7] )

You can do the following with the Languages node:
1) Double-click it to open the Languages dialog box.
2) Right-click it to get a popup menu with the following menu item:

Menu Item Description

Properties... Open the

Languages dialog box.

B Font Templates Node ( )

You can do the following with the Font Templates node:

1) Double-click it to open the Font Templates dialog box.

2) Right-click it to get a popup menu with the following menu item:

Menu Item Description

Properties... Open the

Font Templates dialog box.

W Picture Database Node ( I% )

You can do the following with the Picture Database node:

1) Double-click it to open the Picture Database dialog box.

2) Right-click it to get a popup menu with the following menu item:

Menu Item Descript

ion

Properties... Open the Picture Database dialog box.

B Sound Database Node (

G )

You can do the following with the Sound Database node:
1) Double-click it to open the Sound Database dialog box.
2) Right-click it to get a popup menu with the following menu item:

Menu Item Description

Properties... | Open the Sound Database dialog box.
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W Text Database Node ( Ta )

You can do the following with the Text Database node:

1) Double-click it to open the Text Database dialog box.

2) Right-click it to get a popup menu with the following menu item:

Menu Item Description

Open Open the Text Database window.

m Global Tags Node ( & )

You can do the following with the Global Tags node:

1) Double-click it to open the Global Tags window.

2) Right-click it to get a popup menu with the following menu item:

Menu Item Description

Open Open the Global Tags window.

H Global Macros Node ( = )

The Global Macros node can have many Global Macro sub-nodes. Each Global Macro node is associated with a global
macro of the project. You can do the following with the Global Macros node:

1) Double-click it to expand or collapse the list of its sub-nodes.
2) Right-click it to get a popup menu with the following menu items.

Menu Item Description

Add Macro... Create a new global macro.

Import Import a global macro from an MCR file.
Macro...

B Global Macro Node ( &)

Each Global Macro node is associated with a global macro of the project. You can do the following with the Global Macro
node:

1) Double-click it to open the editing window of the associated macro.
2) Right-click it to get a popup menu with the following menu items.

Menu Item Description

Open Open the editing window of the associated macro.
Close Close the editing window of the associated macro.
Rename Rename the associated macro.

Delete Delete the associated macro.

Export Macro... Export the associated macro to an MCR file.
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m Panel Application Node ( & )

The label of a Panel Application node is the associated application name. You can do the following with the Panel
Application node:

1) Double-click it to open the General Setup dialog box.
2) Right-click it to get a popup menu with the following menu items:

Menu Item Description
Rename Rename the panel application.
Delete Delete the panel application.

General Setup

Open the General Setup dialog box.

Export Panel Application...

Export the panel application to a PLF file.

Toggle All

Expand all the collapsed lists of sub-nodes and collapse all the expanded lists of
sub-nodes.

m Links Node ( @ )
The Links node has one Internal Memory sub-node and can have up to 16 Link sub-nodes. You can do the following with

the Links node:

1) Double-click it to expand or collapse the list of its sub-nodes.
2) Right-click it to get a popup menu with the following menu item:

Menu Item | Description

Add Link Create a new communication link.

Driver Open communication driver list dialog box which lists all the supported communication drivers. In the
Link... dialog box, you can export the driver list to the .csv file.

m Internal Memory Node ( % )

You can do the following with the Internal Memory node:

1) Double-click it to open the Internal Memory dialog box.

2) Right-click it to get a popup menu with the following menu item:

Menu ltem

Description

Properties...

Open the Internal Memory dialog box.

B Link Node ( T )

A Link node is associated with a communication link. You can do the following with the Link node:
1) Double-click it to open the Link Properties dialog box of the associated communication link.

2) Right-click it to get a popup menu with the following menu item:

Menu Item Description

Rename Rename the associated communication link.

Delete Delete the associated communication link.

Properties... | Open the Link Properties dialog box of the associated communication link.

H Tags Node ( &y )

You can do the following with the Tags node:

1) Double-click it to open the Tags window.

2) Right-click it to get a popup menu with the following menu item:

Menu ltem

Description

Open

Open the Tags window.

CHAPTER 1 INTRODUCTION 1-32

1




é;’ - -
PM Designer Operation Manual

m Sound Table Node ( &)

You can do the following with the Sound Table node:

1) Double-click it to open the Sound Table dialog box.

2) Right-click it to get a popup menu with the following menu item:

Menu Item | Description

Properties... | Open the Sound Table dialog box.

m Setup Node ( 2 )
The Setup node has four sub-nodes. You can do the following with the Setup node:
1) Double-click it to expand or collapse the list of its sub-nodes.

B General Setup Node ( = )

You can do the following with the General Setup node:

1) Double-click it to open the General Setup dialog box.

2) Right-click it to get a popup menu with the following menu item:

Menu Item Description

Properties... | Open the General Setup dialog box.

B Command & Status Node ( ] )

You can do the following with the Command & Status node:
1) Double-click it to open the Command & Status dialog box.
2) Right-click it to get a popup menu with the following menu item:

Menu Item | Description

Properties... | Open the Command & Status dialog box.

m Clock Node ( & )

You can do the following with the Clock node:

1) Double-click it to open the Clock dialog box.

2) Right-click it to get a popup menu with the following menu item:

Menu Item Description

Properties... Open the Clock dialog box.

W Passwords Node ( 8 )

You can do the following with the Passwords node:

1) Double-click it to open the Passwords dialog box.

2) Right-click it to get a popup menu with the following menu item:

Menu Item | Description

Properties... | Open the Passwords dialog box.
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m Screens Node ( £ )

The Screens node can have many Screen sub-nodes. Each Screen sub-nodes is associated with a screen of the panel
application. You can do the following with the Screens node:

1) Double-click it to expand or collapse the list of its sub-nodes.
2) Right-click it to get a popup menu with the following menu item:

Menu Item Description

New Screen... Create a new screen.

Import Screen... Import a screen from an SNF file.

Sort by Name Sort the list of Screen sub-nodes by the screen name.

Sort by Number Sort the list of Screen sub-nodes by the screen number.

Close All Screens Close all opened screens.

Save Screens as Pictures... | Open the Save Screens as Pictures dialog box. You can save each of the selected
screens to a picture file using the dialog box.

W Screen Node ( )

Each Screen node is associated with a screen of the panel application. You can do the following with the Screen node:
1) Double-click it to open the associated screen if the screen is not opened yet.

2) Double-click it to open the property sheet of the associated screen if the screen is already opened.

3) Right-click it to get a popup menu with the following menu item:

Menu Item Description

Open Open the associated screen.

Delete Delete the associated screen.

Properties Open the property sheet of the associated screen.
Export Screen... | Export the associated screen to an SNF file.

m Alarms Node ( £ )

The Alarms node can have many Discrete Alarm Block sub-nodes and Analog Alarm Block sub-nodes. You can do the
following with the Alarms node:

1) Double-click it to open the Alarm Properties dialog box.
2) Right-click it to get a popup menu with the following menu item:

Menu Item Description

Add Discrete Alarm Block | Create a new discrete alarm block.

1

Add Analog Alarm Block Create a new analog alarm block.

Import Alarm Block... Import an alarm block from an ALM file.

Properties Open the Alarm Properties dialog box.
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A Discrete Alarm Block node is associated with a discrete alarm block of the panel application. You can do the following
with the Discrete Alarm Block node:

1) Double-click it to open the Discrete Alarm Block dialog box of the associated alarm block.
2) Right-click it to get a popup menu with the following menu item:

Menu Item Description

Delete Delete the associated discrete alarm block.

Properties Open the Discrete Alarm Block dialog box of the associated discrete alarm block.
Export Alarm Block... Export the associated alarm block to an ALM file.

W Analog Alarm Block Node ( h )

An Analog Alarm Block node is associated with an analog alarm block of the panel application. You can do the following
with the Analog Alarm Block node:

1) Double-click it to open the Analog Alarm Block dialog box of the associated alarm block.
2) Right-click it to get a popup menu with the following menu item:

Menu Item Description

Delete Delete the associated analog alarm block.

Properties Open the Analog Alarm Block dialog box of the associated analog alarm block.
Export Alarm Block... Export the associated alarm block to an ALM file.

B Recipes Node ( ﬁl )

The Recipes node can have many Recipe Block sub-nodes. Each Recipe Block sub-node is associated with a recipe block
of the panel application. You can do the following with the Recipes node:

1) Double-click it to expand or collapse the list of its sub-nodes.
2) Right-click it to get a popup menu with the following menu item:

Menu Item Description

Add Recipe Block Create a new recipe block.

W Recipe Block Node ( ] )

A Recipe Block node is associated with a recipe block of the panel application. You can do the following with the Recipe
Block node:

1) Double-click it to open the Recipe Block dialog box of the associated recipe block.
2) Right-click it to get a popup menu with the following menu item:

Menu Item Description
Delete Delete the associated recipe block.
Properties Open the Recipe Block dialog box of the associated recipe block.
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m Data Loggers Node ( @ )

The Data Loggers node can have many Data Logger sub-nodes. Each Data Logger sub-node is associated with a data
logger of the panel application. You can do the following with the Data Loggers node:

1) Double-click it to expand or collapse the list of its sub-nodes.
2) Right-click it to get a popup menu with the following menu item:

Menu Item Description

Add Data Logger | Create a new data logger.

m Data Logger Node ( & )

A Data Logger node is associated with a data logger of the panel application. You can do the following with the Data
Logger node:

1) Double-click it to open the Data Logger dialog box of the associated recipe block.
2) Right-click it to get a popup menu with the following menu item:

Menu Item Description
Delete Delete the associated data logger.
Properties Open the Data Logger dialog box of the associated data logger.

B Operation Logging Node ( e} )

You can do the following with the Operation Logging node:

1) Double-click it to open the Operation Logging dialog box.

2) Right-click it to get a popup menu with the following menu item:

Menu Item Description

Properties... Open the Operation Logging dialog box.

m Macros Node ( = )

The Macros node can have many Macro sub-node. Each Macro node is associated with a macro of the panel application.

You can do the following with the Macros node:
1) Double-click it to expand or collapse the list of its sub-nodes.
2) Right-click it to get a popup menu with the following menu items.

Menu Item Description
Add Macro... Create a new macro.
Import Macro... Import a macro from an MCR file.

B Macro Node ( &)

Each Macro node is associated with a macro of the panel application. You can do the following with the Macro node:
1) Double-click it to open the editing window of the associated macro.

2) Right-click it to get a popup menu with the following menu items.

Menu Item Description

Open Open the editing window of the associated macro.
Close Close the editing window of the associated macro.
Rename Rename the associated macro.

Delete Delete the associated macro.

Export Macro... Export the associated macro to an MCR file.
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1.4.4. Screen Manager

The Screen Manager is a dockable window. You can manage the screens of your project with it easily. To open the Screen

Manager, check the Screen Manager menu item in the View menu. The following is an example of the Screen Manager
that lists the screens of the application EV-104 of the project.

The name of the current panel
application. You can select another
panel application of the project to
view.

If the Use box of a screen is
checked, the
compiler  will

unchecked, the application
compiler will not generate the
runtime data for that screen
and will assume that screen is
not existing.

application
generate the \
runtime data for that screen. If

the Use box of screen is——

Screen Manager

El eving

Mumber

[

L

]
L=l I L) I SN TN o

EEEEEEEEEEEEEEEEE“EEE

Size:640x480;

b

Marne

Ease
Extrusor
Cperador
Tiempos Comunes
Tiempos x Estac
Produccion
Mernoria
Ingenietia 1
Mirnico

Meurmdatica

Yariadores
Crono
Programador
Alfa

Alarmas

SEWY

Erftradas
Alarmas_Liskado
Menu

MNumerico
Screensaver

view of the screens.

Click this icon to get the list

Click this icon to get the thumbnail
view of the screens.

Click the thumbnail of a screen to
select that screen. The selected
screen is highlighted. Use [Ctrl] +
click or [Shift] + click to make
multiple selections.
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The following is an example of the Screen Manager that shows the screens in thumbnail view.

El eving v E]

If the Use box of a screen is
checked, the application
compiler will generate the
runtime data for that screen. If
the Use box of screen is
unchecked, the application
compiler will not generate the
runtime data for that screen and
will assume that screen is not
existing.

Click the row of a screen to select
that screen. The selected screen is
highlighted. Use [Ctr]] + click or
[Shift] + click to make multiple
selections.

T3]
= B3
| EQE

—
L)
=
—_
—l
(=]
(=
o
O =
{ ]
=]
-
=
L)
=
(=]

== —
Crono (#13) Programadar (#14)
w
Size: 640x4E0;
You can right-click the Screen Manager to get the popup menu with the following menu items:
Menu Item Description
New Screen... Create a new screen for the current panel application.
Open Screen... Open the selected screen.
Cut Screen Cut the selected screen and put it on the Clipboard.
Copy Screen Copy the selected screen and put it on the Clipboard.
Paste Screen Insert the screen on the Clipboard to the current panel application.
Delete Screen Delete the selected screen.
Export Screen... Export the selected screen to a file.
Import Screen... Import a screen from a file for the current panel application.
Screen Properties Open the screen property dialog box of the selected screen.
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1.4.5. Popup Menus

1.4.5.1. Object Popup Menu

m For all objects

Icon | Menu ltem Shortcut | Description
& Cut Ctrl+X Cut the selection and put it on the Clipboard.
Copy Ctrl+C Copy the selection and put it on the Clipboard.
! Paste Ctrl+Vv Place the Clipboard contents on the current screen.
Delete Del Delete the selection.
o Pin Pin the selection so it can not move.
T Unpin Unpin the selection so it can move again.
Duplicate... Duplicate the selected object.
Lt Bring to Top Bring the selection to the top.
) Bring Forward Bring the selected object one layer up.
& Send Backward Send the selected object one layer down.
By Send to Bottom Send the selection to the bottom.
Object Properties... Open the property sheet of the selected object.
Save as Default Save the selected object as the default object for the type of that object.
Default objects are saved in the Objects category of the object library.
Save to Object Library... Save the selected object to the object library.
Save as Global Object... Save the selected object as the global object which is saved in the
Global category of the object library. Global Objects can be used for the
Global Object Containers.
Save Current Screen as Save the current screen to a picture file.
Picture...
Screen Properties Open the screen property dialog box for the current screen.
m For polylines and polygons
Menu Item Description
Insert Point Add a point at the specified position.
Delete Point Delete a selected point.

m For pipelines

Menu Item Description

Insert Connector Add a connector at the specified position. If the specified position is on the vertical pipe
segment, you can add left, right or cross connector. If the specified position is on the
horizontal pipe segment, you can add up, down or cross connector.

Delete Pipe Segment Delete a selected connector and its pipe segments.
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1.4.5.2. Screen Popup Menu

Icon

Menu Iltem

Description

Close Screen

Close the current screen.

Cut Screen

Cut the current screen and put it on the Clipboard.

Copy Screen

Copy the current screen and put it on the Clipboard.

Paste Screen

Insert the screen on the Clipboard to the current panel application.

Delete Screen

Delete the current screen.

Save Current Screen as Picture...

Save the current screen to a picture file.

Screen Properties

Open the screen property dialog box for the current screen.
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2.1. Project Information and Protection

You can get the project information and set up passwords to protect your project, the password table and the global
macros by using the Project information & Protection dialog box. To open the dialog box, you can do one of the followings:

1) Inthe PM Designer's Project Manager tool window, double-click the Project node (E).

2) Inthe PM Designer's menu bar, click Project to bring up the Project sub-menu. Click Information & Protection... in the
Project sub-menu.

The following is an example of the Project Information and Protection dialog box.

Project Information & Protection

Project Mame: |M_Ir| Project | Authar; |Ehri$ Chiang | aK
Created Time/date: 11:43 || 3nziz007 |
Last Saved Time/date: | 3:45 ||22/12/2009 | Version:
Developer Paszword:

Froject File Protection Pazzwiord T able Protection

Frotect [ ]Use Developer Pazsword Frotect Ilze Developer Password

[ Edit Pazzword. .. ]

Global Macro Protection

Pratect Usze Developer Password

M ote:

Thiz iz a demo project.
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The following table describes how to read or use each of the items in the dialog box.

Item

Description

Project Name

The name of the project. It is also the file name of the project.

Author

The author of the project.

Created Time/date

The time and date when the project was created.

Last Saved Time/date

The last time and date when the project was saved.

Version

The version number of the PM Designer that was used to save the project last
time.

Developer

Password

Click it to bring up the Edit Developer Password dialog box and specify the
developer password.

The developer password must be an unsigned integer and can have up to 9
digits. The default developer password is 000000000 (nine 0's) for new projects
and new panels. When you download the runtime data of an application to a
panel, the panel compares its developer password with the developer password
of that application. If they are identical, the panel accepts the download
operation immediately. If they are different, the panel asks you to enter the
developer password of the application. This is to make sure you have the right to
use the runtime data. After you enter the application's developer password, the
panel accepts the download operation and takes the developer password of the
application as its developer password.

Project File Protect
Protection

Check this item to enable the project file protection. You need to enter the
specified password to open the project file when this item is checked.

Use Developer
Password

Available when the Protect item is checked. Check this item if you want to use
the developer password for the protection.

Edit Pazsword...

Available when the Use Developer Password item is unchecked. Click it to bring
up the Edit Password dialog box and specify the password.

Password Protect
Table
Protection

Check this item to enable the password table protection. You need to enter the
specified password to view the password table of any panel application of the
project when this item is checked.

Use Developer
Password

Available when the Protect item is checked. Check this item if you want to use
the developer password for the protection.

Edit Pazsword. ..

Available when the Use Developer Password item is unchecked. Click it to bring
up the Edit Password dialog box and specify the password.

Global Protect
Macro
Protection

Check this item to enable the global macro protection. You need to enter the
specified password for viewing any global macro of the project when this item is
checked.

Use Developer
Password

Available when the Protect item is checked. Check this item if you want to use
the developer password for the protection.

Edit Pazsword. ..

Available when the Use Developer Password item is unchecked. Click it to bring
up the Edit Password dialog box and specify the password.

Note

You can type a note for the project.
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2.1.1. The range limitation of the PanelMaster/PM Designer software

(A) The limitation of the general setting and objects:

Developer Password: 1

Item | Description | PanelMaster | PM Designer |
01 | Number of the languages | 10 | 10 |
02 | Number of the fonts (Each Language) | 20 | No Limitation |
03 | Number of the tags | No Limitation | No Limitation |
04 | Number of the macros | No Limitation | No Limitation |
05 | Number of the objects (One Screen) | No Limitation | No Limitation |
06 | Number of the objects (One Project) | No Limitation | No Limitation |
07 | Number of the panels (One Project) | No Limitation | No Limitation |
08 | Number of the instructions (One Project) | No Limitation | No Limitation |
09 | Number of the links | 4 | HMI: 4; PanelExpress: 16 |
10 | Regular user memory ($U) | 5000-Words | 131072-Words |
11 | Battery backed user memory ($N) | 5000-Words | 131072-Words |
12 | System memory ($S) | 1024-Words | 512-Words |
13 | Number of the screen pages | 7999-pages | 7999-pages |
14 Number of the passwords User Password: 8 User Password: 8

Developer Password: 1

(B) The limitation of the particular objects:

Item | Description | PanelMaster | PM Designer |
01 | Number of the Discrete Alarm Blocks | 16-Blocks | 16-Blocks |
02 | Number of the Analog Alarm Blocks | 16-Blocks | 16-Blocks |
03 | Alarm size (Each Block) | Dependsonthe PLCtype | Depends onthe PLC type |
04 | Number of the Recipe Blocks | 16-Blocks | 16-Blocks |
05 | Recipe Size (Each Block) | 1023-Words | 4096-Words |
06 | Number of the recipes (Each Block) | 65535-sets | 65535-sets |
07 | Number of the Data Loggers | 16-Blocks | 16-Blocks |
08 | Sample Size (Each Block) | 32-Words | 128-Words |
09 | Number of the Samples (Each Block) | 65535-sets | 65535-sets |
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2.2. Global Settings

Global settings are the settings that can be used by all panel applications in the same project. They are accessible and
modifiable throughout your project. The global settings help a designer to construct a project that can be flexible and easy
to update. Designers can make changes to the overall design of the panel application by revising the global settings
directly.

You can complete all the global settings in the corresponding dialog box. To open the dialog box, you can double-click the
related node in the Global node in the PM Designer's Project Manager tool window, or you can click Project to bring up the
Project sub-menu in the PM Designer's menu bar, and then click the related command in the Project sub-menu.

The global settings contain the following items.
m Languages
Described in Section 2.2.1.

m  Font Templates
Described in Section 2.2.2.

m  Picture Database
Described in Section 2.2.3.

m  Sound Database
Described in Section 2.2.4.

m Text Database
Described in Section 2.2.5.

m  Global Tags
Described in Section 2.3.

m Global Macros
Described in Chapter 14.
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2.2.1. Languages

This section describes how to set up the languages for the project using the Languages dialog box. Each panel application
in the project can have up to 10 languages for the screen texts. The following is an example of the Languages dialog box.

Mumber of lanquages: | 3 W
Lanquage Mame Character Set
1 Englizh English [United States) [0x403]
2 EREchir Chineze [T aiwan) [0xd04] w
3 T Epir Chineze [PRC) [0=304] W
Import. .. ][ Export... (] l[ Cancel

The following table describes each property in the Languages dialog box.

Property Description

Number of language Specifies how many languages the project will have.

Language The index of the language.

Name Specifies a name for a language. The name must be unique within the project.

Character Set Specifies the character set for a language to determine how to translate the bytes in the
text into characters on the screen.

Import... Click it to import the languages settings from a LNG file.

Export... Click it to export the languages settings to a LNG file.

OK Click it to close the dialog box and accepts all changes.

Cancel Click it to close the dialog box and discard all changes.
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2.2.2. Font Templates

The following is an example of the Font Templates dialog box.

Font Templates @

Language: |EM L =

|l

Current Template

Template List: Mame: |A355 |

M armne Font & Attributes : Wwindows Font: Fant Style: Size:

A10 Avrial; 10; Regular [4 RET THill

a12 Anial; 12; Regular .ﬁl‘?l.." = ] BDId — BE —]
414 Arial; 14; Regular [ . ~ ﬁeigular %g |
a18 Auial; 13; Regular | nal blac | 1Lahc: |
422 Aval: 22: Fegulr O Aiial Narrow [EF— |

P (} Arial Founded MT Be Bold Italic | EEE

A28 Auial; 23; Regular - ; L I

A3 fial, 36 Regular g Anial Unicode MS 43 !
448 Atial 48 Feqular ¢ B askerville Old Face_}: | :?‘2 ||
72 Anial; 72; Regular Effects

A12B Airial; 12; Bald : :

A14R Avial: 14- Bold [ Underline [ 5trikeout

Al0B Avrial; 18; Bald

4288 Arial; 28; Bold . Sample
4438 il 48; Bald
ATZR Aiial; 72; Bold
A12 Airial; 12; Italic

a18l Anal; 18; Italic
A28 Arial; 28; Italic Aa B b I 2 Z
A.3E Anal; 36; Italic

Z."< | }

|mpart... ][ Ewport... QK ]l Cancel

The following table describes how to read or use each of the items in the dialog box.

Item Description
Language Specifies the language that you are working for.
Template List Lists the font templates of the selected language. You can select a font template
here as the current template.
Current Name The name of the current template.
Template Windows Font Specifies the Windows font for the current template.
Font Style Specifies the font style for the current template.
Size Specifies the size for the current template.
Underline Specifies if the Underline feature is selected for the current template.
Strikeout Specifies if the Strikeout feature is selected for the current template.
Update Click it to update the selected template using the new settings.
Import... Click it to import the font templates from an FTF file.
Export... Click it to export the font templates to an FTF file.
OK Click it to close the dialog box and accepts all changes.
Cancel Click it to close the dialog box and discard all changes.
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2.2.3. Picture Database

The picture database contains all the pictures used by the project. The picture database is empty initially after the project is
created.

2.2.3.1. Importing and Exporting Pictures

= Importing Pictures

You need to import a picture before you can use it for the project. There are 5 ways to import pictures:

1) Use the Picture Database dialog box to import one picture at a time from a picture file. The types of importable picture
files include: BMP, JPG, GIF, and WMF.

2) Use the Picture Database dialog box to import many pictures at a time from a picture database (PDB) file.
3) Use the Picture Database dialog box to import one or many pictures at a time by dragging the pictures files from the
Windows Explorer to Picture Database list.

4) Click the icon to select and import a picture file when you specify a picture in a dialog box or a property sheet.

5) Click the icon to select and import a picture in a picture database file when you specify a picture in a dialog box or
a property sheet.

m Exporting Pictures

You can export the pictures of the project so the other projects can share those pictures by importing them. There are 2
ways to export pictures:

1) Use the Picture Database dialog box to export one picture at a time to a picture file.
2) Use the Picture Database dialog box to export many pictures at a time to a picture database (PDB) file.
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2.2.3.2. Picture Groups

The picture database can contain picture groups.

A picture group is a collection of pictures. Each picture in a picture group represents one state. When a picture group is
displayed as the picture shape for an object, the picture that corresponds to the current object state is shown. This is the
main benefit of using a picture group as the object shape because it can show each object state with a different picture.

When a picture group is used as the shape for buttons or switches, you may want it to have a different look when it is
pressed. In order to support the pressed look, a picture group needs two pictures for each state; one picture is for the
normal (released) look and another picture is for the pressed look.

For example, a 3-state multi-state switch needs a picture group that contains 6 pictures as its picture shape if the pressed
look is required.

The following is an example of a picture group supporting 3 states and the pressed look.

Picture Group State Pictures

= [ I-state Switch 0 (Normal/Released)
E btr000 [S0; Mot preszed)
E btn000p [S0; Prezsed)
E B0 [51; Mat prezsed]
& btn001p [S1; Pressed) 0 (Pressed)
& btn00Z [52: Mot preszed)
& btn00Z2p [S2; Pressed)

1 (Normal/Released)

1 (Pressed)

2 (Normal/Released)

2 (Pressed)

0OOCO0
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2.2.3.3. Picture Database dialog box

The following is an example of the Picture Database dialog box.

Picture Database E|

Fictures Wiew

&) Ipong ” (]
] ArowGroup
E LpGrp01 Cancel
&) Btrt1-up
A switch?_down
= StartBtnGrp
(& start_btr_0(S0: Mot pressed)
& star_btr_1 [S0: Pressed)
(= HomeBtnGmp

home_btn_ 0 [S0; Mot pressed)
F3

B

M

Irpaort. ..

Irport From...

M

home_btn_1 [S0; Pressed) Export. .

(& EBlarkBinGp
B blank_btn_0[S0; Mot preszed)
& blank_btr_1 [50; Pressed)

1] Blue hills

Ao wéater lilies

Ao Suret

o) Minter

o) stop_e

o) stop

o) stop_a

o] Platfarmm tuck

RFALE

AZ| pace zelectar 2

Add Group

m

Export Ta...

~ | |[BITMAR 13301 % 193(H] 256 colars |

Calar Conversion: !D_llhe_nng v_l

Transparent Color:

[ Mave Up ” Miove Down ” Delete ] [#] Transparent

The following table describes how to read or use each of the items in the dialog box.

Item Description

Pictures Lists the pictures and picture groups of the project. You can select a picture or a picture group as the
current selection. You can also make multiple selections.

View Shows the current selection. If the selection is a picture group, the first picture of the group will be
shown.

OK Closes the dialog box and accepts all changes to the picture database.

Cancel Closes the dialog box and discards all changes to the picture database.

Import... Imports a picture from a picture file. The types of importable picture files include: BMP, JPG, GIF,
and WMF.

Import From... Imports pictures from a picture database (PDB) file.

Export... Exports the current picture to a picture file.

Export To... Exports the current selection to a picture database (PDB) file.

Add Group Adds one picture group to the picture database.

Add Item Imports a picture from a picture file and adds the picture to the current picture group.
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Item Description

Add From... Imports pictures from a picture database (PDB) file and adds those pictures to the current picture
group.

Move Up Moves the selection down in the list

Move Down Moves the selection up in the list

Delete Delete the selection.

Color Select Dithering or Nearest Color as the color conversion method.

Conversion If the color resolution of a picture is not compatible with the target panel, the application compiler will

use the specified method to convert the picture data so it can be displayed without too much color
distortion at runtime.

Support Available when the selection is a picture group. Check this item so the current picture group
Pressed Look supports the pressed look. When a picture group supports the pressed look, it needs two pictures for
each state; one picture is for the normal (released) look and another picture is for the pressed look.

Transparent Check this item to enable the transparent feature of the selection; if the selection is a picture, the
picture will be transparent for the specified transparent color; if the selection is a picture group, all
the pictures of the picture group will be transparent for the specified transparent color. Note that this
feature is effective only when a picture or a picture group is shown as the picture shape for an
object.

It is a common practice to make a picture transparent for a certain color so the picture can be shown
as a non-rectangle shape. The following are some examples:

Original Picture Transparent Color Picture Shown
N/
r=)

N/

y

Transparent Available when the Transparent item is checked. Select a color for the transparent color.
Color

Rename Click this button to rename the current picture or the current picture group.

Rotate/Flip Rotates or flips the current picture and saves it as another picture in the picture database.

You can select one of the following 7 methods for the Rotate/Flip operation.

Method | Description

90° Rotates the picture clockwise by 90 degree
180° Rotates the picture clockwise by 180 degree
270° Rotates the picture clockwise by 270 degree
X Flips the picture over X axis

90° & X Rotates the picture clockwise by 90 degree and flips it over X Axis

Y Flips the picture over Y axis

900° &Y Rotates the picture clockwise by 90 degree and flips it over Y Axis

CHAPTER 2 CREATING PROJECTS 2-10



PM Designer Operation Manual

2.2.4. Sound Database

The sound database contains all the sounds used by the project. The sound database is empty initially after the project is
created. Now only the target panel that is PanelExpress supports sound.

You can use a function button to play a sound or stop playing sound. For details, please see Section 5.4.1 Basic
Operations of function buttons

You can use Execute General Command ($C2.f) command flag setting in Command Block to play a sound. For details,
please see Section 3.6.7 Using General Commands.

2.2.4.1. Importing and Exporting Sounds

m Importing Sounds

You need to import a sound before you can use it for the project. There are two ways to import sounds:

1) Use the Sound Database dialog box to import one sound at a time from a sound file. The types of importable sound
files include: WAV.

2) Use the Sound Database dialog box to import many sounds at a time from a sound database (SDB) file.

m Exporting Sounds

You can export the sounds of the project so the other projects can share those sounds by importing them. There are 2
ways to export sounds:

1) Use the Sound Database dialog box to export one sound at a time to a sound file.
2) Use the Sound Database dialog box to export many sounds at a time to a sound database (SDB) file.
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2.2.4.2. Sound Database dialog box

The following is an example of the Sound Database dialog box.

Sound Database ! |

&
E

Sound:
‘Gﬁl Sound Databaze
Jo ding
o ringout
-k' start
o B2
WA
Jo Song for Idie Format:
Length: |00:05
)

[ Rename ][ tove Up ]

l Delete ] [ torve Down ]

The following table describes how to read or use each of the items in the dialog box.

Item Description

Sounds Lists the sounds of the project. You can select a sound as the current selection. You can also make
multiple selections.

Sound Shows the sound information of the current selection such as sound format and the length.

Information You can click E to start playing the sound. Click [1] to pause playing the sound. Click [i] to
stop playing the sound.

OK Closes the dialog box and accepts all changes to the sound database.

Cancel Closes the dialog box and discards all changes to the sound database.

Import... Imports a sound from a sound file. The types of importable sound files include: WAV.

Import From... Imports sounds from a sound database (SDB) file.

Export... Exports the current sound to a sound file.

Export To... Exports the current selection to a sound database (SDB) file.

Rename Click this button to rename the current sound.

Delete Delete the selection.

Move Up Moves the selection down in the list

Move Down Moves the selection up in the list
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2.2.5. Text Database

The Text Database is a dockable window. With the Text Database, you can manage the texts in multiple languages of your
project easily. To open the Text Database, check the Text Database menu item in the Project menu or double click the

Text Database node in the Global in PM Project Manager tool window.

The following is an example of the Text Database that lists the texts in all the languages of the project.

File to Table Icon

Text Databas™

To edit a text, you need to select a text row first by left-click anywhere in it, and then
click the cell of the row to bring up the edit box. In the edit box, you can type the text.

To stop or confirm editing, you can click anywhere outside the selected row.

Table to File Icon

Table to Application Icon

Application to Table Icon

= T..
YiLE %ﬂ %T |
The name of the table. You " /SttingID | English ERghir Tal4F 3 -+
can select a table from ('} aonoot General —HREETE —REE
Table A to Table L. A000z Touch Parnel HrEREE R #FRhE IR
A0003 Link 1 P EE—
A0004 Link, 2 pi= 1 EEC
A0005 Panel Setup MHEEE AAEE
A0006 Fun EiT 15T
A0007 Copy AP to HMI IERRER 3 A Hhm EEA L
A000E Link 3 HE= EE=
A0009 Lirk 4 EER EEMA
A0010 Eoot from File T FEETRER MIrETTR A
A0011 IUpdate from File et E R FRER MIrEERE A
A0z Copy AP ko File ENERIEE FhR A3
A0013 FTP Site FTPaliRs3 FTP JR=5-53
an014 Clear Recorded Data EEEsCiE G EEEiE T
A0015 LAM Printer Address HERE ENTTigH E FAEEHT AL HhE
A0016 Set Time/Date EETERE wEAFER
A0017 Check Batkery: T Eih: T At
A0018 False 5 5
A0019 True = =
A00Z0 Screen Saver Time (minutes):  SSEE{REERER (4 RE{R{PEES)
&0021 Al To Fun Panel Setup: MEFRT AMRRERET.  MiThiT AEERER
a00zz BRMES T RERIER FHEHATREER
A0023 SRR ENFE A FAEEHT AL HhE
A0024 i 5
ADDZS i i A
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You can click the following icons to bring up the corresponding dialog box to import or export texts.

Icon Description
Imports texts from a text file(.txt file) to the selected the table.

=]
=

Import Text Table

From/File: |D:\PanelMaster|PMItext, T)T

Table A v Select an operation from the
dropdown list. You can overwrite

Operation: | Cverwrite the table or append the text to
the table.
Check the languages below that wou wank to impark Eheir ek,

To)Tahble:

Import To Table Language Fraom File Language
m| English English
c| R ol

fal 4 P e

If the Import box of a language is
checked, the texts of that language in
the text file will be imported into the
table. If the Import box of a language is
unchecked, the texts of that language
won't be imported.

Exports texts from the selected table to a text file (.txt file).

H
=] | )
Export Text Table E|E|

Fram Table: |Table & w

TojFile: [ihPanelMasteriPMIbext, THT

Check the languages below that vou want to export their text,

Export Language
English
Faahir

(=

If the Export box of a language is
checked, the texts of that language in
the table will be exported to the file. If
the Export box of a language is
unchecked, the texts of that language
won't be exported.
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Icon Description
o Imports texts from the selected table to a panel application in the same project.
oI Import Fanel Application Text
Table Name
Friarm)Table: —
Tojdpplication: Tat — T
\| Application Name
Reference Language: | English w
Selection:
Irnport Language
Endlish
R
If the Import box of a language is
checked, the texts of that language in
the table will be imported into the
application. If the Import box of a
language is unchecked, the texts of
that language won't be imported. >
| J
T Exports texts from a panel application of the project to the selected table.
8 Export Fanel Application Text
Fromj#pplcaton v
TofTable: Table & w
[ )
| Expart | | Cancel |

You can right-click the Text Database to get the popup menu with the following menu items:

Menu Item Description

Cut Cut the selected text and put it on the Clipboard.

Copy Copy the selected text and put it on the Clipboard.

Paste Insert the text on the Clipboard to the current table.

Delete Delete the selected text.

<Language name> Check the language name to display the text of objects in the selected
language.
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2.3. Working with Tags

A tag represents a single input or output variable monitored or controlled by the system. By changing tags, you can use
any PLC or controller without re-developing the application. This chapter explains how you can define and manage tags by
tags editor.

After the tag is created in tags editor, you can use it in your application by Select Tag Dialog Box. Please see Section
4.4.3.3 Selecting Tags for details. Or you can specify the tag by yourself. The format of a tag is Link Number\Tag Group
Name\Tag Name.

For example:
Tags Description
1\MONITOR\CORE DISPLAY | Indicates a local tag named CORE DISPLAY in MONITOR tag group of link 1
O0\BOT\DECLARE Indicates a local tag named DECLARE in BOT tag group of internal memory
0\ _ALARM SHOW Indicates a global tag named _ ALARM SHOW of internal memory

Note that the maximum text amount of the tag/tag group name is 48 characters. You are allowed to define not only tags for
the link but also the tags for a tag group of the link.

2.3.1. Types of Tags
In PM designer, there are two types of tags: global tags and local tags.

m Global Tag

A global tag is a tag that can be used by all panel applications in the same project. With global tags, the panel applications
in the same projects can share the common address declaration without having to keep and maintain the same set of tags
locally.

Note that a global tag can be only associated with internal variables.

m Local Tag
A local tag is a tag that can be only used by the panel application which the tag is located in.

2.3.2. Opening and Closing Tags Editor
m  Opening Tags Editor

To open the global tags editor, use the Global Tags... command on the Project menu, or double click Global > Global Tags
item in the Project Manager tool window, or right-click the Global > Global Tags item in the Project Manager tool window to
bring out the popup menu and then use the Open command on the popup menu.

To open the local tags editor, use the Tags... command on the Panel menu, or double click Panel Application > Tags item
in the Project Manager tool window, or right-click the Panel Application > Tags item in the Project Manager tool window to
bring out the popup menu and then use the Open command on the popup menu.

m  Closing Tags Editor

To close the tag editor, select the window and click the close button, or choose Windows... on the Window menu, select
the window you want to close in the window dialog and then click Close Window(s) button. You can also right-click the
Global > Global Tags item (Panel Application > Tags item) in the Project Manager tool window to bring out the popup menu
and then use the Close command on the popup menu to close the global tags editor(the local tags editor).
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2.3.3. Creating Tags by Tags Editor

You can use tags editor to create and manage tags. The tags editor is split into two panes: Tag Group Explorer on the left
and Tag List Window on the right. Each pane scrolls separately, both horizontally and vertically. You can position the
mouse over the vertical splitter bar and drag the bar to resize the panes.

The following is an example of the tags editor.

List all the Tags for the
active tag group named
MONITOR

Tag Group Explorer List all the Tags for the link

Tag List Window

= Internal Memory (L DBOTTOM LAYER | CLOSK WOBLTOR |YTSTEW | F-F CHANGE | OFEN | HILD . | INTRUSION | IJ £ & HOLD SHOW | < »
BOT
H matic S7-300(P| Port) Name Data Type Address Length ScanRate Comment
BEOTTOM LAYER 1 CORE DISPLAY 32-Bit Unsigned Integer QD512 Fast CORE DISP..
Tag GrOUpS 2 START TIME 16-Bit Unsigned Integer Q1 58 Fast START TIME
3 CLM. TIME 16-Bit Unsigned Integer Q] ag Fast CLOSE MOL..
F-P CHAMGE 1
4 REC. TIME 16-Bit Unsigned Integer iy 46 Fast REC. TIME
a SBE. TIME 16-Bit Unsigned Integer i1 33 Fast SBE. TIME
INTRIJSION — -
= MU & HOLD SHow | | B | OPM.TIME 16-Bit BCD Q123 Fast OPM. TIME
PRINT OUT 7 | COOLTIME 12-BitBCD QD151 Fast COOL TIME
LARK —_—
CTATISTIC & | CLOSE/OPEN BAR | 16-Bit Signed Integer 23 Fast
g2 . —
= &G Recipes 9 | INMREC BAR 16-Bit Signed Integer D752 Fast
25 mold(0) i
2535 mold[1) 10 | light ASCI String con 10 Mormal
= - i
¥ machine instal(2] 11 | COMTADOR 32-Bit Signed Integer apan Fast
= @ Data Loggers
< TEMP 1[0) 12 | DEFECTOS 32-Bit Signed Integer Qo200 Fast
& TEMP 2(1] — : : -
@ TEMF 3(2) 13 | SCREW ROTATE 32-BitFloating Paint YDag Fast
g TEMP 4(3) 14 | light1 ABCI String C200 20 Marmal
TEMP 5[4] —
18 | WSG1 32-Bit Unsigned Integer whaz2 Fast
16 | light2 ASCI String c400 |10 Mormal
Vertical Splitter Bar 17
>
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2.3.3.1. Tag Group Explorer

Tag explorer displays links, recipes, data loggers and their tag groups if any. From tags explorer, you can:
m  Open atag group of a link for editing by clicking the node

m Import and export tags of a link
Described in Section 2.3.4

m  Add new groups to a link and delete or rename the existing tag groups
Described in Section 2.3.5

m View tags (Data Items) of recipes and data loggers.

If there are any recipes or data loggers in the application, the tag editor will display their data items as the tags. All the
data items (tags) for the recipes or data loggers are read only in the tag editor. If you want to edit the data items (tags),
please use the corresponding dialog box.

Becipe Block

BOTTOM LAYER | =old(0) |mold(1) | machine i4 ¥
E"LDDNEiEDH Name reneral Data Ttem
SYSTEM CROD You can edit the data items of S
EEE%HANGE CRO: the selected recipe block with Addr. Name
HOLD F. CROG the recipe block dl_alog box. RO
INTRUSION orod | Please see Section 10.5
INJ & HOLD SHOTH) |~ Setting up Recipe Blocks for CRO:1
FRINT QUT CROE details
ALARM RO ' CRO3
STATISTIC :
=& Recipes CROE < > CRO:4
%5 mold(0] _—
] mo|d[1]\& CROA
%25 machine install2) - i
Ei @gt?tﬁg?&] Recipe Block Name (ID) CROT
@ TEMP 20) | I CROA

% TEMP 3(2]
TEMP 4(3) Data Logger Name (ID )
e TEMPEM]E 99 (D) CROA
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2.3.3.2. Tag List Window

Tag list window displays all the tags related to selected tag group. In the tag list window, you can:

m  Make switching between tag groups by clicking the window tab

m  Click any column header to sort the list

m  Add atag by defining the tag name and then click any other cells to edit the elements of the tag

The following table describes each attribute of the tag.

Item

Description

Name

Specifies the name for the tag.

The name must be unique in the tag group.

The maximum text amount of the name is 48 characters. And Chinese characters are
supported.

The name can not start with a number and can not be the same as a macro keyword.

The name of global tags must start with underline (_ ). But the name of the local tags can not
start with underline ( _).

Data Type

Selects the data type for the tag from the dropdown list. The supported data types for each tag
are some of the followings: 16-Bit Unsigned Integer, 32-Bit Unsigned Integer, 16-Bit Signed
Integer, 32-Bit Signed Integer, 16-Bit BCD, 32-Bit BCD, 32-Bit Floating Point, ASCII String,
Bit.

Address | <Edit
Box>

Specifies the bit address when the Data Type is Bit, otherwise specifies the word address.

Clicks this icon to bring up the Address Input Keypad and specify the desired address for the
<Edit Box> field.

Length Specifies the string length when the Data Type is ASCII string, otherwise displays n/a

Scan Rate Selects the scan rate for the tag from the dropdown list. The supported scan rates for each tag
are Fast and Normal.

Comment Type a comment for the tag.

m  Cut, copy, paste and delete selected tags using menu commands or key combination

You can right-click the number column to display a popup menu of editing commands. The editing commands available
depend on what the pointer is pointing to.

The following table shows the supported editing commands.

Menu Command Key Combination Description

Cut CTRL+X Removes selected tags from the active window and saves them to
the Clipboard.

Copy CTRL+C Duplicates selected tags in the active window.

Paste CTRL+V Pastes cut or copied tags into an active window.

Delete DELETE Deletes tags without copying it to the Clipboard.

Note that all editing commands require a selection in order to work. To select a tag, click the row on its header number
column. To select multiple tags, click the row on its heard column and use Ctrl+Click to add a row to the selection.
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2.3.4. Importing and Exporting Tags

= Importing Tags
1) Right-click the Internal Memory or a link or any of their tag groups item in the Tag Group Explorer to bring out the
popup menu and then use the Import Tags... command on the popup menu.

2) Click the *.csv file you want to import. If you want to open a tags import file that was saved in a different folder, locate
and open the folder first.

3) Click Open.
Note: If the file format is not correct, the import operation will be cancelled.
Note:  The tags import file can contain tags only or many tag groups and their tags.

Note: If the name of a tag in the file exists in the tag group, you will be asked to confirm whether to replace the existing
tag or not.

e If selecting Yes, the tag in the tag group will be replaced by the tag from the file.
e If selecting No, only the tag with nonexistent name will be imported.
e If selecting Cancel, the import operation will be cancelled.

Note: If the tag group name in the file exists in the link, you will be asked to confirm whether to replace the existing tag
group or not.

e If selecting Yes, the tags in the existing tag group will be removed and replaced by the tags from the file.
e If selecting No, only the tag group with nonexistent name and its tags will be imported.
e If selecting Cancel, the import operation will be cancelled.

m  Exporting Tags
If you have tags you want to reuse in another application panel, you can export the tags of the selected tag group as a .csv
file. You may do the following:

1) Locate the tag group you would like to export
2) Right-click on the tag group to display the item's "popup menu"; and then click Export Tags..., the second menu item.
3) If you want to save tags in a different folder, locate and open the folder first. then click Save.

You can export all the tags of the internal memory or a link as a .csv file by right-clicking on the internal memory or a link
item and then using the Export All Tags command on the popup menu.

2.3.5. Adding/Deleting/Renaming Tag Groups

m Adding a Tag Group
1) Click the link or the internal memory you want to add a tag group for
2) Right-click the selected item to display the popup menu, and then click Add Group menu

3) The new tag group will be added at the end of the link. And the default tag group name will become selected for
renaming.

m Deleting a Tag Group:
1) Locate the tag group you would like to delete
2) Right-click on the tag group to display the popup menu; and then click Delete Group

Note: You can only select one tag group to delete at one time.

= Renaming a Tag Group:
1) Locate the tag group you would like to rename
2) Right-click on the tag group to display the popup menu; and then click Rename Group or click the tag group

3) The tag group name will become selected, simply type the new name over the selected text, and then press the
ENTER key or click anywhere outside the editing field.
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3.1. Setting up the Panel Application

You can set up the panel application with the General Setup dialog box. There are five ways to open the dialog box:
1) Inthe PM Designer's Project Manager tool window, double-click the Panel Application node ( = ).

2) In the PM Designer's Project Manager tool window, right-click the Panel Application node ( @ ) to bring out the
popup menu and select General Setup menu item.

3) Inthe PM Designer's Project Manager tool window, double-click the General Setup Node ( & ) in Panel Application >
Setup

4) In the PM Designer's Project Manager tool window, right-click the General Setup Node ( &2 ) in Panel Application >
Setup to bring out the popup menu and select Properties menu item.

5) In the PM Designer's menu bar, click Panel to bring up the Panel sub-menu. Click General Setup...in the Panel
sub-menu.

The General Setup dialog box contains the following pages. Some of the pages appear only when they are needed.
m  General
Described in Section 3.1.1.

m Custom
Described in Section 3.1.2.

m  Keys
Described in Section 3.1.3.

m  Startup Macro / Main Macro / Event Macro / Time Macro
Described in Section 14.2.6.
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3.1.1. General Settings

This section describes how to define the general settings for a panel application. The following is an example of the
General page of the General Setup dialog box.

General Setup [5__(|
Event Macro #3 Timne b acro #1 Time Macro #2 Time Macro #3 Time Macro H#4
General | Custom Startup M acro b ain b acro Ewvent Macro #1 Event Macro #2

Application M ame:; | |
Model: | PY104-MT [Ethernet) W |E] Battery Backed Rak: |128 KB »

Start Up b acro
Startup Macro

Screen: | 3 b || Operator w |

Delay Time: second(s] Display Countdowr ilehiilacic

L | Englch 3 | Event Macro #1:  Trigger bit : | #O " |
Ewent Macro #2: Trigger bit : | #5 v |

[ ] Login Required Default User Level - Bl a8 T | #e 3 |

ldle Proceszing []Event Macmo #4

Bl canzen Idle: Time: iz Time Macra #1: Time Interval: | 0.5 * | second

Idle Screen: | EL | | S ereen Saver ~ | Time Macro #2:  Time Interval : seconds

Change Uszer Lewvel |dle Uszer Level: Time Macro 83 Time Interval ;|10 | minutes

Screan Saver Time: Tilies Time Macro #4 ;. Time Interval ; hiowrs
Frirt

Buzzer Sounding Time: : seconds Frinter; | HF Lazerdet [Ethernet; B00 dpi; 16 grey levels] |

Overlapped buttons can be activated in sequence by one touch

M aote:

Thiz iz an example.

(] l[ Cancel ] Help
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The following table describes each item in the General page.

Item

Description

Application Name

The name of the panel application.

Model

The model of the target panel.

Click E] to bring up the Panel Model dialog box which helps you to select a
model by specifying the size, resolution and orientation of the display.

The following is a sample of Panel Model dialog box

Dizplay Size: 104" v
Display Rezolution; B40 « 450 w
Digplay Orientation: Landzcape b
b adel: F104%NT [Ethemnet) w

Battery Backed RAM

Specifies the size of the battery backed RAM installed in the target panel.

Use External Keypad

Available if the target panel supports the custom designed external keypad. For
example PV037-LSK, PV037V-LSK, PLO37-LSK...

Select this option if the application uses a custom designed external keypad.

Start Up Screen Specifies the first screen of the application that the target panel will display after
power up.
Delay Time Specifies the time that the target panel will delay to run the application.
Display Check this option if you want the target panel to display countdown while it is
Countdown waliting for the expiry of the Delay Time.
Language Specifies the language that the application will display the text for after power up.
Login Required Check this option if you want the target panel to get a valid password from the
operator before it displays the first screen.
Default User Available when the Login Required is not selected. Specifies the user level as the
Level initial user level for the application. When the target panel starts the application, it
sets the current user level to the initial user level.
Idle Display Idle Check this option if you want the target panel to display the Idle Screen when the
Processing Screen target panel has not been operated by the operator for the specified amount of
time. The specified amount of time is called the idle time.
Idle Time The amount of time that will be used to decide if the idle screen should be
displayed.
Idle Screen Specifies the screen that will be displayed as the idle screen.
Change User Check this option if you want the target panel to change the current user level
Level when the idle screen is displayed.
Idle User Level Available when the Change User Level is selected. Specifies the user level that
will be the current user level when the idle screen is displayed.
Screen Saver Specifies the screen saver time. The target panel will turn off its backlight when it
Time has not been operated by the operator for the specified amount of time.
Continued
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Item

Description

Buzzer Sounding Time

Specifies the length of the beep sounded by the buzzer when a touch operation is
activated.

Overlapped buttons can be
activated in sequence by one

touch

Check this option if you want the application to have the feature that the
overlapped buttons can be activated in sequence by one touch. This feature
allows the operator to issue multiple data settings or commands with one touch.
There are some constraints using this feature. See Section 3.1.3 for details.

Note

You can type a note for the panel application.

Macro

Startup Macro

Check this item if you want the application to have the Startup macro.
The Startup macro is run only once when the application starts. The target panel
will not display the start-up screen until the macro terminates. You can use
Startup macro to initialize global data and settings for your application.

Main Macro

Check this item if you want the application to have the Main macro.

The Main macro is run all the time while the application is running. The target
panel runs the Main macro cyclically, i.e. it runs Main macro starting from the first
command again each time after it completes the processing of the last command
of the macro or when it encounters an END command in the middle of the macro.

Event Macro #1~#4

An Event macro is run whenever the associated trigger bit changes from 0 (Off) to
1 (On). An application can have up to four Event macros. If the application needs
an Event macro for a certain event, check one of the items that are available and
specify the associated trigger bit for the corresponding Event macro.

Time Macro #1~#4

A Time macro is run periodically with a preset time interval. An application can
have up to four Time macros. Each Time macro has a different set of time
intervals you can choose to specify how often you want it to run. The following
table describes the available time intervals for each Time macro.

Time Macro Available Time Intervals Remark

#1 0.5 and 1 second

#2 1, 2, 3, ... and 59 seconds

#3 1, 2, 3, ... and 59 minutes The macro is run at 0 second.

#4 1, 2, 3, ... and 24 hours The macro is run on the clock.

If the application needs a Time macro, check the item of an appropriate Time
macro and specify the time interval for that Time macro.

Print

Printer

Specifies the type of printer that the application will use.

Port

Specifies the port of the target panel that will connect to the printer.
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3.1.2. Custom Settings

This section describes how to define the customization settings for a panel application. The following is an example of the
Custom page of the General Setup dialog box.

General Setup [‘S__<|
General | Custom |
Decimal Murmber Keppad Touch Operation Dizabled Siga
Usze custom keypad Use cuzstom sign
YWindow Screemn: | 21 w " by Mumenc Feypad w | Pic.: | stop_g W |
Hexadecimal Mumber Keypad Transparent
[ ]Use custom keypad T. Color; @

Oetal Mumber Keypad

[] Uze custom keypad
Time/Date Format for Test Files

Date: | -MM-DD »

Character Keypad
aracter keypa Time: | HH:MMR:55  »

IJze custom keppad

Window Screer: | 22w " My Character Keppad w User Level Required In Panel Setup

Set Time/D ate:

Frohibit uploading and copying of the panel
application stared in the HAMI Lt

Pazsword Feypad
IJze cugtom keypad
Window Screen: | 2 w || PSW Keypad L |

The following table describes each item in the Custom page.

Item Description
Decimal Use custom Check this item if you want the application to use the custom keypad instead of the
Number keypad built-in keypad for the entry of decimal nhumbers.
Keypad Window Specify the window screen that is designed as the decimal number keypad.
Screen
Hexadecimal Use custom Check this item if you want the application to use the custom keypad instead of the
Number keypad built-in keypad for the entry of hexadecimal numbers.
Keypad Window Specify the window screen that is designed as the hexadecimal number keypad.
Screen
Octal Use custom Check this item if you want the application to use the custom keypad instead of the
Number keypad built-in keypad for the entry of octal numbers.
Keypad Window Specify the window screen that is designed as the octal number keypad.
Screen

Continued
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Item

Description

Character Keypad

Use custom
keypad

Check this item if you want the application to use the custom keypad
instead of the built-in keypad for the entry of characters.

Window Screen

Specify the window screen that is designed as the character keypad.

Password Keypad

Use custom
keypad

Check this item if you want the application to use the custom keypad
instead of the built-in keypad for the entry of passwords.

Window Screen

Specify the window screen that is designed as the password keypad.

Default Folder for File I/O

This field is available only when the target panel is PanelExpress. There
are 4 kinds of default folder that you can select for your application. They
are Same as Application File, Pre-assigned, New Per Day, New Per
Month. Please see Section 3.1.4 for details

Touch Operation Use custom Check this item if you want the application to display the custom sign
Disabled Sign sign instead of the built-in sign when the touch operation of an object is
disabled.
Picture Specify the picture that is to replace the built-in sign.
Transparent Select this item if you want parts of the custom sign to be transparent.
T. Color Specify the transparent color.
Time/Date Format Date The date format that the target panel will use to output date information to
for Text Files text files.
Time The time format that the target panel will use to output time information to
text files.
User Level Required Set Time/Date The minimum user level that is required to set the time and date of the

in Panel Setup

target panel through the target panel's Panel Setup menu.

Prohibit uploading and copying of the
panel application stored in the HMI unit

Check this option if you want to prohibit uploading and copying of the
panel application stored in the HMI unit.
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3.1.3. Activating Multiple Overlapped Buttons by One Touch

To enable the feature of activating multiple overlapped buttons by one touch, open the Panel General Setup dialog box and
check the option of “Activate multiple overlapped buttons by one touch” on the General page. With this feature, the
overlapped underlying buttons will be activated one by one from top to bottom when the top-most button is pressed. The
following are the constraints of applying this feature.

1.

The types of buttons that support this feature include: Bit Button, Toggle Switch, Screen Button, Function Button, Word
Button, Multi-state Switch, and Keypad Button.

The first button, i.e. the top-most button, can only be a bit button, a toggle switch, a word button, a multi-state switch, or
a keypad button. The button can not have the optional property of Minimum Hold Time or Operator Confirmation. If the
button is a bit button, a toggle switch, or a keypad button, it can not have any macro. If the button is a word button, it
can not be configured for Enter Value or Enter Password. If the button is a multi-state switch, it can not be configured
as a List or Drop-down List.

The underlying buttons that have the optional property of Minimum Hold Time or Operator Confirmation will not be
activated.

An underlying bit button that is configured for Momentary ON or Momentary OFF will not be activated. However if that
bit button is the second button and the first button is a keypad button, it can be activated. An underlying bit button that
has any macro will not be activated.

An underlying toggle switch that has any macro will not be activated.

An underlying multi-state switch that is configured as a List or Drop-down List will not be activated.

A function button can only be the last button, i.e. the bottom-most button. All the buttons that are under a function
button will not be activated.

A screen button can only be the last button. All the buttons that are under a screen button will not be activated.

A word button that is configured for Enter Value or Enter Password can only be the last button. All the buttons that are
under such button will not be activated.

10. The maximal number of buttons that can be indirectly activated by one touch is 10.
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3.1.4. Specifying Default Folder for File 1/0

The default folder will be used for a file I/O operation when one of the following two conditions exists:
1) The command issued for the operation does not require the specification of a filename.
2) The command issued for the operation requires a filename and the specified filename contains no path information.

To specify the default folder, you need go to the “Custom” page of the “Panel General Setup” dialog box. To go there, select
the menu item “General Setup” in the submenu “Panel” to get the dialog box, then click the “Custom” tab. Another way to
get the dialog box is to double-click the “Panel General Setup” node on the project tree.

On the “Custom” page, you can specify the desired default folder in the “Default Folder for File I/O” group according to the
following rules:

1) If you want the folder of your application file (.pe2 or .pl2 file) to be the default folder, select “Same as Application File”
in the “Option” combo box.

Drefault Falder for File 140

Option: | Same as Application File w

For applications with this selection running on HMI units, because the applications are not stored in any file and under
any directory, the root directory of the USB memory stick will be used as the default folder instead.

2) If you want to use a specific folder that will exist at run-time as the default folder, select “Pre-assigned” in the “Option”
combo box and specify the folder in the “Folder” edit box.

Drefault Folder for File [0
Option: | Pre-azsigned L

Falder, [C:%

Note that the specified folder must exist at the run-time or the file /O operations will fail.
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3) If your application needs a new default folder every day, select “New Per Day” in the “Option” combo box
and specify the following 3 items:
A) Folder Path: The path for the new folder. The system will create a new default folder under the specified path
every day.
B) Folder Name Format: The format to create a default folder name.

C) <Prefix>: The string to be used as the prefix of the new default folder names. Note that only ASCII characters
are allowed.

Drefault Falder far File 10

Optior; | Mew Per Day w
Folder Path: | C:%
Folder Mame Format: | <Prefias wmmdd M| <Prefi:

e.q.: ChW0E1231

Example:
Folder Name Format Folder Path <Prefix> Date Default Folder Name
<Prefix>yymmdd C: ABC December 19, 2008 C:\ABC081219
<Prefix>yyyymmdd D:NEO ABC_ December 19, 2008 D:ANEO\ABC 20081219
<Prefix>yyMMMdd C: XYZ January 10, 2009 C:\XYZ09JAN10
<Prefix>yyyyMMMdd D:\123 XYZ_ January 10, 2009 D:\123\XYZ_2009JAN10

4) If your application needs a new default folder every month, select “New Per Month” in the “Option” combo box and
specify the following 3 items:
A) Folder Path: The path for the new folder. The system will create a new default folder under the specified path
every month.
B) Folder Name Format: The format to create a default folder name.
C) <Prefix>: The string to be used as the prefix of the new default folder names. Note that only ASCII characters
are allowed.

Drefault Folder for File 140

Option: | Mew Per Manth w
Folder Path; | E:h
Folder Mame Farmat: | <Prefiaxpymm ¥ <Prefig:
g0 CAA0E12

Example:
Folder Name Format Folder Path <Prefix> Date Default Folder Name
<Prefix>yymm C: ABC December 19, 2008 C:\ABCO0812
<Prefix>yyyymm D:\NEO ABC_ December 19, 2008 D:ANEO\ABC_200812
<Prefix>yyMMM C: XYZ January 10, 2009 C:\XYZ09JAN
<Prefix>yyyyMMM D:\123 XYZ_ January 10, 2009 D:\123\XYZ_2009JAN
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3.2. Working with Keys

Some of the target panels are key type. Those key type panels carry external keys that you can press to perform the
defined operations.

To assign or change the operation of the keys in the panel application, you can use the following two ways:

m  Default Settings for the Panel Application
Described in Section 3.2.1.

m  Settings for a Screen
Described in Section 3.2.2.
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3.2.1. Default Settings for the Panel Application

The default settings are the settings that can be used by all screens in the panel application. With the default settings of the
keys, all the screens in the panel application can share the common usages of the keys and do not have to keep and
maintain the same usages in each screen.

You can do the default settings of the keys for the panel application in General Setup property sheet. To open the General
Setup property sheet, please see Section 3.1 Setting up the Panel Application for details. The General Setup property
sheet provides you the Keys page to set up the keys as default.

The following is an example of the Keys page and Usage Setup dialog in General Setup property sheet.

General Setup E|

General | Custom | Keys
ley Usage Usage{Esc +) 5
uF Mone None -
Dowi | one nane €—— Key Usage Table Usage Setup Dialog
F1 Maone Maone
F2 Mane Mone
F3 Maone MNaone
F4 Maone MNone

Usage: | Bit Button w
F5 Maone MNaone

Bit Button
FE Mone Mone i

Function
K20 Mone Mone (5etON O 5et0FF O Momentary ON - (O Momentary OFF (3 Invert
K21 Maone Maone
e, Bit Button Nohe Write Address: 1WM238
K23 Maone MNaone
Vs e — _| If all the screens use the
”| default settings of the key

K2s Mone Mone — named K22, the K22 key
K28 None Mone vanee _ will perform just like the bit
ka7 None None | | [ Enebledby B button when it is pressed.
K30 None Mone That means in any screen
- e — at runtime, the state of

[]Enabled by User Level 1\M238 bit will be inverte_d
K32 Mane Mane _ when the K22 Key is

[ Operatar Confirmation

. pressed.
[ Watification
I Ok H Cancel ][ Help ]

There are two parts in the above illustration: Key Usage Table and Usage Setup Dialog.

m  Key Usage Table

A table lists all the keys of the target panel and their default usages. The key usage table here is empty (Usages for key
and key combination are none) initially after the panel application is created. For details about Key Usage Table, please
see Section 3.2.3

m  Usage Setup Dialog

A floating dialog box allows you specify the usage for the selected key or key combination. You can left-click the cell in the
key usage table to bring up the dialog. For details about Usage Setup Dialog, please see Section 3.2.4.
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3.2.2. Settings for a Screen

Each screen can have its own key operation. If you want a key to perform an operation only in the specified screen, you
need do the settings of the keys for the screen in Screen Properties property sheet. To open the Screen Properties
property sheet, please see Section 3.9.3 Setting up a Screen for details. The Screen Properties property sheet provides
you the Keys page to set up the keys for the screen.

The following is an example of the Keys page and Usage Setup dialog in Screen Properties property sheet.

Screen Properties §|

General | Background | Keps

3

ey Usage Usage(Esc +) >
i Mone Mone o | Key Usage Table Usage Setup Dialog
DO MHone MHone
F1 Bit Buttan Mane
F2 Screen Button | Mane [ Use Defaul
F3 Bit Button Mane U - [Soreen Buttan 3 - - -
: = »{ F5 key will perform just like
Fd Bit Buttan Maone o
Sereen Button the screen button when it is
il Screen Bufton | None Function pressed. That means at
F& MNane Mane (%) Open Screen () Previous Screen () Close & Open Screen (O Cloge Screen runtime, the screen 253 will
K20 Mone Mone be opened when the F5
K21 None None | | SCeerl223 M| Technical Suppor A Key is pressed in the
, specified screen.
K22 Bit Button Mone [] Change uszer level to: p
k23 Mone Mone [ Acknowledae alarm
k24 Mone Maone
Advanced
k24 Mone Maone
[ Enabled by Bit
k26 Mone Maone
K27 MNone Maone
K30 Mone Mane ] Enabled by User Level
K3 Mone Maone
K32 Mone Maone

[ Motification

I [0].4 H Cancel H Help ]

There are two parts in the above illustration: Key Usage Table and Usage Setup Dialog.

m  Key Usage Table

Atable lists all the keys of the target panel and their usages in a screen. The key usage table here is the same as the one
in the Keys page of the General Setup property sheet initially after the screen is created. For details about Key Usage
Table, please see Section 3.2.3

m  Usage Setup Dialog

A floating dialog box allows you specify the usage for the selected key or key combination. You can left-click the cell in the
key usage table to bring up the dialog. In the dialog box, Use Default option is checked by default. You can uncheck the
Use Default option to assign a usage for the selected cell and such usage is only available in the specified screen. For
details about Usage Setup Dialog, please see Section 3.2.4.
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3.2.3. Key Usage Table Settings

The key usage table is located in the Keys page of General Setup property sheet or Screen Properties property sheet. It
lists all the keys of the target panel and their default usages. The Keys page is only shown up when the target panel is key

type.

The following table lists key type panels and their available keys.

Model Available Keys
PV037-LSK Provides UP,DOWN F1~F4 by default;
PV037V-LSK Provides UP,DOWN,F1~F6,K20~K37 if using external keypad;
PLO37-LSK Provides ESC-key to double the number of above keys.

PV057-LSK / PV057V-LSK / PL057-LSK Provides UP,DOWN,F1~F6,K20~K37
PV057-TSK / PV0O57V-TSK / PLO57-TSK Provides ESC-key to double the number of above keys.

PV070-WST/ PVO70-WKT Provides F1~F6;
Provides UP,DOWN,F1~F6,K20~K57 if using external keypad.
PanelExpress Provides F1~F12

The following is an example of key usage table in the Keys page.

Keps
Key Usage Usage(Esc +) - There are three columns in the key usage table. The
LIP Mone Maone following table describes each column.
DO Mane None Column Description
: Key Available keys of the target panel.
F1 Bit Button Mone - -
Usage Displays how the key will be used
F2 Screen Button | Maone when it is pressed.
F3 Bit Button Mane Usage(Esc+) | Displays how the key combination
(ESC+Key) will be used when it is
Fa Bit Button Mone pressed.
F5 Sereen Button | Mone This column exists only when the
target panel supports the key
Fi Mone Mone combination.
K20 Mone Maone Note: Left-click the cell will bring up the Usage Setup
Dialog which is used to set up the usage of the selected
K21 Mone Mone cell. For details about Usage Setup Dialog, please
K22 Bit Button MNone see Section 3.2.4.
k23 Mone Mone
24 Mane Mahe
k25 Mone Mone
k26 Mone Mone
k27 Mone Mone
k30 Mone Mone
k31 Mone Mone
k32 Mone Mone 3
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3.2.4. Usage Settings for a Key

You can assign or change the usage for the key or the key combination by Usage Setup Dialog. The Usage Setup dialog is
a floating dialog box that can be moved to anywhere you want.

To open the Usage Setup Dialog, you may left-click the cell in the key usage table. If the selection in the key usage table is
changed, the dialog box will stay open and show all the settings related to the selection.

The following is an example of usage setup dialog.

The name of the 4 r5 X If you want to

key or the key close the dialog,

combination [ Use Defaul click the close
Usage: |Soreen Buton v] button.

Screen Button

Function
(%) Open Scieen () Previous Screen () Close & Open Screen () Close Screen
Screen;| 253 % | | Technical Support W

[ Change user level ta:
] Acknowledge alam

Advanced
] Enabled by Bit

[ 1Enabled by User Level

] Matification
Property Description

Use Default Check this option if you want to use the default setting in the Keys page of the General Setup

property sheet. The field is only available in the Keys page of the Screen Properties property sheet.
Usage Select a usage for the key or key combination. There are 7 choices: None, Bit Button, Function

Button, Keypad Button, Multistate Switch, Screen Button and Word Button.
Bit Button If the usage is Bit Button, you need to specify the following properties:

Property Description
Function Select the operation for the bit button. There are 5 choices: Set ON, Set

OFF, Momentary ON, Momentary OFF, and Invert.
For details, see Section 5.1.1 Basic Operations

Write Address Specifies the bit variable to be operated.

Click to enter an address for this field. Click to select a tag for this
field.

ON Macro Check this option if you want the button to have an ON macro. Select a
macro from the dropdown list. This option is available when the bit button
operation is Set ON, Momentary ON, or Momentary OFF.

OFF Macro Check this option if you want the button to have an OFF macro. Select a
macro from the dropdown list. This option is available when the bit button
operation is Set OFF, Momentary ON, or Momentary OFF.

Continued
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Property Description
Function If the usage is Function Button, you need to specify the following properties:
Button Property Description
Function Specifies the operation that you want the function button to perform. About the
available operations, see Section 5.4.1 Basic Operation.
Keypad If the usage is Keypad Button, you need to specify the following properties:
Button Property Description
Enter Select this item if the button is used to input the specified character to the keypad
Character buffer.
Character Available when the Enter Character is selected. Specifies the character to be
entered in the keypad buffer.
Enter Select this item if the button is used to issue the specified command to the keypad
Command buffer.
Command Available when the Enter Command is selected. Specifies the command to be
issued to the keypad buffer. There are four commands available:
Command Description
Enter Completes the data entry and sends the input string to the
associated object or the system.
Escape Cancels the data entry operation.
Clear Clears the keypad buffer.
Backspace | Removes the last character in the keypad buffer.
Multistate If the usage is Multistate Switch, you need to specify the following properties:
Switch Property Description
State Type The state type of the monitored variable. There are two options: Value and LSB.
For details, see Section 4.4.1.1 State Types
Data Type The data type of the variables specified in this page.
Write Specifies the variable to be controlled.
Address -
Click to enter an address for this field. Click to select a tag for this field.
Total State Specifies the number of valid states that the monitored variable has.
Note: The last state is state N-1 when the Total States is N.
Next State Specifies the method of calculating the next state for the Button control type.
+1 means the next state is the current state plus one when the current state is not
the last state. When the current state is the last state, the next state is state O.
-1 means the next state is the current state minus one when the current state is not
state 0. When the current state is state 0, the next state is the last state.
Screen If the usage is Screen Button, you need to specify the following properties:
Button Property Description
Function Specifies the operation that you want the screen button to perform. There are four
choices: Open Screen, Previous Screen, Close and Open Screen, and Close
Screen. For details, see Section 5.3.1 Basic Operations.
Screen Specifies the screen to be opened.
Change user | Check this option if you want the button to change the current user level.
level to And specifies the new user level to replace the current user level.
Acknowledge | Check this option if you want the button to acknowledge the associated alarm of
alarm the screen where the button is on.
Continued
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Property

Word Button

Description
If the usage is Word Button, you need to specify the following properties:
Property Description
Function Specifies the operation that the word button performs. For details, see Section
5.6.1 Basic Operations.
Data Type The data type of the variable to be controlled.
Write Address | Specifies the variable to be controlled.
Click to enter an address for this field. Click to select a tag for this
field.
Constant The constant for the specified operation.
Minimum The minimum for the specified operation.
Maximum The maximum for the specified operation.
Total Digits The number of digits to be displayed for the Minimum and the Maximum on the
numeric keypad.
Fractional When the Data Type is 32-bit Floating Point, this property specifies the number
Digits of fractional digits to be displayed for the Minimum and the Maximum on the
numeric keypad.
When the Data Type is not 32-bit Floating Point, this property specifies not only
the number of fractional digits to be displayed but also the number of least
significant digits to be displayed as the fractional part. With this feature, an
integer can be shown and entered as a fixed point number. When the
Fractional Digits is nonzero, say N, the entered value will be converted to an
integer according to the following formula before being output.
OutputValue = EnteredValue * (Nth power of 10)
Example:
Display Type Total Fractional | Entered Output
Digits Digits Value Value
32-bit Floating Point 4 12.34 12.34
32-bit Floating Point 4 123.4 Error!
16-bit Signed | 5 123.45 12345
Decimal
16-bit Signed | 5 2 -0.05 -5
Decimal
16-bit Signed | 5 2 3 300
Decimal
Activation Select Button Down item so the touch operation will be activated when the

button is touched. Select this Button Up item so the touch operation will be
activated when the button is released.

Continued
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Property Description
Advanced The following table describes each property in the Advanced group. Some of the properties are
available when need.
Property Description

Enabled by Check this option so the operation of the object will be enabled and disabled by

Bit the specified bit.

Bit Specifies the bit that enables and disables the touch operation.
Click to enter a bit address. Click to select a bit tag.

Enabling Specifies the state (On or Off) that enables the touch operation.

State

Enabled by Check this item so the touch operation of the object will be enabled and

User Level disabled by the current user level.

Lowest Specifies the lowest user level that is required to enable the touch operation.

Enabling

User Level

Operator Check this option if you want the operator to confirm the operation. The

Confirmation | Confirmation box will be displayed when the object performs the operation. If
the operator selects “Yes” in the Confirmation box, the operation will be done. If
the operator selects “No” or the operator does not respond within the specified
time period (Maximum Waiting Time), the operation will be cancelled.

Maximum Specifies the maximum time that the object will wait for the operator's

Waiting Time | confirmation. The operation will be cancelled if the operator does not respond
within this time.

Notification Check this option so the object will notify the specified bit after it finishes the
operation.

Bit Specifies the bit that receives the notification.

State Specifies the state (On or Off) that is used for the notification.
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3.3. Internal Memory

This section describes how to set up and use the internal memory for the panel application.

3.3.1. Types of Internal Memory

The following table describes the types of memory space that can exist or always exist in the internal memory.

Bit: $CBn.b; b: 0~f

Type Address Format Description

Regular user Word: $Un The size of this memory space is settable.

memory Bit: $Un.b; b: 0~f

Battery backed Word: $Nn This memory space is available when the target panel is equipped with

user memory Bit: $Nn.b; b: 0~f battery backed RAM. The size of this memory space is settable.

System memory | Word: $Sn This memory space keeps the system maintained data and information.
Bit: $Sn.b; b: O0~f See Section 3.3.3 for details.

Index registers Word: $In The index registers are provided to support the indirect addressing. To
Bit: $In.b; b: O~f know how to specify indirect address by using index register, please

see Section 3.3.2 for details.
Command block | Word: $CBn This memory space is allocated for storing the data read from the specified

command block.

3.3.2. Index Registers

The index registers are battery backed if the panel has battery backed memory. The index registers are cleared to zero
when the panel application is updated.

You can use the index registers to specify the indirect address. With the support of indirect addressing, an object or macro
can be designed to access different sets of data at run time.

Examples

1) The word address W[$I30] is equivalent to W2000 when the value of $130 is 2000.

2) The word address $U[$I0+123] is equivalent to $U223 when the value of $10 is 100.

3) The bit address $U[$12].a is equivalent to $UO.a when the value of $12 is 0.

4) The word address [$12]:W100 is equivalent to 3:W100 when the value of $I2 is 3.

5) The bit address [$10]: W[$I1+10].f is equivalent to 5:W20.f when the values of $10 and $I1 are 5 and 10 respectively.

Notes:

1) Itis your responsibility to make sure that the values in the index registers will result in valid addresses at runtime. PM
Designer has no way to check the validity of the using of index registers.

2) The offset values must be a positive number and the maximum offset value is 65535.

3) Only $10~$115 can be used for the node address (PLC address) and no offset value is allowed.

4) Make sure the PLC driver you are going to use supports the indirect addressing.
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3.3.3. System Memory

The following table lists the system maintained data and information in the system memory of the PM panels that may be

useful for your application.

Note that in any case do not modify the system memory for any purpose or the system may malfunction or crash.

Address Length | Content
$S0~$S25 26 Keypad input buffer for keypads
$S0: Command code for keypad display
$S1~$S24: Null terminated ASCII character string up to 48 characters
$S42 1 The second and minute of the current time in BCD format
Bit 0~7: Second (0x00~0x59)
Bit 8~15: Minute (0x00~0x59)
$S43 1 The hour of the current time in BCD format and the RTC adjustment parameter
Bit 0~7: Hour (0x00~0x23)
Bit 8~15: RTC adjustment value
$S44 1 The day and month of the current date in BCD format
Bit 0~7: Day (0x01~0x31)
Bit 8~15: Month (0x01~0x12)
$S45 1 The year and the day-of-week of the current date in BCD format
Bit 0~7: Year (0x00~0x99)
Bit 8~15: Day of week (0x00~0x06); O represents Sunday
$S46 1 The second of the current time in binary format (0~59)
$S47 1 The minute of the current time in binary format (0~59)
$548 1 The hour of the current time in binary format (0~23)
$S49 1 The one tenth of the second of the current time in binary format (0~9)
9 represents 0.9 second
$S50 1 The day of the current date in binary format (0~30)
0 represents the first day of a month
$S51 1 The month of the current date in binary format (0~11)
0 represents January
$S52 The year of the current date in binary format (0~99)
$S53 The day of week of the current date in binary format (0~6)
0 represents Sunday
$S219 1 Current user level (0~9); 9 indicates that the user logged in with the developer password
$S230~$S241 | 12 The ASCII character string up to 24 characters to show the allowable input range for
numeric keypads
$S297 1 The lowest user level that can be accepted by the current password keypad. When the
value is 0, any user level is acceptable. When the value is 9, only the developer password
is acceptable.
$S300~$S301 | 2 500ms timer
$S302~$S303 | 2 1 second timer
$S304 1 20 Hz sine wave (-1000 ~ 1000)
$S305 1 20 Hz cosine wave (-1000 ~ 1000)
$S306 1 20 Hz triangle wave (0~1000)
Continued
3-19 CHAPTER3 CREATING PANEL APPLICATIONS




PM Designer Operation Manual

Address Length | Content
$S307 1 System signals
$S307.0: always 0 when ready
$5307.1: always 1 when ready
$S315 1 System status
$S315.0: 1 indicates that the data in battery backed RAM is good
$S317 Current language number (0~9); O represents language #1
$S319 Status bits of USB memory sticks
$S319.0: Drive C (1:0K; 0:None)
$S319.1: Drive D (1:0K; 0:None)
$5319.2: Drive E (1:0K; 0:None)
$S654 1 Link enabled bits for Link 1~16
$S654.0 is for Link 1; 0: Disabled; 1: Enabled
$S654.1 1 is for Link 2;
$S654.f is for Link 16
$S662~$S677 | 32 Communication status words for Link 1~16
$S662 is for Link 1
$S663 is for Link 2
$S677 is for Link 16
Communication Status
Value Meaning Value Meaning
0 OK 13 Invalid request
1 Overrun error 14 Device busy
2 Break error 15 Unknown error
3 Parity error 16 Link disabled
4 Framing error 17 Initialization failure
5 No response 18 Failed to send data
6 Unrecognized response 19 Failed to receive data
7 Timeout 20 Failed to open connection
8 Inactive CTS 21 Connection not ready
9 Checksum error 22 Invalid sub-link
10 Command rejected 23 Invalid COM port
11 Invalid address 24 Error
12 Invalid range 255 Uncertain
$S838 1 The ID of the current recipe block (0~15)
$S839~$S854 | 16 The current recipe numbers of recipe block 0~15

$S839 is for recipe block 0
$5840 is for recipe block 1

$S854 is for recipe block 15
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3.3.4. Setting up Internal Memory

You can use the Internal Memory dialog box to define the sizes of the regular user memory and the battery backed user
memory. To open the Internal Memory dialog box, you can do one of followings:

1) In the PM Designer's Project Manager tool window, double-click the Internal Memory Node (‘-'u';“ ) in Panel
Application > Links

2) Inthe PM Designer's Project Manager tool window, right-click the Internal Memory Node (’-f.;‘ ) in Panel Application >
Links to bring out the popup menu and select Properties menu item.

The following is an example of the Internal Memory dialog box.

Internal Memory §|

Reqular zer Memany Specify the size of regular user memory in
word. The size must be between 0 and

Number of words: 5000 <45 131072 words. By default, it is 5000.
arnce|

Bit address range: FU0.0 - $U4599

“Wiord address range: | $U0 - $U4533

Eattery Backed Uszer M . .
SRl aEhed HRer A Specify the size of battery backed user

Murmber of words: 40 <43 memory in word. The size must be between 0
and 131072 words. By default, it is 0.

Bit address range: $MO.0 - $439.1

“Wiord address range: | M0 - M35

Syztem kemaory
Mumber of words: 1024

Bit address range: $50.0- $51023f
“Word address range: | $50 - $51023
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3.4. Communication Links

This section describes how to set up communication links for the panel application to access the data of external devices.

3.4.1. Types of Communication Links

The following table describes the three types of communication links that the panel application can have.

Link Type Description

Direct link A direct link connects the panel and the specified device or devices directly. The following are
examples of the direct links.

[Example 1] The panel uses an RS232 direct link to talk with the specified device directly.

HMI
R5232

Ethernet

Continued
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Link Type

Description

Indirect link

With an indirect link, the panel can talk with a device that is not connected to it. An indirect link
connects the panel and the specified indirect link server. The indirect link server is the target panel
of another panel application of the same project and connects to the specified device directly.

[Example 1] Indirect Link via 2-to-1 Connection

Direct link

Indirect link
via

2-to-1 connection 7 to-1 server

[Example 2] Indirect Link via N-to-1 Connection (COM)

RS5485
HMI HMI — N-to-1 master

. % Direct link
[ |

n
m |
Indirect Link
via
N-to-1 connection (COM)

[Example 3] Indirect Link via N-to-1 Connection (Ethernet)

" nom HMI

Indirect Link via N-to-1
connection (Ethernet)

Ethernet \\\_\4

Direct link

M-to-1 master

Continued
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Link Type Description

Communication | To allow other panels to communicate with the device that is directly connected to the target panel,
service you need to add an appropriate communication service link to the application for that purpose. The
following table describes the available communication services.

Communication Description
Service
2-to-1 Server (COM) You need to specify the data link, i.e. the associated direct link,

for this communication service. This service allows two panels
to talk with one device and only one communication port is
required on that device.

2-to-1 Transparent This communication service makes the target panel a gateway
Server (COM) for another computing device, such as a PC, another PM panel,
or a panel of other brand, to access the associated controller.
See the following diagrams to know the possible applications.

PC 2t0-1 Transparent Server

Any kinds of controller whose communication protocol is of the
request-reply type can be supported by this communication
service. Ask your local representative to check if your controller
is supported. Note that the communication parameters (baud
rate, number of data bits, number of stop bits, and type of parity
check) of the computing device and the communication
parameters of the 2-to-1 Transparent Server must be identical.

Currently supported protocol:
PanelMaster ModBus Device/Slave (RTU)

N-to-1 Master (COM) You need to specify the data link, i.e. the associated direct link,
for this communication service. This service allows up to 16
panels to talk with one device and only one communication port
is required on that device.

N-to-1 Master (Ethernet) | You need to specify the data link, i.e. the associated direct link,
for this communication service. This service allows up to 16
panels to talk with one device and only one communication port
is required on that device.
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This section describes how to define the general settings for the communication links using the General page of the Link
Properties dialog box. The following is an example of the General page that defines a direct link.

Link Properties

General | Parameter
Link Mumber:
Link Mame: |L|NK'| |
Link Type: | Diirect Link [COM) w |
Device/Server: |.-’-'«SI Contrals w || A5IC/2 Protocal [Woke Token) W |
Lirk Port: |I:EIM1 [LIMET ] V| [] 5ub-lirks
Record communication status in operation log
[] Check woard
The duration of showing a communication ermor message: zecond(z)
[ ak. ] [ Cancel ] [ Help ]

The following is an example of the General page that defines a communication service link.

Link Properties

Gieneral | Parameter
Link Murmber:
Link Marne: |Server |
Link Type: | Communication Service [COM] ~ |
Device/Server: | Panelk aster w ” 240-1 Server [COM] E" |
Link Part |COM2 [ Server) |
Data Link: | LINK1 v |
The duration of showing a communication error message; zecond(s]

[ Ok, ] [ Cancel ] [ Help
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The following table describes each property in the General page of the Link Properties dialog box.

Property Description
Link Number The sequence number of the communication link. It is assigned when the link is created and
it will be reassigned when any other link of the same application is removed.
Link Name Specifies the name of the communication link.
Link Type Select one of the following link types for the link:
Link Type Description

Direct Link (COM) The link connects to the specified device directly through the
specified serial (COM) port.

Direct Link The link connects to the specified device directly through the
(Ethernet) specified Ethernet port.

Communication The link connects to one or more other PM panels through the
Service (COM) specified serial (COM) port and provides the communication

service specified in the Device/Server field to the connected PM
panels. See the description of the Device/Server field to know the
available communication services.

Communication The link connects to one or more other PM panels through the
Service (Ethernet) | specified Ethernet port and provides the communication service
specified in the Device/Server field to the connected PM panels.
See the description of the Device/Server field to know the
available communication services.

Indirect Link via The link connects to a PM panel that provides the communication

2-to-1 Connection service as a 2-tol server through the specified serial (COM) port.

(COM) The target panel can communicate with the associated device
indirectly through that PM panel.

Indirect Link via The link connects to a PM panel that provides the communication

N-to-1 Connection | service as a N-tol master through the specified serial (COM) port.

(COM) The target panel can communicate with the associated device
indirectly through that PM panel.

Indirect Link via The link connects to a PM panel that provides the communication

N-to-1 Connection | service as a N-tol master through the specified Ethernet port. The

(Ethernet) target panel can communicate with the associated device

indirectly through that PM panel.

Continued
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Property Description
Device/Server When the Link Type is Direct Link, select a device to specify the connected device of this
link.
When the Link Type is Communication Service (COM), select one of the following servers.
Server Description
2-to-1 Server You need to specify a direct link of the application as the data link for
the service in the Data Link field. The link connects to a PM panel and
allows that panel to communicate with the device connected by the
specified data link indirectly. The panel served by the link must use an
indirect link to accept the service.
2-to-1 You need to specify a direct link of the application as the data link for
Transparent the service in the Data Link field. The link connects to a computing
Server device and allows that device to communicate with the device
connected by the specified data link indirectly. The computing device
can be a PM panel, a panel of other brand, or a PC. If the computing
device is a PM panel, it must use a direct link to accept the service.
N-to-1 You need to specify a direct link of the application as the data link for
Master the service. The link can connect up to 8 PM panels and allow those
panels to communicate with the device connected by the specified
data link indirectly. The panels served by the link must use an indirect
link to accept the service.
When the Link Type is Communication Service (Ethernet), select one of the following
servers.
Service Description
N-to-1 Master You need to specify a direct link of the application as the data link
for the service in the Data Link field. The link can connect up to 8
PM panels and allow those panels to communicate with the device
connected by the specified data link indirectly. The panels served
by the link must use an indirect link to accept the service.
When the Link Type is Indirect Link and the Indirect Link Server Location is specified, the
indirectly connected device is shown here.
Link Port Select a port for this link.
Sub-links When an RS485 communication line has many devices connected to it, the logical
connection of a device on the link with the PM panel is called a sub-link.
This field is available when the Link Type is Direct Link (COM). Select this option if this link
will connect to many devices and you want to identify, monitor, or control the
communication with each connected device.
Data Link Select a direct link of the application as the data link for the communication service when
the Link Type is Communication Service.
Indirect Panel Select the panel application that provides the communication service for this indirect link.
Link Application
Servgr Link Select the communication service link provides the communication service for this indirect
Location link.

Record communication
status in operation log

Check this option if you want the communication status of the link or the link’s sub-links to
be recorded in the operation log. The recordable types of status include: Enabled,
Disabled, Failed, and Recovered. The operation log display can show the logged
communication status.

Check Word

The panel will read the specified word once in a while to check if the connection of the link
is good.

The duration of showing
a communication error

message

The communication error message box will hide and show according to the specified
duration. If the duration is 0, the error message box will not show.
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3.4.3. Parameter Settings (Serial Port)

This section describes how to set up the communication parameters for the serial communication links using the
Parameter page of the Link Properties dialog box.

serial direct link.

The following is an example of the Parameter page for a

The following is an example of the Parameter page for a
N-to-1 master.

Gereral | Parameter

Trahsmission

Baud Fate: | 3600 A
DataBits: | & v
Parity: Ewen w
Stop Bite: |1 ~

General | Parameter | Broadecast Block

Others Tranzmission Others

Panel Address: |1 ¥ Baud Rate: 57600  |» Panel Address:
PLC Address: 3 £ Data Btz | 8 v

Tireout Tirne: 2 o (%01 Sec) B Even 3

Command Delay: |4 S| =01 5ec) StopBits: |1 3

Retry Count: 3 £

M-to-1 Cannection

Specify N-ta-1 Connection Slave Panels. .

The following table describes each property in the Parameter page of the Link Properties dialog box for a serial link.

Property Description
Baud Rate The baud rate used.
Data Bits The number of data bits used.
Parity The scheme of parity used.
Stop Bits The number of stop bits used.
Panel Address The address of the target panel.
PLC Address The address of the connected device.

Timeout Time

The maximum time allowed for the communication driver to wait for the reply from the
connected device. When the elapsed time exceeds the Timeout Time, the communication
driver assumes the communication failed.

Command Delay

If the Command Delay is 0, the communication driver sends the next request immediately to
the connected device after it received the reply of the last request. If the Command Delay is
nonzero, the communication driver delays the specified time before sending the next
request to the connected device.

Retry Count The number of times that the communication driver will retry to get a successful reply from
the connected device for each request. If the number is zero, the communication driver will
use a default retry count.

Specify N-to-1 This button is available when the link is a N-to-1 master. Click this button to bring up the

Connection Slave N-to-1 Connection Slave Panels dialog box. You can define the slave panels of the N-to-1

Panels connection in the dialog box.

Specify Other Data
Sharing Panels

This button is available when the link is a direct link and the connected device is Data
Sharer (RS485). Click this button to bring up the Other Data Sharing Panels dialog box. You

can define the other data sharing panels in the dialog box.
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3.4.4. Parameter Settings (Ethernet Port)

This section describes how to set up the communication parameters for the Ethernet links using the Parameter page of the
Link Properties dialog box. The following is an example of the Parameter page for an Ethernet direct link.

General | Parameter

IPAddress: | 192162 . 10 . 33
[] Use Defaul Part

Part: | 502

Mode Addresz: |1

4

Timeout Time: 1 [# 0.1 Sec.)

Command Delay: (1% | [x0.1 Sec.

4

Retry Count: 3

The following table describes each property in the Parameter page of the Link Properties dialog box for an Ethernet link.

Property Description
IP Address The IP address of the connected device.

Use Default Port Check this option if the default IP port is used

Port Specifies the IP port used
Node Address Specifies the node address of the connected device.
Timeout Time The maximum time allowed for the communication driver to wait for the reply from the connected

device. When the elapsed time exceeds the Timeout Time, the communication driver assumes
the communication failed.

Command Delay If the Command Delay is 0, the communication driver sends the next request immediately to the
connected device after it received the reply of the last request. If the Command Delay is honzero,
the communication driver delays the specified time before sending the next request to the
connected device.

Retry Count The number of times that the communication driver will retry to get a successful reply from the
connected device for each request. If the number is zero, the communication driver will use a
default retry count.
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3.4.5. Sub-link Settings

An RS485 link can have many slave devices connected to it. The HMI uses the same communication protocol to talk with
all those slave devices. The connection between the HMI and each of the slave devices is a sub-link. With the Sub-link
table, the operator can enable or disable a sub-link at any time.

This section describes how to define the sub-links for the direct links using the Sub-link page of the Link Properties dialog
box. The following is an example of the Sub-link page.

General | Parameter | Sub-link

Mumber of subdlinks: |6 L
| Name Node State Show Language:
1 Endglish v
2 Sublink
3 Mame: | TC6
i Mode Address: (B0 »
Z Initial State: | OFf A
Show eror mezsage
Al+Up: Move kem up Al+Dowr: Move item down

The following table describes each property in the Sub-link page of the Link Properties dialog box for a direct link.

Property Description

Number of sub-links Specifies how many devices the link will connects as sub-links.

Language Specifies the current language for the Name field.

Name The name of the selected sub-link for the language specified in the Language field.

Node Address The address of the selected sub-link. The address must be a uniqgue number within all the
sub-links.

Initial State The initial communication state for the selected sub-link. If the state is On, the panel will

communicate with the sub-link after running the application. If the state is Off, the panel will
not communicate with the sub-link until the communication state is turn On in a sub-link table.

Show error message If this option is checked, the communication error message will be shown when the selected
sub-link encounters communication errors. If this option is unchecked, no error message will
be shown for any communication errors.
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3.4.6. Sharing Data among Panels Using Data Sharer

The data sharer is a virtual device. It allows data sharing among up to 16 PM panels on an Ethernet or an RS485 network.
Each of the PM panels can have up to 256 words of data to share.

HMI " aom

Data
Sharer

To set up the communication for the data sharing, create a direct link and select Data Sharer (UDP) or Data Sharer
(RS485) of PanelMaster as the connected device. The panel address that you can set in the Parameter page of the Link
Properties dialog box must be unique for each sharing panels as it is used to identify the shared data.

The communication driver for the link connecting to Data Sharer is responsible for broadcasting the panel's shared data on
the network. For example, if the panel address of a panel is 10 and the number of the link connecting to Data Sharer is 2,
the following Macro command will cause the communication driver to broadcast the corresponding data on the network.

2\P10.0 = MOV($u300, 30)

The communication driver receives the broadcasted shared data on the network automatically. It has a block of memory to
store the shared data. To access a word, use the following address, where m is the panel address and n is the word
number of that panel's shared data.

Pm.n m=1~16; n=0-255

To access a bit, use the following address, where b is a hexadecimal number representing the bit number in the specified
word.

Pm.n.b m=1~16; n=0-255; b=0~f

The UDP is used for the data sharing on Ethernet.
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3.4.7. Using General Device (COM) to Communicate with Unsupported Devices

You can use general device to customize your own serial port communication driver.

To use customized communication protocol, you may do the followings:

1. Select PanelMaster->General Device(COM) as the destination controller in Link Properties dialog box.

Link Properties

General | Parameter

Link, Murnber:
Link Name:  |Link 1 |
Link Type: | Direct Link [COM] w |

Device/Server: | Panelkd aster w ” General Device [COM]

Link Port: | COMZ [ Link 1] “ | [ ] Sub-links

2. Write your own communication protocol by macro commands. The following is an example:

ES Macro — General Dewvice |E||§||z| Properties o x
0 S0 = “ABCDE" Ao 5010 = 4241H, sU11 = 4443H, s012 = 4500H - o -

— TH_ W = MOVI$LU20, 5] /7 Send 5 waords["ABCDE
1 SU20 = B2W(SU1D, S5) ~~ SU20 = D0D41H, SU21 = 0042H, sU22 = 0043H - LT ) U eend s ety ]
2 S 5023 = 0044H, sU024 = 0045H . " -
3 |TX_W = MOV(SU20, 5) -~ Send 5 words("ABCDE") in SU20 to TX ommand: [P1 = OV (2, F3) =
1 < and wait until all datum ars sent Diata Type: |[U]1B-bitUnsigned V|
= Par PT:  [Ti_w &
4 SUZ5 = 0DH < ODH is ASCII code for return charater | |
7 T¥_W = MOV (SUZ0, 6) -~ Send B wards{"ABCDE<CRE>") in SUZ0 ta TX Par P2 |$U20 =)
a A and wailt until all datum are sent Par. F3: |5 |
9
10 TX = MOV (5UZ0, 5) A Jend 5 words in SUZ0 to TH
11

Y
12 5U100 = MOV (RX,5) A Bead 5 words from R¥ to U100 Operation: 3
13 SU100 = MOV (RX_W.5) - REead 5 words from RX to SU100 Copies P3words of P2 to P1.
14 A and wailt until all datum are received
15 Parameters:
16 REZET = 1 (B) ## Reset TX UART and clear R¥ bhuffer —
17 |FLUSH = 1 (B) ~~ Clear RX buffer B Type  |Description
18 The starting location
1a 4 P1 [IIE ofthe memary to
receive the copy.
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The following table describes the bit devices and word devices of general device:

Address

Device
Type

Full Name

Read/Write

Operation

CTS_STS

Bit

Clear To Send

Status

Read only

Get the state of the CTS signal from the destination
device.

I: Transmission prohibited by the destination device.
0: Transmission permitted by the destination device.

When EN_HS is 1, you need to wait for the permission
before sending data by checking whether CTS_STS is 0.

EN_HS

Bit

Enable RTS/CTS
hardware

handshaking

R/W

When EN_HS is 1, before sending data, you need
check whether CTS_STSis 0 and set RTS =1 to
prohibit the data transmission from the destination
device. After finishing data sending, set RTS to O to
permit the transmission.

FLUSH

Bit

Write Only

Set 1 to clear receive buffer.

RESET

Bit

R/W

Set 1 to reset UART and clear receive buffer

RTS

Bit

Request To Send

R/W

Set 1 to prohibit the transmission from the destination
device. Set 0 to permit the transmission

RX

Word

Receive Data

Read only

Read N characters from the receive buffer. If the size of
receive buffer is larger than N, read N characters and
RX_CNT = N; RXB_CNT=RXB_CNT-N;

Otherwise read RXB_CNT characters, and RX_CNT =
RXB_CNT; RXB_CNT=0.

For each receiving operation, RX_STS indicates the
result: 1: Success, 2: Timeout, <0: Failed.

RX_CNT

Word

Receiving Count

Read only

Total characters read from the receive buffer.

RX_STS

Word

Status of the last
receiving

Read only

Get the status of the last receiving.
1: Success, 2: Timeout, <O:Failed.

RX_W

Word

Receive data and
wait until all datum
are received

Read only

Read N characters from the receive buffer. If the size of
receive buffer is larger than N, read N characters and
RX_CNT = N; RXB_CNT=RXB_CNT-N; if RX_STS =
1(Success), continue to read the remaining. Or wait until
time out.

If the size of receive buffer is less than N,. read
RXB_CNT characters, and RX_CNT = RXB_CNT;
RXB_CNT=0.

For each receiving operation, RX_STS indicates the
result: 1: Success, 2: Timeout, <0: Failed.

3

RXB_CNT

Word

Count of Receive
buffer

Read only

The number of bytes of data in the receive buffer.

TO_TIME

Word

Time Out

R/W

Specify the amount of time that the target panel waits
between sending commands to your controller. The unit

of time is 100MS and the default is 0.
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Address D.I? vice Full Name Read/Write Operation
ype
TX Word Transmit Data R/W Transmit Data to the specified COM port. Please do the
following procedure:
1. Wait for the end of last transmission
2. If EN_HS is 1, wait for CTS_STS = 0 to send the
data
3. If EN_HS is 1, set RTS to 1 before sending data.
And set RTS to 0 after transmission is over.
4. If timeout before sending data, TX_STS will be 2
and the operation is cancelled
5. Sending data and TX_STS will be 1, if sending data
is successful.
TX_STS Word Status of the last | Read only Get the status of the last transmission
transmission 1: Success, 2: Timeout, OxF: Sending
TX W Word Transmit Data and | R/W Transmit Data to the specified COM port. Please do the
wait until all datum following procedure:
are sent 1. Wait for the end of last transmission
2. If EN_HS is 1, wait for CTS_STS = 0 to send the
data
3. If EN_HS is 1, set RTS to 1 before sending data.
And set RTS to 0 after transmission is over.
4. If timeout before sending data, TX_STS will be 2
and the operation is cancelled
5. Ready to send data
6. Wait until all datum are sent and TX_STS will be 1, if
sending data is successful.
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3.5. Sound Table

The sound table contains all the sounds used by the panel application. The sound table is empty initially after the panel
application is created.

You can use the sound only if the target panel is PanelExpress. In the PanelExpress application, you can use function
button with play sound operation to play the specified sound.

Before using the sound in the panel application, you need to import or add a sound into the Sound Table.

To open the Sound Table dialog box, please do one of the followings:
1) Inthe PM Designer's Project Manager tool window, double-click the Sound Table ( @:E ) node in Panel Application.

2) In the PM Designer's Project Manager tool window, right-click the Sound Table ( QFE ) node to bring out the popup
menu and select Properties menu item.

2) On the Panel menu, click Sound Table...

The following is an example of the Sound Table dialog box.

Delete

Mowe Lp

Sound Table Zix
Number Name Type
1 chimes Wy
2 ding Wy
4 chord WY
3 recycle WY
-
L=} SECUrity wWEy m

Mave Dawn
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The following table describes how to read or use each of the items in the dialog box.

Item Description
Sounds Lists the sounds for the panel application. You can select a sound as the current selection. You can
also make multiple selections. To select a sound, click the row on its header column of that sound in
the list. To select multiple rows, click the row on its header column and use Ctrl + Click to add a row
to the selection.
The following table describes each column in the sound list.
Column Description
Number The number of the sound in the sound list. The number is an unsigned integer
starting from 0. It must be unique in the panel application. You can click the cell
and then edit the number.
Name The name of the sound. You can click the cell to select a sound predefined in
the Sound Database from the drop down list. To know how to predefine sounds
in Sound Database, please see Section 2.1.3.
Type Displays the type of the sound.
OK Closes the dialog box and accepts all changes to the sound table.
Cancel Closes the dialog box and discards all changes to the sound table.
Import... Imports a sound from a sound file. The types of importable sound files include: WAV only.
Add Adds a sound from the Sound Database to the end of the sound table. To know how to use Sound
Database, please see Section 2.1.3.
Insert Inserts a sound from the Sound Database before the selection. To know how to use Sound
Database, please see Section 2.1.3. This button is available when the selection is made.
Delete Deletes all the selections. This button is available when the selection is made.
Move Up Moves the selection one item down in the list. This button is available when the selection is made.
Move Down Moves the selection one item up in the list. This button is available when the selection is made.
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3.6. Command Block and Status Words

Your can command the panel to do a variety of things using the command block. The command block is a block of words in
your controller or the internal memory. The panel scans the control block periodically and performs the specified
operations according to the contents of the control block. You can decide the size of the command block, the command
words that are required in the command block, and the rate of scanning the command block, so the overhead of reading
the command block is minimized.

The panel can provide its status information to you by writing status values to the status words. The status words are in
your controller or the internal memory. You can decide the status words that are required for your application so the panel
will not waste time to output useless status values.

3.6.1. Types of Command Block and Status Words

There are three types of control block and status words that you can choose for your application.

3.6.1.1. Type A

m Type A Command Block
You can have the following command words for the application and their orders in the command block are adjustable.

Screen Switching Register

You can command the panel to change the main screen or display a window screen by setting this word to the number of
the desired screen.

Command Flag Word (Command Flags #0 ~ #15)
The following table describes the function of each bit in the Command Flag Word.

Bit Function Description
0 (reserved)
1 Switch Language Changes the language that the panel displays.
Parameter One Register: Specifies the number of the desired language
2 Set Current Recipe Sets the current recipe number of the specified recipe block to the specified
Number recipe number.

Parameter One Register: Specifies the recipe number
Parameter Two Register: Specifies the recipe block

Note: You do not need to specify the recipe block if the application has only one
recipe block.

3 Read Recipe From PLC Reads a recipe from the specified address which is defined in the Recipe Block
dialog box and use that recipe to replace the specified recipe of the specified
recipe block.

Parameter One Register: Specifies the recipe number
Parameter Two Register: Specifies the recipe block

Note: You do not need to specify the recipe block if the application has only one
recipe block.

4 Write Recipe To PLC Writes the specified recipe of the specified recipe block to the specified address
which is defined in the Recipe Block dialog box.

Parameter One Register: Specifies the recipe number
Parameter Two Register: Specifies the recipe block

Note: You do not need to specify the recipe block if the application has only one
recipe block.

5 Clear Alarm History Clears the alarm history.

Continued
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Bit Function Description
6 Clear Alarm Count Clears the alarm counts.
7 Sound Buzzer Sounds buzzer.
Parameter One Register: Specifies the sound type.
Sound Type Value Description
0 Continuous beep
1 500ms beeps
2 200ms beeps
3 100ms beeps
4 50ms beeps
8 Print Screen Prints the specified screen.
Parameter One Register Operation
(Undefined) Prints the top screen.
0 Prints the top screen.
The number of the screen Prints the specified screen.
to be printed Note: This operation is not supported by
PL035/037/057/058
9 Backlight On Turns the backlight on.
10 Backlight Off Turns the backlight off.
11 Set Current User Level Sets the current user level to the specified level.
Parameter One Register: the user level
12 Close All Window Closes all window screens.
Screens
13 (reserved)
14 (reserved)
15 Execute General See the section 3.6.7 Using General Commands for details.
Command

Note: To activate any of the above functions, you need to change the corresponding command bit from Off to On. The
panel does not reset the command bit, so you have to reset the command bit before commanding the panel to perform the
same function again. You should keep the state of the command bit long enough so the panel can detect the change. The
best way is to use the corresponding acknowledge bit in the Command Status Word. The panel turns on the acknowledge
bit when it detect the change. It is safe to reset the command bit when you see the acknowledge bit turns on. The panels
turns off the acknowledge bit when it sees the command bit turns off.
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Low Trigger Word (Trigger Bits #0 ~ #15), High Trigger Word (Trigger Bits #16 ~ #31)
You can use the trigger bits to initiate the following operations:

1) Asking the associated data loggers to collect data

2) Asking the associated data loggers to clear their logging buffers

3) Executing event macros

4) Increasing the clock by one hour

5) Decreasing the clock by one hour

6) Logging in

7) Logging out

8) Asking the associated line charts to read and draw a new set of data.

9) Asking the associated line charts to clear its content.

10) Asking the associated scatter charts to read and draw a new set of data.
11) Asking the associated scatter charts to clear its content.

Enabling Word (Enabling Bits #0 ~ #15)
You can use the enabling bits to enable the following operations:
1) The data collection of data loggers

Parameter One Register
This word specifies the parameter #1 for the specified operation.

Parameter Two Register
This word specifies the parameter #2 for the specified operation.

Parameter Three Register
This word specifies the parameter #3 for the specified operation.

Parameter Four Register
This word specifies the parameter #4 for the specified operation.

m Type A Status Words
You can have the following status words for the application.

Status Word Description

Command Status Word
(Command Flag Ack. Bits #0 ~ -#15)

Low Trigger Ack. Word
(Trigger Ack. Bits #0 ~ #15)

High Trigger Ack. Word
(Trigger Ack. Bits #16 ~ #31)

Stores the acknowledge bits of the command bits #0 ~ #15.

Stores the acknowledge bits of the trigger bits #0 ~ #15.

Stores the acknowledge bits of the trigger bits #16 ~ #31.

Current Screen Number Word Stores the current main screen number.

Current Recipe Block ID Word Stores the current recipe block number.

Current Recipe Number Word Stores the current recipe number of the current recipe block.
Current User Level Word Stores the current user level.

Current Language Word Stores the current language number.
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3.6.1.2.

Type H (Binary)

m Type H (Binary) Command Block

You can have the following command words for the application.

Screen Number Register

You can command the panel to change the main screen or display a window screen by setting this word to the number of
the desired screen. You can also use this word to request the panel to 1) change the language, 2) turn on the backlight,
and 3) turn off the backlight. The following table describes how to program this word.

Bit Description
0~9 Specifies the screen to be displayed.
11~13 Specifies the language that the panel displays for.
000: The panel does nothing.
001: The panel changes the language to language 1.
010: The panel changes the language to language 2.
111: The panel changes the language to language 7.
14 If this bit is On, the panel turns off the back light of the display.
15 If this bit is On, the panel turns on the back light of the display.

Command Flag Register
The following table describes the function of each bit in the Command Flag Register.

Bit Function

0 Clears the alarm history.

1 Clears the alarm counts.

2 (reserved)

3 (reserved)

4 Writes the current recipe of recipe block #0 to the address defined in the Recipe Block dialog box of recipe block
#0.

5 Sets the current recipe number of recipe block #0 to the number specified in Recipe Number Register.

6 Reads the recipe from the address defined in the Recipe Block dialog box of recipe block #0 and use it to
replace the current recipe of recipe block #0.
Turns on the buzzer.
Used as trigger bit #4.
Used as trigger bit #5.

10 Used as trigger bit #6.

11 Used as trigger bit #7.

12 Used as trigger bit #0.

13 Used as trigger bit #1.

14 Used as trigger bit #2.

15 Used as trigger bit #3.

Note: To activate any of the above functions, you need to change the corresponding command bit from Off to On. The
panel does not reset the command bit, so you have to reset the command bit before commanding the panel to perform the
same function again. You should keep the state of the command bit long enough so the panel can detect the change. The
best way is to use the corresponding acknowledge bit in the Command Status Word. The panel turns on the acknowledge
bit when it detect the change. It's safe that you reset the command bit when you see the acknowledge bit turns on. The
panels turns off the acknowledge bit when it sees the command bit turns off.
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Recipe Number Register

The number in this word will be used as the current recipe number of recipe block #0 when bit 5 of Command Flag
Register changes from Off to On.

m Type H (Binary) Status Words

You can have the following status words for the application.

Status Word Description

Whenever the panel switches the main screen, it sets this word to the number of
the current main screen.

Command Flag Ack. Word Contains the acknowledge bits for the command flags of Command Flag Register.

Screen Status Word

Current Recipe Number Word Stores the current recipe number of recipe block #0.

3.6.1.3. Type H (BCD)

The command words and status words you can have for the application are the same as the H (Binary) type. However, the
values in the following words must be in BCD format: Screen Number Register, Recipe Number Register, Screen Status
Word, and Current Recipe Number Word.
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3.6.2. General Settings

This section describes how to define the general settings for the command words and the status words using the General
page of the Command & Status dialog box. The following is an example of the General page.

Command & S5tatus §|

General | Command Block | Status 'Word

Type: | NN ~

Usze Command Block,

Fead Address: w100

Size; |9 * | words

Scan Time: |1 * | second

Command Block Image

Bit Addrezs Ranoge: FC0.0~ $CaF

“whord Address Bange; | $C0 ~ $C8

Impaort... ][ Export... (] l[ Cancel ][ Help

The following table describes each property in the General page.

Property Description

Type Select one of the following three types of control block and status words for your
application:
A, H (Binary), H (BCD)

Use Command Block Check this item if the application needs any of the command words.

Read Address Specifies the address of the command block.

Size Specifies the size of the command block.

Scan Time Select one of the following rate for the panel to scan the command block:

1 second, 0.5 second, 0.25 second

Command | Bit Address | Shows the valid address range of the bits in the command block. Note that the application
Block Range can only read the bits.
Image Word Shows the valid address range of the words in the command block. Note that the
Address application can only read the words.
Range
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3.6.3. Command Block Settings (Type A)

This section describes how to configure the type A command block using the Command Block page of the Command &
Status dialog box. The following is an example of the Command Block page.

General | Command Block | Srams word

Cormand *word

Arrangement; | Default

Command Flag

a []Reserved [$C2.0)
Switch Language [$C2.1]

screen Switching Register | $C0 | » Set Current Recipe Mumber [$C2.2]

Reset 55F to Zero
Parameter One Reqister FC1 W

Command Flags #0 - #15 02 W

Trigger Bitz #0 - #15

Fead Recipe From PLC [$C2.3]
Wiite Recipe To PLC [$C2.4]

[ ] Clear &larm Histary [$C2.5]

] Clear Alarm Count [$C2.5)
3w [150und Buzzer [$C2.7)

Parameter Two Register 04w [ Frint Screen [$C02.8]

[ ] Trigger Bits #16 - #3

Enabling Bits #0 - #15

[ ]Backlight On [$C2.9)
[ ] Backlight Off [$C2.a)

$C6 |8 []5et Cumrent User Level [$C2.5)

Parameter Thiee Register | $C7 % | [ Close All'window Screens ($C2.c)
Parameter Four Reqgister 08 W [ Reserved ($C2.d)

[ ]Reserved [$C2.g]
Execute General Command [$C2.f)

The following table describes each property in the Command Block page.

Property Description
Command | Arrangement Select Default if you want the command words to be in the default order in
Word the command block. Select Custom if you want to arrange each command

word in the command block by yourself.

Screen Switching
Register

Check this option so you can use the word to change the main screen or
display a window screen by setting the word to the number of the desired
screen.

Reset SSR to Zero

If this option is selected, the panel always resets the Screen Switching
Register to zero when it detects a nonzero value is in the word. If this option
is not selected, the panel resets the Screen Switching Register to zero only
when the specified screen is valid and not displayed yet.

Parameter One Register

Check this option so you can this word to specify the No. 1 parameter for the
specified operation.

Command Flags #0 ~ #15
(Command Flag Word)

Check this option so you can use the command flags to request the panel to
do the specified operations.

Trigger Bits #0 ~ #15
(Low Trigger Word)

Check this option if you need any of the trigger bits in the word for your
application.

Parameter Two Register

Check this option so you can this word to specify the No. 2 parameter for the
specified operation.

Trigger Bits #16 ~ #31
(High Trigger Word)

Check this option if you need any of the trigger bits in the word for your
application.

Continued
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Property Description
Command | Enabling Bits #0 ~ #15 Check this option if you need any of the enabling bits in the word for your
Word (Enabling Word) application.
Parameter Three Check this option so you can this word to specify the No. 3 parameter for the
Register specified operation.
Parameter Four Register | Check this option so you can this word to specify the No. 4 parameter for the
specified operation.
Command | Switch Language (#1) Check this option so you can use command flag #1 to request the panel to
Flag display the specified language. You need to specify the following:
1) Parameter One Register: the number of the desired language
Set Current Recipe Check this option so you can use command flag #2 to request the panel to
Number (#2) set the current recipe number of the specified recipe block to the specified
recipe number. You need to specify the following:
1) Parameter One Register: The recipe number
2) Parameter Two Register: The recipe block
(Note: You do not need to specify the recipe block if the application has only
one recipe block)
Read Recipe From PLC Check this option so you can use command flag #3 to request the panel to
(#3) read a recipe from the specified address which is defined in the Recipe
Block dialog box and use that recipe to replace the specified recipe of the
specified recipe block. You need to specify the following:
1) Parameter One Register: The recipe number
2) Parameter Two Register: The recipe block
(Note: You do not need to specify the recipe block if the application has only
one recipe block)
Write Recipe To PLC Check this option so you can use command flag #4 to request the panel to
(#4) write the specified recipe of the specified recipe block to the specified
address which is defined in the Recipe Block dialog box.
You need to specify the following:
1) Parameter One Register: The recipe number
2) Parameter Two Register: The recipe block
(Note: You do not need to specify the recipe block if the application has only
one recipe block)
Clear Alarm History (#5) Check this option so you can use command flag #5 to request the panel to
clear the alarm history.
Clear Alarm Count (#6) Check this option so you can use command flag #6 to request the panel to
clear the alarm counts.
Sound Buzzer (#7) Check this option so you can use command flag #7 to request the panel to
sound its buzzer in the specified manner.
You need to specify the following:
1) Parameter One Register: The sound type.
The following table describes the sound type value.
Sound Type Value Description
0 Continuous beep
1 500ms beeps
2 200ms beeps
3 100ms beeps
4 50ms beeps
Continued
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Property Description
Command | Print Screen (#8) Check this option so you can use command flag #8 to request the panel to
Flag print the specified screen.

You need to specify the following:

1) Parameter One Register: the number of the screen to be printed

Note1: The top screen is printed if the number is zero or there is no
Parameter One Register.

Note2: The operation of printing a screen that is not the top screen is not
supported by PL035/037/057/058

Backlight On (#9)

Check this option so you can use command flag #9 to request the panel to
turn its backlight on.

Backlight Off (#10)

Check this option so you can use command flag #10 to request the panel to
turn its backlight off.

Set Current User Level
(#11)

Check this option so you can use command flag #11 to request the panel to
set the current user level to the specified one.

You need to specify the following:
1) Parameter One Register: the user level

Close All Window Screens
(#12)

Check this option so you can use command flag #12 to request the panel to
close all window screens.

Execute General
Command (#15)

Check this option so you can use command flag #15 to request the panel to
perform the specified operation. See the section 3.6.7 Using General
Commands for details.
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3.6.4. Status Word Settings (Type A)

This section describes how to configure the type A status words for your application using the Status Word page of the
Command & Status dialog box. The following is an example of the Status Word page.

General | Command Block | Status ‘wWard

Command Flag Ack. Bits #0~ #15  |R100
Trigger Ack. Bits 0 ~ #15 R101
[] Trigger Ack. Bits #16 ~ #31

Current Screen Mumber 'Word R102

[] Current Fecipe Black 10 Yword

[] Current Fecipe Mumber ‘wiord
Current User Level Word R102
Current Language W ord F104

In the Status Word page, check the needed status words for your application and specify a word variable that will receive
the status value for each checked status word.

The following table describes when and what the panel will write to each status word.

Status Word Description
Command Flag Ack. Bits #0 ~ The panel will write the states of all the effective command flags to this word
#15 whenever there is any state change occurring on the effective command flags.

Trigger Ack. Bits #0 ~ #15

The panel will write the states of trigger bits #0 ~ #15 to this word whenever there
is any state change occurring on trigger bits #0 ~ #15.

Trigger Ack. Bits #16 ~ #31

The panel will write the states of trigger bits #16 ~ #31 to this word whenever
there is any state change occurring on trigger bits #16 ~ #3.

Current Screen Number Word

The panel will write the number of the current main screen to this word whenever
the main screen changes.

Current Recipe Block ID Word

The panel will write the current recipe block ID to this word whenever a different
recipe block becomes the current recipe block.

Current Recipe Number Word

The panel will write the current recipe number of the current recipe block to this
word whenever a different recipe becomes the current recipe of the current recipe
block.

Current User Level Word

The panel will write the current user level to this word whenever the current user
level changes.

Current Language Word

The panel will write the current language number to this word whenever it
changes the language.
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3.6.5. Command Block Settings (Type H)

This section describes how to configure the type H command block using the Command Block page of the Command &
Status dialog box. The following is an example of the Command Block page.

General | Command Block | Srams word

Cormand *word Command Flag

[ Clear &larm Histary [$C1.0)

[ ] Clear slarm Counts [$C1.7]
[]Reserved [$C1.2)

[ ] Reserved [$C1.3]

Wirte Recipe to PLC [$C1.4]
[15et Curent Fiecipe Mo. [Block 0] ($C1.5)
Read Recipe from PLC [$C1.6]
[150und Buzzer [$C1.7)

Trigger Bit #4 [$C1.8)

Trigger Bit #5 [$C1.9)

[ ] Trigger Bit #5 [$C71. ]

] Trigger Bit #7 [$C1.h]

Trigger Bit #0 [$C1.c)

Trigger Bit #1 [$C1.d)

[ ] Trigger Bit #2 [$C1.g]

[] Trigger Bit #3 [$C1.1)

Fieset SMF to Zero

The following table describes each property in the Command Block page.

Property Description
Command | Screen Number Register You can use the word to change the main screen or display a window
Block screen by setting the word to the number of the desired screen. You can

also use this word to request the panel to do the following operations: 1)
Change the language, 2) Turn on the backlight, and 3) Turn off the
backlight.

The following table describes how to program this word.

Bit Description
0~9 Specifies the screen to be displayed.
11~13 Specifies the language that the panel displays for.

000: The panel does nothing.
001: The panel changes the language to language 1.
010: The panel changes the language to language 2.

111: The panel changes the language to language 7.

14 If this bit is On, the panel turns off the back light of the
display.
15 If this bit is On, the panel turns on the back light of the
display.
Continued
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Property Description

Reset SNR to Zero If this option is selected, the panel always resets the Screen Number
Register to zero when it detects a nonzero value is in the word . If this
option is not selected, the panel resets the Screen Number Register to
zero only when the specified screen is valid and not displayed yet.

Command Flag Register You can use the command flags to request the panel to do the specified
operations.

Recipe Number Register When you use command flag #5 to set the current recipe number for recipe
block #0, you need to specify the recipe number in this word.

Command | Clear Alarm History (#0) Check this option so you can use command flag #0 to request the panel to
Flag clear the alarm history.

Clear Alarm Counts (#1) Check this option so you can use command flag #1 to request the panel to
clear the alarm counts.

Write Recipe To PLC (#4) Check this option so you can use command flag #4 to request the panel to
write the current recipe of recipe block #0 to the specified address which is
defined in the Recipe Block dialog box.

Set Current Recipe Check this option so you can use command flag #5 to request the panel to

Number (#5) set the current recipe number for recipe block #0.

You need to specify the following:
1) Recipe Number Register: the recipe number

Read Recipe From PLC Check this option so you can use command flag #6 to request the panel to

(#6) read a recipe from the specified address which is defined in the Recipe
Block dialog box and use that recipe to replace the current recipe of recipe
block #0.

Sound Buzzer (#7) Check this option so you can use command flag #7 to request the panel to
sound its buzzer.

Trigger Bit #4 (#8) Check this option so command flag #8 will be used as trigger bit #4.

Trigger Bit #5 (#9) Check this option so command flag #9 will be used as trigger bit #5.

Trigger Bit #6 (#10) Check this option so command flag #10 will be used as trigger bit #6.

Trigger Bit #7 (#11) Check this option so command flag #11 will be used as trigger bit #7.

Trigger Bit #0 (#12) Check this option so command flag #12 will be used as trigger bit #0.

Trigger Bit #1 (#13) Check this option so command flag #13 will be used as trigger bit #1.

Trigger Bit #2 (#14) Check this option so command flag #14 will be used as trigger bit #2.

Trigger Bit #3 (#15) Check this option so command flag #15 will be used as trigger bit #3.
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3.6.6. Status Word Settings (Type H)

This section describes how to configure the type H status words for your application using the Status Word page of the
Command & Status dialog box. The following is an example of the Status Word page.

General | Command Block | Status ‘wWard

Scresn Status Wword R100
Command Flag Ack. Ward  |R101

[] Current Fecipe Mumber ‘wiord

In the Status Word page, check the needed status words for your application and specify a word variable that will receive
the status value for each checked status word.

The following table describes when and what the panel will write to each status word.

3

Status Word Description

Screen Status Word The panel will write the number of the current main screen to this word whenever
the main screen changes.

Command Flag Ack. Word The panel will write the states of all the effective command flags to this word
whenever there is any state change occurring on the effective command flags.

Current Recipe Number Word The panel will write the current recipe number of recipe block #0 to this word
whenever a different recipe becomes the current recipe of recipe block #0.
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3.6.7. Using General Commands

This section describes how to use the general commands provided by the type A command block. To issue a general
command, specify necessary parameters in the parameter registers and then turn on command flag #15 in Command Flag
Register.

You can request the panel to perform the following file operations using the general command and the default filename:

Parameter One p ter Two Regist
Operation Register (S:arr:eD)er Wwo Register Default Filename Format
(Operation code)

Save logged data to TXT file 1 ID of the data logger (0~15) | DL<ID>_ <Date> <Time>.txt
Save logged data to CSV file 14 ID of the data logger (0~15) | DL<ID>_ <Date> <Time>.csv
Save logged alarms to TXT file | 2 (Not required) AL_<Date>_ <Time>.txt
Save logged alarms to CSV file | 15 (Not required) AL_<Date> <Time>.csv
Save alarm counts to TXT file 3 (Not required) AC_<Date> <Time>.txt
Save alarm counts to CSV file 16 (Not required) AC_<Date>_<Time>.csv
Save recipe data to TXT file 4 ID of the recipe block RB<ID>.txt

(0~15)
Save recipe data to CSV file 17 ID of the recipe block RB<ID>.csv

(0~15)
Save recipe data to DAT file 5 ID of the recipe block RB<ID>.dat

(0~15)
Print screen to BMP file (256 6 Number of the screen S<ID>_<Date>_<Time>.bmp
colors)
If the target panel is PE, the
color resolution follows the
setting of the PC
Print screen to BMP file (64K 7 Number of the screen S<ID>_<Date>_<Time>.bmp
colors)
If the target panel is PE, Print
screen to JPG file
Save logged operations to TXT | 9 (Not required) OL_<Date> <Time>.txt
file
Save logged operations to 18 (Not required) OL_<Date>_<Time>.csv
CSV file
Save logged data to LDF file 10 ID of the data logger (0~15) | DL<ID>_<Date> <Time>.ldf
Take picture and save it to 12 ID of the USB camera (0~3) | CAM<ID>_<Date> <Time>.bm
BMP file p
Take picture and save it to 13 ID of the USB camera (0~3) | CAM<ID>_<Date> <Time>.jpg
JPG file

Note for default filename format:

<ID>: ID of the data logger, ID of the recipe block, ID of the USB camera, or number of the screen
<Date>: date when saving the data; format is YYMMDD

<Time>: time when saving the data; format is hhmmss
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You can request the panel to perform the following file operations using the general command and the specified filename:

Operation Parameter One Register | Parameter Two Parameter Three Register
(Operation code) Register (Data ID) | (Specified filename)

Save logged data to 31 ID of the data Specifies the address in the internal

TXT file logger (0~15) memory $U that stores the specified

filename or full pathname. The name
must be a valid Windows pathname
with  ASCIl characters only. The
character string must be null terminated
and each character occupies one byte.
The maximum length of the string is
127. All the folders stated in the full
pathname must already exist or the file
operation will fail. For example, if the
number stored in this register is 400, it
means the specified filename is stored

in $U400.
Save logged alarms 32 (Not required) Same as above
to TXT file
Save alarm counts to 33 (Not required) Same as above
TXT file
Save recipe data to 34 ID of the recipe Same as above
TXT file block (0~15)
Save recipe data to 35 ID of the recipe Same as above
DAT file block (0~15)
Save logged 39 (Not required) Same as above
operations to TXT file
Save logged data to 40 ID of the data Same as above
LDF file logger (0~15)
Take picture and save | 42 ID of the USB Same as above
it to BMP file camera (0~3)
Take picture and save | 43 ID of the USB Same as above
it to JPG file camera (0~3)
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3.7. Setting up Clock Operations

This section describes how to define the clock operations for the panel application using the Clock dialog box. The
following is an example of the Clock dialog box.

‘wirite Timeddate to PLC Synchronize Panel with PLC
Timeddate Data Type: ’E BCD bytes v Timesdate Data Type: .E BCD bytes v
L _ | | J ancel
Wwrite Address: | w870 EHE Read Address: w300
Write Operation [ Do not run panel application until the restart
@ Timed Interval |60 2 e synchronization iz done successiully
- Fead Operation
() Triggered E———
() Timed Interval | B0 = | minutes
{3 Triggered

[] Increase Hour:  Trigger Bit: | #2 v |

[#] Decrease How :  Trigger Bit: 11-3 v:

The following table describes each property in the Passwords dialog box.

Property Description
Write | Write Time/date to Select this option so the panel will write time and date information to the specified
PLC variable.
Time/date Data Type Select one of the following data type for the output time and data information.
Data Type Description
6 BCD bytes The following shows the data structure.
Byte No. | Content
0 Minute; 0~59
1 Hour; 0~23
2 Day; 1~31
3 Month; 1~12
4 Year; 00~99
5 Day-of-week; 0(Sunday)~6(Saturday)
Note: All the values are in BCD format.

Continued
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Property Description
Write Time/date Data Type

Data Type Description

8 BCD bytes The following shows the data structure.
Byte No. | Content
0 Minute; 0~59
1 Hour; 0~23
2 Day; 1~31
3 Month; 1~12
4 Year; 00~99
5 Day-of-week; 0(Sunday)~6(Saturday)
6 Second; 0~59
7 0

Note: All the values are in BCD format.

7 BCD words The following shows the data structure.
Word No. | Content
0 Second; 0~59
1 Minute; 0~59
2 Hour; 0~23
3 Day; 1~31
4 Month; 1~12
5 Year; 00~99
6 Day-of-week; 0(Sunday)~6(Saturday)

Note: All the values are in BCD format.

7 binary words | The following shows the data structure.

Word No. | Content

Second; 0~59

Minute; 0~59

Hour; 0~23

Day; 1~31

Month; 1~12

Year; 00~99

Day-of-week; 0(Sunday)~6(Saturday)

OO || WIN|FP,|O

Write Address Specifies the variable that will receive the output time and date information.

Write Timed When this item is selected, the panel writes time and date information to the
Operation specified variable periodically at a rate specified in the Interval field. You can
specify an interval between 1 and 255 minutes.

Triggered | When this item is selected, the panel writes time and date information to the
specified variable whenever the specified trigger bit changes from Off to On.

Continued
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Property

Description

Read | Synchronize Panel
with PLC

Select this option so the panel will read time and date information from the
specified variable and adjust its clock accordingly.

Time/date Data Type

Specifies the data type for the input time and data information. For details, see the
description of the Time/date Data Type field of the Write group.

Read Address

Specifies the variable that the panel will read the time and date information.

Do not run panel
application until the
restart synchronization
is done successfully

The password keypad will close automatically when it gets no input from the
operator for the specified time.

Read Timed
Operation

When this item is selected, the panel reads time and date information from the
specified variable periodically at a rate specified in the Interval field. You can
specify an interval between 1 and 255 minutes.

Triggered

When this item is selected, the panel reads time and date information from the
specified variable whenever the specified trigger bit changes from Off to On.

Increase Hour

Select this option so you can increase the panel's clock by one by changing the
specified trigger bit from Off to On.

Decrease Hour

Select this option so you can decrease the panel's clock by one by changing the
specified trigger bit from Off to On.
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3.8. Setting up Passwords

This section describes how to set up the passwords for the panel application using the Passwords dialog box. The
following is an example of the Passwords dialog box.

Passwor ds E|

Uszer Level Pazzward Comment
1 1111 Operator
2 2222
3 3333
4 4444
4] 5555
B BEEE
i FERT k aintenance
g aaas Executive

9 | Uze developer pazsword

Autamatic lagin for aperations requinng a higher uzer level

Login Trgger Bit: #7 w

Logout Trigger Bit: | #8 »

Login Timeot; 30 % | seconds

The following table describes each property in the Passwords dialog box.

Property Description

Password The Password column contains 8 fields. You can specify the password for a user level in
the corresponding field. A password is a positive integer up to 8 digits. A password must
be unique within the application.

Comment The Comment column contains 8 editable fields. You can type the comment for a
password or user level in the corresponding field.

9 Check this item if you want the developer password to be the password with the highest
privilege.

Automatic login for The password keypad will display to get a password with a higher user level when the

operations requiring a operator touches an object that requires a higher user level than the current one to

higher user level perform the programmed operation.

Login Trigger Bit When the specified trigger bit changes from Off to On, the password keypad will display
to get a password. The operator can enter a valid password or cancel the password
keypad.

Logout Trigger Bit When the specified trigger bit changes from Off to On, the current user level is reset to 0.

Login Timeout The password keypad will close automatically when it gets no input from the operator for

the specified time.
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3.9. Screens

3.9.1. Types of Screens

There are three types of the screen: Normal Screen, Window Screen and Menu Screen.

To create any type of the screen, you can use the following procedures:

1) Create a screen. Default is a normal screen. To learn how to create a screen, please see Section 3.9.2 for details.
2) Open Screen Properties dialog box. To learn how to open the dialog box, please see Section 3.9.3 for details.
3) Inthe dialog box, select the type you would like the screen to be.

The following table describes how each type of the screen opens, closes and displays.

Types

Description

Normal Screen

A screen that will be shown up when it is selected to be a startup screen or a screen button with
open screen/previous screen operation is pressed.

Usually the normal screen can not be closed until the other normal screen is opened.

The normal screen is also called a main screen that displays only one at a time in the panel. The
screen size depends on the panel model and it is fixed.

Window Screen

A screen that appears in the following situation:

e Screen button with open screen operation is pressed

e Selected to be a startup screen

e OPEN_WS macro command is used.

e Alarm is active or clear if display screen option in the discrete/analog alarm block is selected
e Page selector object is used

e Custom keypad is needed

Usually the window screen stays on the normal screen until you press the close button on the title
bar or use screen button or CLOSE_WS macro command to close. It then disappears.

The panel can display many window screens at a time.

At runtime the window screen will display on the predefined position at very beginning. If the
window screen has the title bar, you can click-and-hold the title bar to move it around in the panel.

Menu Screen

A screen that will be shown up when it is selected to be a startup screen or screen button with
open screen operation is pressed.

Usually the menu screen stays on the normal screen or window screen until you press anywhere
outside the menu screen or use screen button to close. It then disappears.

The panel can display one menu screen at a time.

The menu screen can slide into the view horizontally from left or right side of the screen. It can also
appear by the left or right side of the button and slide upward or downward into the view. Please
see Section 5.3.4 to learn how to use screen button to set up the position of the menu screen.
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3.9.2. Creating and Opening Screens

m Creating Screens
To create a screen, you can use the following procedures:

1) Do one of the following:
e  On the Screen menu, click New Screen...
e Inthe Project Manager tool window, right-click the panel application > Screens item and then click New Screen...
on the popup menu.

2) Inthe New Screen dialog box, type the name and number you want, and hit the ENTER key or click the OK button to
validate your choice. The following is an example of the New Screen dialog box.

Specify the screen name here. The screen names are
case insensitive. For example, consider the names
Startup Screen, startup screen to be the same.

Mew Screen

Mame: |||:||e Screer| < I

4 <

Humber. Specify the screen number here. The screen number

must be between 1 and 7999.

Parel &pplication:

Cancel

Note: In each panel application, both the screen name and the screen number have to be unique.

m Opening Screens
To open a screen, you can do one of the followings:

1) Inthe Project Manager tool window, double click the screen you want to open

2) On the Screen menu, click Open Screen... In the Open Screen dialog box, select one or multiple screens and click
Open button to open all the selected screens.

The following is an example of Open Screen dialog box.

Open Screen

CHAPTER 3

Panel &pplication: |Panel_1
Numbsr  Mame Open To select a screen, cIic.k the
1 Screen 1 [bit & word buttons] row of that screen in the list.
2 Screen 2 [window hipe] - .
3 Screen 3 [more buttons) T(_) select multiple screens,
4 Soreen 4 [sliders) click one row and use Ctrl +
5 Screen 5 [data entry) Click to add a row to the
5 Screen B [Menu) selection.
¥ Screen ¥ [idle screen)
o Balneo To select continuous screens,
?D E‘EE'PE{‘“'E”“t click one row and hold the Shift

LItEan 1ayaLis H

5000 A5CIL_kbd key and click the last row.
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m Activating Screens after Opening
To uncover any screen that is partially or completely obscured by other screens, you can do one of the followings:

1) Inthe Project Manager tool window, double click the screen which is not on the top.

2) On the Window menu, click the screen you need to activate. Or click Windows... to bring out the Windows dialog box.
In the Windows dialog box, select the screen and then click Activate button.

3) Click anywhere on the screen. If the screens are maximized, click on the title tab of the screen.

3.9.3. Setting up a Screen
You can set up the screen with the Screen Properties dialog box.

To set up a screen, right click the panel application > Screens > screen you want to set up in the Project Manager tool
window, and then click Properties on the popup menu.

To set up a current screen, an opened screen which is on the top, you can do one of the followings:

1) Inthe Project Manager tool window, double click the current screen.

2) Right click the blank area on the current screen, and then click Screen Properties... on the popup menu.
3) Onthe Screen menu, click Screen Properties...

The Screen Properties dialog box contains the following pages. Some of the pages appear only when they are needed.
m  General
Described in Section 3.10.3.1.

m  Background
Described in Section 3.10.3.2.

m  Keys
Described in Section 3.2.2.

m  Open Macro / Close Macro / Cycle Macro
Described in Section 14.2.6.
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3.9.3.1. General Page

This section describes how to define the general settings for a screen. The following is an example of the General page of
the Screen Properties dialog box.

Screen Properties §|

General | Background | Open Macro || Close Maco | Cyele Macio

Screen Mumber: B Screen Mame: | Screen 2 [window tepe]
Uze Thiz Screen
Type Pririt
(O Momal Screen (8 window Screen () Menu Screen [ ]whole Screen
|Ipper-left Carner Lower-right Corner
width: [300 & Height [200 # w1: |1 1. |0 %2 (200 | vz [200
(&) Shown on Display Center Position on Paper [millimeters)
() Shown At s |0 v |0

Title Bar Cloze Button
Percentage of data zcan time allocated to the fast scar: | 50% »

. Y
Language: |English £ [Mate: Uze data tags to specify the fast scan)
Title: (]
“What to show far an object's content befare ite comezponding
: e
Base Screen data iz scanned for the object?
Blank.
g * || Balheo w ©Blan
() Last scanned data or blank
(") Last scanned data or zero
OPEM Macro CLOSE Macrmo

Cv'CLE Macro

Ltz e Deley e (IR | milbscoml Humeric keypad remains open for continuouz data entry

Mate:

(]9 l [ Cancel ] [ Help

The following table describes each item in the General page.

Property Description

Screen Number The number of the screen. It must be between 1 and 7999.

Screen Name The name of the screen.

Use This Screen Check this option if you want to use the screen.

Type Specifies the type of the screen. There are three types: Normal Screen, Window

Screen and Menu Screen. Please see Section 3.9.1 for details.

Continued
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Property Description

Width Specifies the width (in pixels) of the screen. This field is available to edit when the
Type is Window Screen and Menu Screen.

Height Specifies the height (in pixels) of the screen. This field is available to edit when the

Type is Window Screen and Menu Screen.

Shown on Display Center

Check this option if you want the window screen is shown on display center. This
field is available when the Type is Window Screen.

Shown At Check this option if you want the window screen is shown at the specified position.
This field is available when the Type is Window Screen.

X Specifies the X coordinate of the window screen’s upper-left corner in pixel on the
normal screen.

Y Specifies the Y coordinate of the window screen’s upper-left corner in pixel on the
normal screen.

Title Bar Select this option if you want the window screen to have a title bar to show the
specified title when the Type is Window Screen.

Close Button Select this option if you want the window screen to have a close Button when the
Type is Window Screen and the Title Bar field is checked.

Language Select a language so you can view and edit the settings of the title for that language.
This field is available when the Type is Window Screen and Title Bar field is
checked.

Title Specifies the title for the Title Bar. This field is available when the Type is Window
Screen and Title Bar field is checked.

Base <Check Box> Check this option if you want to have a base screen for the current screen

Screen <Combo Box> Specifies the screen to be a base screen. This field is available when the Base
Screen is checked.

OPEN Macro Check this item if you want the screen to have the OPEN macro.

An Open Macro is run once when the associated screen is being opened. The target
panel will not display the screen until the Open Macro terminates. You can use
OPEN macro to initialize global data and settings for the screen.

CLOSE Macro

Check this item if you want the screen to have the CLOSE macro.

A Close Macro is run once when the associated screen is being closed. The target
panel will not erase the screen until the Close Macro terminates.

CYCLE <Check Box> Check this item if you want the screen to have the CYCLE macro.

Macro A Cycle Macro is run all the time while the associated screen is open. The target
panel runs Cycle Macros cyclically, i.e. it will run a Cycle Macro starting from the first
command again each time after it completes the processing of the last command of
the macro or when it encounters an END command in the middle of the macro. And
the cycle macro terminates immediately if the screen is closed.

Cycle Macro Specifies the delay time in 0, 100, 200, 300, 400, 500, 600, 700, 800, 900, 1000
Delay Time milli-second for the cycle macro.

Print Whole Screen Check this item if you want to print the whole screen by Command Flag or Function

Button or Macro Command

Upper-left Specifies the X and Y coordinates in pixel for the upper-left corner of the screen’s
printing area. The field is available when Whole Screen item is unchecked.

Lower-Right Specifies the X and Y coordinates in pixel for the lower-right corner of the screen’s
printing area. The field is available when Whole Screen item is unchecked.

Position on Paper | Specifies the X and Y coordinates in millimeters for the position where the specified
area of the screen will print on paper..

Continued
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Property Description
Percentage of data scan time allocated to Select the percentage of data scan time allocated to the fast scan
the fast scan among 50%, 66%, 75%, 80%, 86% and 90%.

Note: The bigger percentage, the faster data scan time to the tag with
fast scan rate, but the slower data scan time to the tag with normal scan

rate.
What to show for Blank Select this item to show blank for an object's content before its
an object’s content corresponding data is scanned for the object.
before its ding dat Last scanned data Select this item to show last scanned data or blank for an object’s
corresponding data |- o pyjank content before its corresponding data is scanned for the object.
is scanned for the — :
object? Last scanned data Select this item to show last scanned data or zero for an object’s content
or zero before its corresponding data is scanned for the object.
Operable under window screen Check this option to make the screen operable under window screen.
This field is available only when the Type is Normal Screen.
Numeric keypad remains open for Check this option if you want numeric keypad to remain open for
continuous data entry continuous data entry.
Note You can type a note for the screen.
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3.9.3.2. Background Page

This section describes how to define the background of a screen. The following is an example of the Background page of
the Screen Properties dialog box.

Screen Properties §|
General | Background | Open Macro || Close Maco | Cyele Macio
) 5olid Color

& Tile Pattern: P

FG Colar:

BG Color:

) Picture

The following table describes each item in the Background page.

Property Description

Solid Color Check this option if you want the screen background filling with the solid color.

<Solid Color> Click the corresponding color button to specify the color which is used to fill the
background. This item is available when Solid Color option is selected.

Tile Check this option if you want the screen background filling with the pattern.

Pattern Specify the pattern which is used to fill the background. Click the corresponding
Pattern icon and select a pattern from the Pattern palette. This item is available
when Tile option is selected.

FG Color The color that is used to paint the black part of the pattern. When the solid white
pattern is selected, this color is not used. This item is available when Tile option is
selected.

BG Color The color that is used to paint the white part of the pattern. This item is available
when Tile option is selected.

Picture Check this option if you want to have a picture background for the screen.
<Name> The name of the picture. You can use the drop-down list to select a picture from the

picture database.

. . . ) . . )
Click to select a picture file. After the selection, the picture of the selected file
is imported and saved in the picture database.

Click to bring up the Select/Import from Library dialog box. Select a picture
from a picture library file. After the selection, the selected picture is imported and
saved in the picture database.

Stretch Check this item so the picture can change its size automatically to just fit the
screen.
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3.9.4. Importing/Exporting a Screen
This section describes how to export a screen and import a screen regardless of the panel model and screen size.

= Importing a screen
1) Right-click the panel application > Screens item in the Project Manager tool window to bring out the popup menu and
then use the Import Screen... command on the popup menu

2) Click the *.snf file you want to create a new screen from. If you want to open a screen that was saved in a different
folder, locate and open the folder first.

3) Click Open.

m Exporting a screen
If you have screen you want to reuse, you can export the screen as a .snf file. You may do the following:
1) Inthe Project Manager tool window, click the screen you would like to export

2) Right-click on the screen to display the screen item's "popup menu"; and then click Export Screen..., the fourth menu
item.

3) If you want to save a macro in a different folder, locate and open the folder first. then click Save.

3.9.5. Cutting/Copying/Pasting/Deleting a Screen

m Copying or Cutting and Pasting a Screen

To copy/cut a screen which is opened and activated, right click the blank area on the screen, and then click Copy
Screen/Cut Screen on the popup menu or use the Copy Screen/Cut Screen command On the Screen menu.

After Copying or Cutting, you can paste the screen by right clicking the blank area on any of the screen and then using
Paste Screen command on the popup menu or using the Paste Screen command On the Screen menu.

m Deleting a Screen

To delete a screen which is opened and activated, right click the blank area on the screen, and then click Delete Screen on
the popup menu or use the Delete Screen command on the Screen menu.

To delete a screen from project manager tool window, local the screen you would like to delete and then right-click on the
screen node to use the Delete command on the popup menu. You will be asked to confirm the deleting operation.
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3.9.6. Saving Screens as Pictures
This section describes how to save screens as pictures.

m Saving a screen as a picture

To save current screen as the bmp or jpg file, you can do one of the followings.

1) Open and activate the screen as a current screen

2) Right click the anywhere on the current screen, and then click Save Current Screen as Picture... on the popup menu.
- or-
On the Screen menu, click Save Current Screen as Picture...

m Saving multiple screens as pictures

You can also use Save Screens as Pictures dialog box to save a screen or multiple screens as bmp or jpg files. To open
the dialog box, click Save Screens as Pictures... on the Screen menu.

The following is an example of the Save Screens as Pictures dialog box.

Save Screens as Pictures

Select

Fanel Application: FIEEHRnE
Screen: Language: | Enalish b

|

Mumber M ame Filename State: 0 =

Main Screen CEENDM  File Type: | BMP Image Files [ bp) v
[]10 Diynamic Objects [default]
111 Arimated Graphic (defaul) aave in Folder.
112 Charts [default) C:%Program FileshPh D esigneryPRJIAS creenPictur E]
113 Trend Graphic [default] )
BE wiord Buttor (defaLit] Frint Screen Mame as Foot Mote
[]4 Function Button [default) Froaress
[15 Bit Lamp & Multistate...  [default]
[]5000 ASCH Keypad [defauilt]

R ey Button & Eeppad  [default]
7 Fadio & Step Button  [default]
[]#= Multiztate & Shde Sw...  [default]
14 ASCH EntrpdDigplay .. ASCH Entr,
12 Bit Button # Toggle ... Bit Button _

Check Al | Uncheckal | [
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The following table describes each item in the dialog box.

Property

Description

Panel Application

The application Name.

Screen The screen list shows all the screens in the panel application. You can click the
column header to sort the items.
The following table describes each column in the screen list.
Column Description
Number The screen number. Check the option before the screen
number if you want to save the screen as a picture file.
Name The screen name.
Filename The Filename. The default filename is Screen
Name+Language Name+S+State Number.
Note: If any of the characters such as \:*?"<>| in the screen
name, they will be converted to underscore( ).
Check All Click the button to check all the screens.
Uncheck All Click the button to uncheck all the screens.
Selections Language The language that displays the text of objects.
State The state that displays the state of objects.
File Type Select the file type. There are two types: bmp and jpg.
Save in Specifies the folder you want to locate the files. If the file exists in the folder, it will be
Folder replaced by the new one.
Print Screen Check this option if you want to display general screen information as foot note.
Name as The format of the foot note is Screen Name(#Screen Number); Screen
Foot Note WidthXScreen Height.
Progress <Screen Show the selected screen or the screen which is saving. To select a screen, click the
View> row of that screen in the screen list.
<Progress Show the saving progress after the Save button is clicked.
Bar>
Save Click the button to save all the selections with the specified conditions.
Close Click the button to exit the dialog box.
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4.1. Drawing Basic Shapes

PM Designer provides a drawing tool you can use to create simple or elaborate drawing shapes such as lines, rectangles,

circles, arcs etc.

To create a drawing shape, click the shape on the Draw Toolbar (See Section 1.3.2.3 Draw Toolbar for details), or use the
command on the Draw menu (See Section 1.3.1.3 Draw menu for details) and then move the mouse to the position you

want to place the shape and click the left button. To set up a drawing shape, double-click the shape to bring up the
corresponding properties dialog that you can set up the color and style of the line/outlined, pattern, FG/BG Color...of the

shape.

Note: If you don't see the Draw Toolbar as below in the lower left corner of the program window, please click Draw Toolbar

command on the View menu.

s N — | = lOC ;0o B

The following is a sample of the basic shapes:

< # L&

% i Symbals

Lines

< Rectangles
& Circles

Arcs &

= [ gpe
Falygans

Rectangle

Fie Shapes

symbols

Arcs &

Folygans
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4.1.1. Drawing Dots

1. In the Draw menu or Draw toolbar, click Dot

2. Move the cursor onto the screen where you want to draw a dot. A dot with default settings will display and move
along with the cursor.

Click the desired position on the screen to place the dot. The center of the dot will be at the clicked position.

4, Double-click the dot to bring up the Dot dialog box and then modify the settings of the dot.
The following is an example of the Dot dialog box.

& Dot E|
Style: Color; E
Pozitioh
w181 %
Yoo 137 &

The following table describes each property in the Dot dialog box.

Property Description
Select one of the dot styles listed below:
[ n | | | | | .
AR AL
LI R i S
Style # ||| o |o|o|le|=
alw v o |@m| g 2B
O @ | *|w | ®| % =
®H | (8| e | & | 0|
B H| = |(k|[v| | ?|@
Color Specifies the dot color.
Positi X Specifies the X coordinate of the upper-left corner of the dot.
osition
Y Specifies the Y coordinate of the upper-left corner of the dot.
5. You can click the following icons in the Draw toolbar to modify the properties of the dot.
Click Icon To
<t Select a style for the dot.
el Select a color for the dot.
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4.1.2. Drawing Lines

1. In the Draw menu or Draw toolbar, click Line ™ to draw a straight line. You can also click Horizontal Line
~ to draw a horizontal line or click Vertical Line | to draw a vertical line.
2. Move the cursor onto the screen where you want to draw a line. A line with default settings will display and move

along with the cursor.
Click the desired position on the screen to place the line. The start point of the line will be at the clicked position.

4, Drag the handle at the start point to adjust the position of the start point. Drag the handle at the end point to
adjust the position of the end point.

The picture on the left shows the two handles of a line. Position the mouse

/ pointer over one of the handles. When the cursor turns to be e drag the handle
until the line has the length and slope you want.

Left-click and hold down the mouse button until the cursor becomes cross icon'%' to move the line.

6. Double-click the line to bring up the Line dialog box and then modify the settings of the line. The following is a
sample of Line dialog box.

Line |

Type
(%) General () Horizontal 1 Wertical

E3

Style: Color Controlled By Bit

State: Color: E
Cantrol Bit: |$U0.0

Start Poirt End Pairt

Type: |[O—— w Tope: |—B w
] Filled Filled

Sizer |1 W Sizer |1 w

Terminal

=1 (B0 % w2120 %

LU Y2144 (3

Yizibility Caontralled By Bit
Contral Bit:

Vizible State: (%) OM () OFF
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The following table describes each property in the Line dialog box.

Property Description

Type Specifies the type of the line: General, Horizontal, or Vertical.

Line Style

Clicks the button to select the —
line style from the dropdown EI

W|ndOW ShOWﬂ on the I'Ight e 1 [ L [

Color Controlled Check this option if the color of the line will be controlled by the specified bit.
By Bit

State Select the state that you want to view or define the color for.

Color Specifies the line color for the selected state.

Control Bit Specifies the bit that controls the color.

Click to enter the bit address. Click to enter the bit tag.

Start / Start/End Point Select this option if you want the line to have a shape at the start/end point.
Egﬁnt Type Clicks the dropdown list to select the type for Start/End Point
— —
Start Point Type: 4+— End Point Type: |—F
+— —
— —
o— "
= —
&+ —t
< —
o o
Filled Select this option if you want the shape to be filled with the line color.
Size Specifies the shape size.
Terminal | X1 The X coordinate of the start point.
Y1l The Y coordinate of the start point.
X2 The X coordinate of the end point.
Y2 The Y coordinate of the end point.
Visibility | Visibility Check this option if the line will be shown or hidden by the specified bit.
Control Controlled By Bit
Control Bit Specifies the bit that shows or hides the object.

Click to enter the bit address. Click to enter the bit tag.
Visible State Specifies the state (On or Off) that makes the line visible.

You can click the following icons in the Draw toolbar to modify the properties of the line.

Click Icon To
<! Select a style for the line.
@ Select a color for the line.
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4.1.3. Drawing Polylines

1. In the Draw menu or Draw toolbar, click Polyline = to draw a polyline.

n

Move the cursor onto the screen where you want to draw a polyline and click the position where you want the
start point of the polyline to be at.

3. Continue clicking on the screen to place as many points needed for nodes in the polyline.
4, Right-click to place the last point for the polyline and complete the polyline.
5. Drag one blue handle of the polyline at a time to resize the polyline.
6. Drag one black handle of the polyline at a time to adjust the node positions of the polyline.
m} m} a
The picture on the left shows all the blue and black handles of a polyline.
Position the mouse pointer over one of the handles. When the cursor
. _ tums to be «” or + or ™u or ++, drag the handle until the polyline is
the shape and size you want.
m} m} a
7. Right-click anywhere on the polyline and use the Insert Point command on the object popup menu to insert a

new point for the polyline. Or right-click the existing point of the polyline and use the Delete Point command on
the object popup menu to delete the point.

Popup menu Description
Add a point at the specified position.
Insert Point
Insert Point
Delete Point
Delete Foint
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8.

Double-click the polyline to bring up the Polyline dialog box and then modify the settings of the polyline.

The following is a sample of Polyline dialog box.

Polyline

E3
=
Style: Color Controlled By Bit
State: Colar; [E]

Control Bit: | $U0.0

Start Point End Paint

Type: |&F—— s Type: | —0
Fillzd Fillzd

Sizer |2 hd Size: ™

Profile

Left: |75 % Wwidth (183 2

Top: (227 = Height: |33 &

Yizibility Controlled By Bit

Control Bit: | $10.1

Wizihle State: (%) ONW () OFF

The following table describes each property in the Polyline dialog box.

Property Description
Line Style Specifies the style of the polyline.

Color Controlled Check this option if the color of the polyline will be controlled by the specified

By Bit bit.

State Select the state that you want to view or define the color for.

Color Specifies the line color for the selected state.

Control Bit Specifies the bit that controls the color.

Click to enter the bit address. Click to enter the bit tag.

Start Start Point Select this option if you want the polyline to have a shape at the start point.
Point Type Specifies the shape type.

Filled Select this option if you want the shape to be filled with the line color.

Size Specifies the shape size.
End End Point Select this option if you want the polyline to have a shape at the end point.
Point Type Specifies the shape type.

Filled Select this option if you want the shape to be filled with the line color.

Size Specifies the shape size.

Continued
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Property Description
Profile Left The X coordinate of the upper-left corner of the bounding rectangle of the
polyline.
Top The Y coordinate of the upper-left corner of the bounding rectangle of the
polyline.
Width The width of the bounding rectangle of the polyline.
Height The height of the bounding rectangle of the polyline.

Visibility | Visibility Controlled | Check this option if the polyline will be shown or hidden by the specified bit.
Control | By Bit

Control Bit Specifies the bit that shows or hides the polyline.
Click to enter the bit address. Click to enter the bit tag.
Visible State Specifies the state (On or Off) that makes the line visible.
9. You can click the following icons in the Draw toolbar to modify the properties of the polyline.
Click Icon To
ﬂ Select a style for the polyline.
[a Select a color for the polyline.
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4.1.4. Drawing Rectangles

. O .

1. In the Draw menu or Draw toolbar, click Rectangle to draw a normal rectangle. You can also click Round
Rectangle to draw a round rectangle or click Clipped Rectangle - to draw a clipped rectangle.

2. Move the cursor onto the screen where you want to draw a rectangle. A rectangle with default settings will
display and move along with the cursor.

3. Click the desired position on the screen to place the rectangle. The upper-left corner of the rectangle will be at
the clicked position.

4, Drag one handle of the rectangle at a time to resize the rectangle.
i = F  The picture on the left shows the eight handles of a rectangle. Position the mouse pointer
H B over one of the handles. When the cursor turns to be ¥ or I or ™4 or ++, drag the
h = 4 handle until the rectangle is the shape and size you want.

5. Double-click the rectangle to bring up the Rectangle dialog box and then modify the settings of the rectangle.

The following is a sample of Rectangle dialog box.

o o
E| || Rectangle
a ol Twpe: |Clipped ha Mumber of Dats: (12 2

aD

%]
o
Color Carntrolled By Bit
Contral Bit: |$10.0
State:

Eorder

Thickness: |3 e

Caolar: [E] Style:

[¥] Solid

Pattern:

FG Color: @ BG Color:
Prafile

Left (147 % WwWidth, 117 &
Top: 195 % Height: |53 &

‘Wizibility Controlled By Bit

Cantrol Bit: | $U01

Yizible State: ) 0OM () OFF

The following table describes each property in the Rectangle dialog box.

Property Description

Specifies the type of the rectangle. There are three types: Normal, Round, or Clipped.

Normal Round Clipped

Continued
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Property Description
Number Specifies the size of the clipped corners if the rectangle is a clipped rectangle. Specifies the
of Dots radius of the round corners if the rectangle is a round rectangle.

Specifies the 3D visual effect for the rectangle. There are three effects: Flat, Raised, or Sunken.

Effects Samples Description
Flat i U 53| | You can specify the
. | Color and Style for the
M, | T [Nomal hs Border if it is selected.
i
(%) Flat () Raised ) Sunken . . .
- Thickness field is not
[] Calor Controlled By Bit available when flat is
selected.
[v] Border
Thickness:
Calor: E Style:
[15alid E_
Pater
FiG Calaor: BGCol | _ _ _|[— _ |l
Raised |7 Rectangle 3] | You can specify the
d color for the top and
Tper [Momal @ left edges. And PM
o Designer will darken
3D . Cancel .
OFit © Raised © surken the specified color and
[ Color Cantralled By Bit draw the bottom and
right edges for you.
Border and Style field
Thickess [10 D is not available when
Raised is selected.
Style:
Sunken Rectangle 4] | You can specify the
F color for the bottom
gonly, | Tope [Nomd v and right edges. And
& PM  Designer  will
Ot O Raised © Surken darken theg specified
[ Color Contralled By Bit color and draw the top
and left edges for you.
Border and Style field
Thcknoss 2 is not available when
ickness: |10 % |5 . .
Raised is selected.
Cuolor: Style:

Continued
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Property Description
Color Color Controlled | Check this option if the color of the rectangle will be controlled by the
Control By Bit specified bit.
Specifies the bit that controls the color.
Control Bit :
Click to enter the bit address. Click to enter the bit tag.
State Select the state that you want to view or define the colors for.
Border Border Check this option if you want the rectangle to have border.
Thickness Specifies the thickness of the border.
Color Specifies the border color for the selected state.
Style Select a line style for the border.
Solid Check this option if you want the rectangle to be solid. A solid rectangle is
Solid filled with the specified pattern and colors. This field is available when the
Border is selected.
Pattern Specifies the fill pattern for the selected state.
Specifies the color for the selected state that will be used for painting the
FG Color ;
black part of the fill pattern.
Specifies the color for the selected state that will be used for painting the
BG Color : .
white part of the fill pattern.
Profile Left The X coordinate of the upper-left corner of the rectangle.
Top The Y coordinate of the upper-left corner of the rectangle.
Width The width of the rectangle.
Height The height of the rectangle.
Visibility | Visibility . L . . - .
Control Controlled By Bit Check this option if the rectangle will be shown or hidden by the specified bit.
Specifies the bit that shows or hides the rectangle.
Control Bit :
Click to enter the bit address. Click to enter the bit tag.
Visible State Specifies the state (On or Off) that makes the rectangle visible.

You can click the following icons in the Draw toolbar to modify the properties of the rectangle.

Click Icon

To

Select a line style for the border.

Select a color for the border.

Select a color for painting the white part of the fill pattern.

Select a pattern for the fill pattern.

8o | o | | 18] | IS

Select a color for painting the black part of the fill pattern.
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4.1.5. Drawing Circles

1. In the Draw menu or Draw toolbar, click Circle

to draw a circle.

2. Move the cursor onto the screen where you want to draw a circle. A circle with default settings will display and

move along with the cursor.

Click the desired position on the screen to place the circle. The center of the circle will be at the clicked position.

4, Position the mouse pointer over the handle on the edge of the circle. When the cursor turns to be " oor M drag

the handle until the circle is the size you want.

5. Position the mouse pointer over the handle on the center of the circle. When the cursor turns to be'%', left-click

the center and hold down the button to move the circle.

The picture on the left shows the two handles of a circle.

6. Double-click the circle to bring up the Circle dialog box and then modify the settings of the circle.

The following is a sample of Rectangle dialog box.
Circle

Color Controlled By Bit

Control Bit; [$0.0

State:

Outlined
Color: E

S olid

Fatterr: i

FG Colar: @

Center & Fadiuz
A B8
Yo 198 &

Control Bit: | $U01

Yizibility Cantralled By Bit

Yizible State: (%) OM () OFF

BG Color:

R adiusz:

35

.
w

E3
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7.

The following table describes each property in the Circle dialog box.

Property Description
Color Color Controlled Check this option if the color of the circle will be controlled by the specified
Control By Bit bit.
Control Bit Specifies the bit that controls the color.
Click to enter the bit address. Click to enter the bit tag.
State Select the state that you want to view or define the colors for.
Outline Outlined Check this option if you want the circle to be outlined.
Color Specifies the outline color for the selected state.
Solid Solid Check this option if you want the circle to be solid. A solid circle is filled with
the specified pattern and colors.
Pattern Specifies the fill pattern for the selected state.
FG Color Specifies the color for the selected state that will be used for painting the
black part of the fill pattern.
BG Color Specifies the color for the selected state that will be used for painting the
white part of the fill pattern.
Profile X The X coordinate of the center of the circle.
Y The Y coordinate of the center of the circle.
Radius The radius of the circle.
Visibility | Visibility Check this option if the circle will be shown or hidden by the specified bit.
Control Controlled By Bit
Control Bit Specifies the bit that shows or hides the circle.
Click to enter the bit address. Click to enter the bit tag.
Visible State Specifies the state (On or Off) that makes the circle visible.

You can click the following icons in the Draw toolbar to modify the properties of the circle.

Click Icon

To

Select a color for the outline.

Select a color for painting the white part of the fill pattern.

Select a pattern for the fill pattern.

g0 | o | ¥ | &

Select a color for painting the black part of the fill pattern.
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4.1.6. Drawing Ellipses

—
In the Draw menu or Draw toolbar, click Ellipse to draw an ellipse.

2. Move the cursor onto the screen where you want to draw an ellipse. An ellipse with default settings will display
and move along with the cursor.

3. Click the desired position on the screen to place the ellipse. The upper-left corner of the bounding rectangle of
the ellipse will be at the clicked position.

4, Drag one handle of the ellipse at a time to resize the ellipse.
] m]

The picture on the left shows the eight handles of an ellipse. Position the mouse pointer
over one of the handles. When the cursor turns to be & or I or ™u or 4+, drag the

handle until the rectangle is the shape and size you want.
[m]

5. Double-click the ellipse to bring up the Ellipse dialog box and then modify the settings of the ellipse.

The following is a sample of the Ellipse dialog box.

.

Colar Controlled By Bit

Contral Bit: |$LI0.0
State:

o
s

Cancel

[v] Outlined

Calar: @

[+] Sofid

Patterr:  [fa3]

FG Color: BG Color: [E
Profile

Left: 1352 % Width: 100 3
Top: (44 % Height: (51 %

Yigibility Controlled By Bit

Control Bit; |[$U1.0

Yigible State: () OM () OFF

The following table describes each property in the Ellipse dialog box.

Property Description
Color Color Controlled Check this option if the color of the ellipse will be controlled by the
Control By Bit specified bit.
Control Bit Specifies the bit that controls the color.
Click to enter the bit address. Click to enter the bit tag.
State Select the state that you want to view or define the colors for.

Continued
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Property Description
Outline Outlined Check this option if you want the ellipse to be outlined.
Color Specifies the outline color for the selected state.
Solid Solid Check this option if you want the ellipse to be solid. A solid ellipse is filled
with the specified pattern and colors.
Pattern Specifies the fill pattern for the selected state.
FG Color Specifies the color for the selected state that will be used for painting the
black part of the fill pattern.
BG Color Specifies the color for the selected state that will be used for painting the
white part of the fill pattern.
Profile Left The X coordinate of the upper-left corner of the bounding rectangle of the
ellipse.
Top The Y coordinate of the upper-left corner of the bounding rectangle of the
ellipse.
Width The width of the bounding rectangle of the ellipse.
Height The height of the bounding rectangle of the ellipse.
Visibility | Visibility Check this option if the ellipse will be shown or hidden by the specified bit.
Control Controlled By Bit
Control Bit Specifies the bit that shows or hides the ellipse.
Click to enter the bit address. Click to enter the bit tag.
Visible State Specifies the state (On or Off) that makes the ellipse visible.

You can click the following icons in the Draw toolbar to modify the properties of the ellipse.

Click Icon

To

Select a color for the outline.

Select a color for painting the white part of the fill pattern.

Select a pattern for the fill pattern.

g | o | ¥ |

Select a color for painting the black part of the fill pattern.
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4.1.7. Drawing Arcs

6.

4-15

) ™
In the Draw menu or Draw toolbar, click Arc to draw an arc.

Move the cursor onto the screen where you want to draw an arc. An arc with default settings will display and
move along with the cursor.

Click the desired position on the screen to place the arc. The upper-left corner of the bounding rectangle of the
arc will be at the clicked position.

Drag one handle of the arc at a time to change the shape of the arc.

a [m] a
[l
_ﬁ_.—.__hﬂ\.
a a a
(]
a m] m]

The picture on the left shows the handles of an arc. The blue handles are for shaping the
arc. The black handles of the two ends of the arc are for changing the ends' angles. The
black handle at the center of the arc is for forcing the arc to be a part of a circle.

Position the mouse pointer over one of the handles. When the cursor turns to be " or I
or ™ or 4+, drag the handle until the arc is the shape and size you want.

Double-click the arc to bring up the Arc dialog box and then modify the settings of the arc.

The following is a sample of Arc dialog box.

Arc 3
Color; ak.
o () [ ok ]
Left: |EEH = Width: |81 E
g o Top: (202 % Height: 121 =

The following table describes each property in the Arc dialog box.

Property Description
Color Specifies the color of the arc.
Profile | Left The X coordinate of the upper-left corner of the bounding rectangle of the arc.
Top The Y coordinate of the upper-left corner of the bounding rectangle of the arc.
Width The width of the bounding rectangle of the arc.
Height The height of the bounding rectangle of the arc.

You can click the following icons in the Draw toolbar to modify the properties of the arc.

Click Icon

To

154

Select a color for the arc.
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4.1.8. Drawing Pie Shapes

[y
1. In the Draw menu or Draw toolbar, click Pie to draw a pie shape.

2. Move the cursor onto the screen where you want to draw a pie shape. A pie shape with default settings will
display and move along with the cursor.

3. Click the desired position on the screen to place the pie shape. The upper-left corner of the bounding rectangle
of the pie shape will be at the clicked position.

4, Drag one handle of the pie shape at a time to change the pie shape.

o o o The picture on the left shows the handles of a pie shape. The blue handles are for

// H\‘\\, changing the pie shape. The black handles of the two ends of the arc are for
r changing the ends' angles. The black handle at the center of the arc is for forcing
O O the arc to be a part of a circle.
u]

Position the mouse pointer over one of the handles. When the cursor turns to be

" or + or ™u or +—, drag the handle until the pie is the shape and size you
m| want.

5. Double-click the pie shape to bring up the Pie dialog box and then modify the settings of the pie shape.
e )
Cutlined Colar: @

u]
Solid
Fatterr:
FG Calar:

BG Color;

Profile
Left: B2 & Width: 309 &

Top: (332 2 Height: (153 &

The following table describes each property in the Pie dialog box.

Property Description
Outline | Outlined Check this option if you want the pie shape to be outlined.
Color Specifies the outline color.
Solid Solid Check this option if you want the pie shape to be solid. A solid pie shape is filled with

the specified pattern and colors.

Pattern Specifies the fill pattern.
FG Color | Specifies the color that will be used for painting the black part of the fill pattern.
BG Color | Specifies the color that will be used for painting the white part of the fill pattern.

Profile Left The X coordinate of the upper-left corner of the bounding rectangle of the pie shape.
Top The Y coordinate of the upper-left corner of the bounding rectangle of the pie shape.
Width The width of the bounding rectangle of the pie shape.
Height The height of the bounding rectangle of the pie shape.
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6. You can click the following icons in the Draw toolbar to modify the properties of the pie shape

Click Icon To

Select a color for the outline.

Select a color for painting the white part of the fill pattern.

Select a pattern for the fill pattern.

o | | ¥e | &

Select a color for painting the black part of the fill pattern.
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4.1.9. Drawing Polygons

n

o 0 > w

In the Draw menu or Draw toolbar, click Polygon O to draw a polygon.

Move the cursor onto the screen where you want to draw a polygon and click the position where you want the
first vertex of the polygon to be at.

Continue clicking on the screen to place as many points needed for vertices in the polygon.
Right-click to place the last vertex for the polygon and complete the polygon.
Drag one handle of the polygon at a time to resize the polygon.

Drag one black handle of the polygon at a time to adjust the vertex positions of the polygon.

o m] [m]
The picture on the left shows the handles of a polygon. The blue
handles are for resizing the polygon. The black handles are for moving
the vertices of the polygon.

o [m]
Position the mouse pointer over one of the handles. When the cursor
turns to be & or I or ™u or 4+, drag the handle until the polygon is
the shape and size you want.

o m] [m]

Right-click anywhere on the polygon and use the Insert Point command on the object popup menu to insert a
new point for the polygon. Or right-click the existing point of the polygon and use the Delete Point command on
the object popup menu to delete the point.

Popup menu Description
Add a point at the specified position.
[m] m] a a
n/ n/
Insert Point O o o o

\ 4
]

Inzert Point \
u] [m] [m] m] a a
Delete a selected point.
a a a a
B/ B/
Delete Point o o o
-]
Delete Point \
a a a m] m] m]
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8. Double-click the polygon to bring up the Polygon dialog box and then modify the settings of the polygon.

u]

Polygon

Color Controlled By Bit

Contral Bit: [$U0.0

State:
Outlined

Thickness:

%]
Color: [E]

Sold

[

FG Colar; @

Patterm:

BG Colar:

Profile

Left: |43 & Width: (151

4

Top: 1139 2 Height: (143

4

Yigibility Controlled By Bit
$U0.1

Cantral Bit;
Wizible State: (3 0M () OFF

The following table describes each property in the Polygon dialog box.

Property Description
Color Color Controlled Check this option if the color of the polygon will be controlled by the specified
Control By Bit bit.
| Specifies the bit that controls the color.
Control Bit .
Click to enter the bit address. Click to enter the bit tag.
State Select the state that you want to view or define the colors for.
Outline Outlined Check this option if you want the polygon to be outlined.
Thickness Specifies the thickness of the outline.
Color Specifies the outline color for the selected state.
Solid . Check this option if you want the polygon to be solid. A solid polygon is filled
Solid . o
with the specified pattern and colors.
Pattern Specifies the fill pattern for the selected state.
Specifies the color for the selected state that will be used for painting the
FG Color )
black part of the fill pattern.
BG Color Specifies the color for the selected state that will be used for painting the

white part of the fill pattern.

4-19
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9.

Property Description
Profile Left The X coordinate of the upper-left corner of the bounding rectangle of the
polygon.
To The Y coordinate of the upper-left corner of the bounding rectangle of the
P polygon.
Width The width of the bounding rectangle of the polygon.
Height The height of the bounding rectangle of the polygon.
Visibility | Visibility
Control Controlled By Check this option if the polygon will be shown or hidden by the specified bit.

Bit

Control Bit

Specifies the bit that shows or hides the polygon.
Click to enter the bit address. Click to enter the bit tag.

Visible State

Specifies the state (On or Off) that makes the polygon visible.

You can click the following icons in the Draw toolbar to modify the properties of the polygon.

Click Icon

To

Select a line style for the border.

Select a color for the border.

Select a color for painting the white part of the fill pattern.

Select a pattern for the fill pattern.

Bo Mo | ¥ | & | IS

Select a color for painting the black part of the fill pattern.

CHAPTER 4 DESIGNING SCREENS 4-20




¢++' - -
PM Designer Operation Manual

4.1.10. Drawing Text Objects

1. In the Draw menu or Draw toolbar, click Text

|

2. Move the cursor onto the screen where you want to draw a text object. A text object with default settings will
display and move along with the cursor.

3. Click the desired position on the screen to place the text object. The upper-left corner of the bounding box of the
text object will be at the clicked position.

4, Double-click the text object to bring up the Text Object dialog box and then modify the settings of the text object.
This dialog box contains the following three pages:

Note 1:
Note 2:
Tip:

4-21

General
Described in Section 4.1.10.1.

Shape
Described in Section 4.3.4

Visibility
Described in Section 4.4.6.

You can use the Text toolbar to modify the properties of the text object's text instantly.
You can use the Draw toolbar to modify the properties of the text object's shape instantly.

By default, the Auto Text Resizing on the Edit menu is checked and the related icon on the Edit toolbar is
sunken. If you don’t want to resize the text when resizing the object, you need to uncheck the Auto Text

Resizing command on the Edit menu or click the sunken icon (-2, on the Edit toolbar to make the font size
fixed.

CHAPTER 4 DESIGNING SCREENS
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4.1.10.1. General Settings

This section describes how to define the general settings for text objects.

Text Object 3

General | Shape | Visiilty

Language: | Language 1 ~ | — Shape

[ ] Usze the text of the first language for all other languages

Font: [Arial w

0 G

Thiz iz a test.

In this edit box, you can view and
edit the current text of the current
selected language.

A

Colar; @ Tranzparent

Drirection Position g E E
(%) From left to right . . .

) From right to left
) From top to bottom
) From bottam to top

oNoNe
oNON®,
OCO

Spacing

Border: Lire: Char.:

[ ] ][ Cancel ][ Help ]

The above is an example of the General page of the Text Object dialog box.
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The following table describes each property in the General page.

Property Description
Language The language that you are setting the text for.
Shape Check this option if you want the text object to have a frame as its background. The Shape

page appears in the dialog box when the option is selected.

Use the text of the
first language for all
other languages

Check this item so the text object always shows the text of the first language regardless of what
the current language is.

Font

The font of the current text. You can use the drop-down list to select a font.

Or click [:J to bring up the Font Templates dialog box and select a font for the current text.
You can change the font templates before selecting a font in that dialog box.

<Text Edit Box>

The current text of the current selected language. You can view and edit the text for the

selected language in this edit box. Or click [:] to bring up the Text Source dialog box to select
a text from Text Database. You can change the text database before selecting a text in that
dialog box.

Color The color of the text. To specify the color, click the corresponding Color icon and select a color
from the Color palette.
Transparent Check this item to make the background of the text transparent.
BG Color Specifies the background color of the text. This field is available when the Transparent is not
selected.
Direction Select one of the following directions to arrange the characters of the text.
. . From left to From right to From top to From bottom to
Direction .
right left bottom top
Input text:
An A e
example n I
p
e m
X a
An example | elpmaxe nA 3 X
m e
p
| n
e A
Position
221 Th iti f the text bod
e position of the text body.
O ® O P Y
C O O

The alignment of the text.

Border Spacing

The margin (in pixels) to the border of the object’'s shape for the text body.

Line Spacing

The distance (in pixels) between two adjacent lines of the text.

Character Spacing

The distance (in pixels) between two adjacent characters of the text.
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4.1.11. Drawing Picture Objects

1. In the Draw menu or Draw toolbar, click Picture E .

2. Move the cursor onto the screen where you want to draw a picture object. A picture object with default settings
will display and move along with the cursor.

3. Click the desired position on the screen to place the picture object. The upper-left corner of the bounding box of
the picture object will be at the clicked position.

4, Double-click the picture object to bring up the Picture Object dialog box. Select a picture and define the settings
for the picture object in the dialog box. Note that you can use the Picture toolbar to modify the properties of the
picture object instantly. The following is an example of the Picture Object dialog box.

Mame: | fltothzer W

Fit ta Object
Tranzparent

Tranzparent Color;

Flip/Fatate: |07 w
Tone

Toning Color: @

Wizibility Controlled By Bit

Contral Bit; | $U0.0

Yisible State: 30N () OFF

Prifile
Left: |206 3 Width: |70 2

Redraw
Top: |29 = Height: |70 =

The following table describes each property in the Picture Object dialog box.

Property Description

The name of the picture that the object displays. You can use the drop-down list to select
a picture from the picture database.

. 5 : i . . .
Click to select a picture from a file. After the selection, PM Designer imports the
Name picture of the selected file and saves the picture in the picture database.

Click to bring up the Select/Import from Library dialog box. Select a picture from a
picture library file. After the selection, PM Designer imports the selected picture from the
selected library and saves the picture in the picture database.

View Shows the processed result of the selected picture according to the current settings.
Continued
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Property Description

Check this item so the picture can change its size automatically to just fit

Fitto Object inside the object.

Check this item to make parts of the picture transparent. The transparent
Transparent parts are pixels whose colors are identical to the specified transparent color.
This item is available when the picture is not a black and white picture.

The transparent color. This item is available when the picture is not a black

Transparent Color and white picture.

The color to paint the black part of a black and white picture. This item is

FG Color available when the picture is a black and white picture.

The color to paint the white part of a black and white picture. This item is

BG Color available when the picture is a black and white picture.

Flip/Rotate Specifies the method to flip or rotate the picture before drawing it. There are
8 options:

Method Description

0° Do nothing

90° Rotates the picture clockwise by 90 degree

180° Rotates the picture clockwise by 180 degree

270° Rotates the picture clockwise by 270 degree

X Flips the picture over X axis

90° & X Rotates the picture clockwise by 90 degree and flips it over X
Axis

Y Flips the picture over Y axis

90° &Y Rotates the picture clockwise by 90 degree and flips it over Y
Axis

Tone Check this item to tone the picture.

Toning Color The color to tone the picture.

Visibility | Visibility Check this option if the picture will be shown or hidden by the specified bit.
Control Controlled By Bit

Control Bit Specifies the bit that shows or hides the picture object.

Click to enter the bit address. Click to enter the bit tag.

Visible State Specifies the state (On or Off) that makes the picture visible.

Profile Left The X coordinate of the upper-left corner of the object.

Top The Y coordinate of the upper-left corner of the object.

Width The width of the object.

Height The height of the object.

Redraw Click this button to redraw the object on the screen with the current settings.
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4.1.12. Drawing Scales
E

2. Move the cursor onto the screen where you want to draw a scale. A scale with default settings will display and
move along with the cursor.

In the Draw menu or Draw toolbar, click Scale

3. Click the desired position on the screen to place the scale. The upper-left corner of the bounding box of the scale
will be at the clicked position.

4, Double-click the scale to bring up the Scale dialog box and then define the settings for the scale. The following is
an example of the Scale dialog box. To the right of the dialog box shows the corresponding scale.

Diirection Paozition

() Horizontal (%) Wertical 7 Left {*) Right

=
_—

Cancel

[ ] Dynamic Range

Colar: @

Mumber of Majar Ticks: (11 5

Mumber of Sub Divizions: |5 |5

Minaor Tick Length: |13 % =3 i00.0
——90.0
L | —
[+] iz SHP
Marks — 700
Font: O R3  ®ax12 Ozie — 0.0
Finirnm: |0 b awirnurn; | 1000 E— 50.0
Tatal Digit: |4 % ;— 40.0
——30.0
Fractional Digits: |1 % —
——20.0
Feverse Order —
- ——10.0
— 0.0
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The following table describes each property in the Scale dialog box.

Property

Description

Direction and Position

Select the direction and the position for the scale according to the following table.

Direction Horizontal Vertical

Position Top Bottom Left Right

[TITTTTTT] | & .

Lol e] |e i 15

a A

Dynamic
Range

Dynamic
Range

Check this item if you want the numbers of the scale ticks and the range of the scale marks
to be dynamic, i.e. to be controlled by the specified variable.

Parameter
Block

Specifies the variable that controls the numbers of the scale ticks and the range of the
scale marks. The variable is an array of four double-words (8 words). The following table
describes the data members of the array.

Word #
0,1

Data Type
32-bit unsigned integer

Description

The number of major ticks. The allowable range of
this number is between 2 and 101.

2,3 32-bit unsigned integer | The number of divisions between two adjacent
major ticks. The allowable range of this number is

between 1 and 100.
The minimum of the scale marks.

4,5
6,7

32-bit signed integer

32-bit signed integer The maximum of the scale marks.

Example

Assume a scale’s dynamic range control block is $U100. The following macro commands
makes that scale look like this:

$U100 = 3 (UD) // The number of major ticks.

$U102 = 5 (UD) // The number of sub-divisions.
$U104 = 0 (SD) // The minimum of the scale marks.
$U106 = 100 (SD) // The maximum of the scale marks.

[TTTTTTTT]
5]

=15 166

Color

The color of the scale. To specify the color, click the corresponding Color icon and select a
color from the Color palette.

Number of Major Ticks

The number of major ticks. The minimum you can specify is two.

Number of Sub
Divisions

The number of divisions between two adjacent major ticks. The minimum you can specify
is one.

Minor Tick Length

The length of minor ticks.

AXxis

Check this item if you want the scale to have an axis.

Marks Marks Check this option if you want the scale to have marks.
Font The font of the marks.
Minimum The minimum of the marks. It is a 32-bit integer.
Maximum The maximum of the marks. It is a 32-bit integer.
Total Digits | The total digits to be displayed for the marks.
Fractional The number of fractional digits for the marks. For example, when the Maximum is 5000, the
Digits Total Digits is 4, and the Fractional Digits is 2, the mark for the Maximum will be 50.00.
Reverse Check this option if you want the marks of the scale to show in reverse order. In normal
Order order, the maximal mark is at the right end or top end of the scale. In reverse order, the
maximal mark is at the left end or bottom end of the scale.
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4.1.13. Drawing Tables
E .

2. Move the cursor onto the screen where you want to draw a table. A table with default settings will display and
move along with the cursor.

1. In the Draw menu or Draw toolbar, click Table

3. Click the desired position on the screen to place the table. The upper-left corner of the table will be at the clicked
position.
4, Use drag-and-drop editing to move an existing object into an empty cell of the table. If the object is allowed to be

placed in the cell, a message box will popup to confirm the operation. The following is an example of object
insertion with confirmation dialog box.

(i ®I[- [B]x]

| Tahle Demao

> If you click Yes to insert the object to the table,
the object will be part of the table. Any
modifications such as moving the table, resizing
the table, deleting the table... will be applied to
the objects of the table at the same time.

mz > If you click No to cancel the operation, the

Marme
ok 1 53[;.;.?1.;1 Bit object will move to the specified position and
——— D] float over the table.
2_Second_Bit 1‘.{)‘ Insert ko table?
Date
Tirme [ Yes l [ Ma
Waek |

Note: Only 23 types of the objects can be placed in the cells of the table. The supported objects are Picture, Dot,
Text, Bit Button, Toggle Switch, Word Button, Multistate Switch, Screen Button, Function Button, Keypad Button,
Numeric Display, Numeric Entry, ASCIl String Display, ASCII String Entry, Bit Lamp, Multistate Lamp, Time
Display, Date Display, Day-of-Week Display, Message Display, Bar Graph, Picture Display, GIF Display,
Advanced Numeric Display.

5. Click the cell inside the table. If the cell contains the object, there will be the {hi' icon on the upper-left corner of
the cell. The following is an example shown you how to edit the object in the table.

BH Screen 1 (#1) > Left-click the icon
and hold down the
Table Demo button. When the

This is an empty

cell where you cursor turns to be 3",
can p|ace an move the ObjeCt out of
object' the table.
< — > Double click the icon
Bit/Object /ﬁalue to bring up the
1_Second_Bit | §LU100.0 g properties dialog box
2 Second_Bit | $U101.0 g of_ the correspond!ng
- object and then define
Date Date Display 04-17-07 the settings of object
Tirme Tirne Display 0o:07:21 for the selected cell.
Week Day-of-week Display Tuesday
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6.

4-29

Position the mouse point over one of the grid lines. When the cursor turns to be I or +*, drag the line until the

column is the width and the row is the height you want.

Note: You can adjust the width of the column when the Distribute columns evenly is not selected in the general
page of the Table dialog box. And you can adjust the height of the row when the Distribute rows evenly is not

selected in the general page of the Table dialog box.

Double-click anywhere inside the table, exclusive of the @r? icon, to bring up the Table dialog box and then

Marrie Bit'Object Walue P v[\)”rgt% gﬁh”engotlﬁ n?rc]jjust the
1_Gecond_Bit | §U100.0 N 3 |
2_Second_Bit |§Ui0to Y — g
Diate Diate Display 04-17-07 |——— Drag the line to adjust the
Time Time Display 000721 height of the row.
YWilpglk Day-of-week Display Tuesday

define the settings for the table. This dialog box contains the following two pages:

m General

Described in Section 4.1.13.1.

m Cell

Described in Section 4.1.13.2.

CHAPTER 4

DESIGNING SCREENS




4? - -
PM Designer Operation Manual

4.1.13.1. General Settings

This section describes how to define the general settings for table objects. The following is an example of the General

page of the Table Object dialog box.

Table X

General | Call
I0: | TBLOOOD Mote:
Barder Colar: @]
L
GF_0o1
Cel
Murnber of rows: B g
Murnber of columng: |3 &

Distribute rows evenly Drag and drop

Distibute columns evenly
Grid
Wertical

Horizontal

Calor: [E]

Style: |[-]a

[ QK ][ Cancel ][ Help ]

The following table describes each property in the General page of the Table dialog box.

Property Description
ID The object’s identifier. It is generated when the object is created and is unchangeable.
The identifier is unique within the screen where the object is on. The format of the ID’s
for the tables is TBLnnnn.
Note You can type a note for the object.

Shape settings

For details about the following properties, see Section 4.3.4 Setting up the Shape of an

Object. % Border Color, BG Color

Cell Number of rows Specifies the number of rows in the table.
Number of columns | Specifies the number of columns in the table.
Distribute rows Check this option if you want the rows of the table to be distributed evenly always.
evenly Uncheck this option if you want to adjust the heights of the rows.
Distribute columns | Check this option if you want the columns of the table to be distributed evenly always.
evenly Uncheck this option if you want to adjust the widths of the columns.
Drag and drop Check this option so you can drag and drop an object into a cell of the table. Note that
not all kinds of objects can be placed in the cells of the table.
Grid Vertical Check this option if you want the table to have vertical grid lines.
Horizontal Check this option if you want the table to have horizontal grid lines.
Style Specifies the style for the grid lines.
Color Specifies the color for the grid lines.
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4.1.13.2. Cell Settings

The following is an example of the Cell page of the Table Object dialog box and Select Object Dialog box when the Insert

Button is clicked.

General | Cell Click the button to bring up
(Row,Column) ~ Object Margin ~ the Select Object dialog.
(0,0} Tex = o elate /
(0,19 Text B o
— Inzert
PP 0o : -
Select Object EJE|
(1,0) Text B o e—
] I ar Girap
(1,1) Text = o E'ﬁ Eutton
it Lamp
{1.2) MNumeric Entry EI 0 Character Display
Character Entry
(2,0) Text = o Date Display
G Dray-of-week, Digplay
(21) Text 0 Dat
Function Button
(2.2) Numeric Entry |[E | 0 GIF Display
1 i Feypad Button
(3.0) Texd G 0 Mezzage Dizplay
(313 Tert Q T 3 ultistate Lamp
! ultiztate Switch
5 I I MHurneric Display
(3,23 Date Display | | 0 Mumeric Entry
Ficture
(40) Tex EI 0 Picture Display
(41) Text [:;:l 0 3 Screen Button
! Test
FEaN < > Time Display
Toagle Switch
*wiord Buthon
[ ok ][ coacel |[ Hep | [ ok ] [ Concel |

The following table describes each property in the Cell page of the Table dialog box. To make the buttons available, you
need to select a row. To select a row, left-click the (Row, Column) column.

Property Description

(Row,Column) The location of the cell.

Object The type of the specified object. If the field is empty, the cell has no object inserted and it is called
empty cell.

o Click the button to bring up the properties dialog box of the specified object and define the settings
of the object for the selected cell. The button is available when the Object field is not empty.

Margin The distance in pixels between the object boundary and the cell border. Select a number between 0
and 10.

Delete Click the button to clear the contents of the selected cell. The button is available when the selected
cell is non-empty.

Insert Click the button to bring up the Select Object Dialog Box shown above. And select an object type
listing in the dialog to create a new object for the selected cell. The button is available when the
selected cell is empty.

Note: The table won't allow to insert the type of an object which is not listed in the dialog.

Move Up Click the button to move the selected cell before the previous cell. It will not be available when
multiple rows are selected or no row is selected or the first row is selected.

Move Down Click the button to move the selected cell after the next cell. It will not be available when multiple
rows are selected or no row is selected or the last row is selected.
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4.2. Editing Objects

In this section you will learn how to select the objects first and then move around, copy, or edit the selections without
affecting the rest of the screen.

4.2.1. Selecting and De-selecting the Objects

m Selecting Objects

To select an object, move the mouse to the object you want to select and then click the left button.

To add an object to the selection, use Shift + Click.

To select all objects of the active screen, use Ctrl + A or use the Select All command on the Edit menu.

m Selecting Objects by a Rectangular Area

Click the mouse left button on the blank area of the screen, and hold the button to begin your selection. Where you click
will become one of the corners of the rectangular selection area. Then drag the mouse diagonally. Release the mouse
button when to the position you want the opposite corner of the rectangular area to be.

Each of the selected objects will have blue square-shaped tabs around it. The object with solid tabs is the reference object.

m De-selecting the Objects
To de-select the objects, either click the blank area of the screen, or make a new selection.

4.2.2. Basic Operations with the Selected Area
m Moving Objects

Left-click anywhere inside the selected objects and hold down the button. When the cursor turns to be‘%’, drag the mouse
to move the selection to another area of the screen. It will "float" over the rest of the screen, allowing you to position it
wherever you want it to be. Release the mouse button to "let go" of the selection.

m Grouping or Ungrouping Objects

To group the selection, click .Ll_j' on the edit toolbar, or use the Group command on the Edit menu or on the object popup
menu. After you have grouped a selection that includes at least two objects, you can copy, move and resize all objects in a
group as a single unit. Or you can select an object within the group and change the properties without ungrouping. You can
also save the group to the object library and use this object group in the animated graphic.

To ungroup the selected group, click E[ on the edit toolbar, or use the Ungroup command on the Edit menu or on the
object popup menu. After ungrouping the objects, the objects within the group will be restored to the single ones.

m Resizing Objects
The square-shaped tabs around your object can be re-sized. You can resize by clicking on the square-shaped tabs located
at the corners and the middle sections of the bound rectangle area, holding the mouse button down, when the cursor turns

to be & or I or Mu or +—, dragging the mouse to change the size of the selection. Release the mouse button when the
selection is the size you want it to be. You can make it bigger or smaller, and achieve a distorted effect by "squashing" or
"stretching" the selection to make it either wider/narrower or taller/shorter than its original proportions.

Tip: You can't resize more than one object at a time unless you group multiple objects before resizing.

m Auto Text Resizing

To automatically scale the text of the object when resizing the object, click -, on the edit toolbar if it is raised, or use the
Auto Text Resizing command on the Edit menu.

Tip: Auto Text Resizing command is checked and the icon is sunken by default. If you don’t want to resize the text
when resizing the object, you need to uncheck the Auto Text Resizing command or click the sunken icon to
make the font size fixed.
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m Pinning or Unpinning Objects

To pin the selection so it can not move, click o~ on the edit toolbar, or use the Pin command on the Edit menu or on the
object popup menu.

To unpin the selection so it can move again, click b on the edit toolbar, or use the Unpin command on the Edit menu or
on the object popup menu.

Tip: Pinning objects can still be resized.

m Copying or Cutting and Pasting Objects

. . . Thi . .
To copy the selection from the current screen and places it on the Windows — clipboard, press Ctrl+C, or click on
the standard toolbar, or use the Copy command on the Edit menu or on the object popup menu.

To cut the selection from the screen, press Ctrl+X, or click & on the standard toolbar, or use the Cut command on the
Edit menu or on the object popup menu.

After Copying or Cutting, you can paste the selection by pressing Ctrl+V, or click on the standard toolbar, or use the
Paste command on the Edit menu or on the object popup menu.

To copy and paste the selection by mouse, press and hold down Ctrl key, and
then left-click the selection and hold down the button. When the cursor turns

to be‘%’, drag the mouse to copy the selection to another area of the screen.
The picture on the right shows the example.

[m]

Tip: Cut and Paste are good for moving objects around in the screen or to another screen.
Copy and Paste are good for duplication objects for current screen or some others screens.
By pasting multiple times on the current screen, you can achieve a cascading effect.

By pasting once to the different screen, the position of the pasted object will be same as the copied object in the
different screen.

m Deleting Objects

To delete the selection, press Del or use the Delete command on the Edit menu or on the object popup menu. When you
use Delete, whatever is in the selection will be deleted.

= Undo
To reserve the last action, press Ctrl+Z, or use the Undo command on the Edit menu.

= Redo

To reapply the actions that were previously canceled by the Undo command. press Ctrl+Z, or use the Redo command on
the Edit menu.

m Keyboard Shortcuts

Shortcut Operation Shortcut Operation Shortcut Operation
Ctrl+N ) i
New Project Ctrl+X Cut Ctrl+D Duplicate
Ctrl+O , )
Open Project Ctrl+C Copy Ctrl+F Find
Ctrl+S Save Ctrl+V Paste Ctrl+R Replace
Ctrl+z Undo Ctrl+Click+move | Copy & Paste Ctri+A Select All
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Ctrl+Y

Redo

Del

Delete

Shift+Click

Multiple Select

Ctrl+Click

Reference Object Select
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4.2.3. Duplicating Objects

To duplicate the selected object, use the Duplicate...

command on the Edit menu or on the object popup menu. After the

duplicate command is executed, the following dialog will popup and allows you to set how to duplication objects.

Ioplicate

Colurnms:

F o

Wertical:

Harizontal:

Increment; |1 S

MHurnber of Copies

3

4

4

4

Spacing in Piselz

4

4

4 v

Increasze Address

= :
Copy Direction a
O .
O 1
O e
O _ _
o v s || s | e e
® e T [T | o
O addresses I'u1:$U11EI_J W FUADET J m:$u1c}é_
| SADANAD P Por o o) | Pl b b )
© b U117 [ w5107 || ma: $u¢:
Click View > Address > Monitor on the
menu to show the monitor address on the

upper-left corner of the object.

The following table describes each property in the Duplicate dialog.

Property Description
Number Columns The total number of the columns.
of Copies Rows The total number of the rows.
Spacing Vertical The distance (in pixels) between two adjacent objects in the vertical direction.
inPixels " yorizontal | The distance (in pixels) between two adjacent objects in the horizontal direction.

Increase Address

Check this item so the address of each duplicate will be increased of the specified
increment over the previous object.

Increment The increase amount.
Copy From top to down, place the duplicates row by row. In the same row, place the duplicate to
Direction the right of the previous object.
From top to down, place the duplicates row by row. In the same row, place the duplicate to
the left of the previous object.
From down to top, place the duplicates row by row. In the same row, place the duplicate to
the right of the previous object.
From down to top, place the duplicates row by row. In the same row, place the duplicate to
the left of the previous object.
From left to right, place the duplicates column by column. In the same column, place the
duplicate down to the previous object.
From right to left, place the duplicates column by column. In the same column, place the
duplicate down to the previous object.
From left to right, place the duplicates column by column. In the same column, place the
duplicate up to the previous object.
From right to left, place the duplicates column by column. In the same column, place the
duplicate up to the previous object.
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4.2.4. Aligning Objects

To arrange the selected objects on a screen, you need to select a reference object from the selections and then press the
icon on the toolbar or click the menu item listed as below. To do the multiple selection, use Shift + Click. To select a
reference object from the selections, use Ctrl + Click.

Use the Align commands on the Edit menu to arrange objects/draws on a screen. Select an object or draw by
single-clicking on it, then hold down the Shift key while clicking on other objects or draws to be aligned with it. When all of
the objects or draws to be aligned are selected, choose one of the commands in the Align submenu or directly click
specified icon in the Edit Toolbar.

Icon Menu Item Description

Align the left sides of selected objects to the left side of the reference object. All the
=] Left objects move horizontally so their left sides are in line with the left side of the
reference object.

Align the vertical centers of selected objects to the vertical center of the reference
object. All the objects move horizontally so their vertical centers are in line with the
vertical center of the reference object.

Align the right sides of selected objects to the right side of the reference object. All the
=l Right objects move horizontally so their right sides are in line with the right side of the
reference object.

— Align Align the tops of the selected objects to the top of the reference object. All the objects
Top . . L : .
move vertically so their tops are in line with the top of the reference object.

Align the horizontal centers of selected objects to the horizontal center of the
reference object. All the objects move vertically so their horizontal centers are in line
with the horizontal center of the reference object.

Vertical
= Center

=
=

Horizontal
Center

&

Align the bottoms of selected objects to the bottom of the reference object. All the
iy Bottom objects move vertically so their bottoms are in line with the bottom of the reference
object.

=
B=

o

To Grid Select or deselect the option of aligning objects to the grid points.

Nudge the selection left. When the Snap to Grid option is not selected, all objects of
the selection move one pixel left. When the Snap to Grid option is selected, each
object of the selection moves left to where its upper-left corner aligns to the nearest
grid point.

Nudge the selection right. When the Snap to Grid option is not selected, all objects of
the selection move one pixel right. When the Snap to Grid option is selected, each
object of the selection moves right to where its upper-left corner aligns to the nearest
grid point.

Nudge the selection up. When the Snap to Grid option is not selected, all objects of
o Up the selection move one pixel up. When the Snap to Grid option is selected, each
object of the selection moves up to where its upper-left corner aligns to the nearest
grid point.
Nudge the selection down. When the Snap to Grid option is not selected, all objects of
the selection move one pixel down. When the Snap to Grid option is selected, each
object of the selection moves down to where its upper-left corner aligns to the nearest
grid point.

i

Left

i

Right

Nudge

:EF Down
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4.2.5. Making Objects Same Size

To make the selection same size as the reference object which can be selected by using Ctrl + Click, press the icon on the
toolbar or click the menu item listed as below.

Icon Menu Item Description
= Width Make the selected objects have the same width as the reference object.
; Make
af] Same Height Make the selected objects have the same height as the reference object.
Size
Lo Both Make the selected objects have the same width and height as the reference object.

4.2.6. Arranging the Order of Objects

Icon Menu Iltem Description
T Bring to Top Bring the selection to the top.
h Bring Forward Bring the selected object one layer up.
Layer
Ta| Send Backward Send the selected object one layer down.
By Send to Bottom Send the selection to the bottom.
Set Order Start the order setting process for the objects of the active screen. For details,
please see Section 4.2.6.1 Changing the Order of Objects

4.2.6.1. Changing the Order of Objects

The object order in PM Designer is the order in which the selection cursor moves the input focus from one object to the
next within a screen. Usually the order proceeds from left to right and from top to bottom in a screen. In the model with
programmable keys such as 037-LSK, the Data Entry Object receives input focus in the specified order by clicking
direction keys. In touch panel, you can use function button to select a data entry object with the order number previous or
next to the current selection.

The object order is also the display order. If the screen contains overlapping the objects, change the order will change the
display sequence of the objects. The objects that come later in the order are always displayed on top of any overlapping
objects that precede them in the order.

m Viewing order
To view the current order of all objects in the screen, click Set Order on the Edit menu.

m Changing order
To change the order for all objects in the screen
1) On the Edit menu, click Set Order
A Number in the upper-left corner of each object shows its place in the current order
2) Setthe order by clicking each object in the order you want to display the object. The ordering number starts from 1.
3) Click the blank field on the screen to exit Set Order mode
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The following is an example of the object ordering.

[BRbbhbbbbbbbbbbbbbibbbbbth] | | IAAALAAARAALALLARALALLALE)
Corernardcations: Disshled + + “:Dmurdcatinrns' Ea}:lled E

Port: Cori B Fort: e |m
Band Rate: 4200 Band Rate: ﬂ]l:l

Data Bits: 7bits + - 7| Data Bits: fits E |E
Parity: Hone Farity: Fije

Stop Bit: 1hit Stop Bit: fE
Cororaand Delay: 99 FEJororaand Delay:
Retry Times: 90 OF Retry Times: i Ed 0K

Timeout Tirme: 99 Tireout Tiree: FE
Panel Address: 000 L) Panel sddvess: B

PLC Address: 99999 ancel Il FLC Address: [FE]99 B

If the screen running on 037-LSK, click the down or right direction key to move the selection in 2-4-6-8-10-12-14-16-18

-20-29 sequence. If the screen running on the touch panel, click function button to move the selection in the same
sequence. The text objects with 1,3,5...order number are not data entry object, so they won't receive the selection and
don't list in the sequence.
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4.3. Designing Object Appearance

There are four common components of object appearance. They are described in the following table:

Appearance Component

Description

Shape

The shape of an object can either be a graphical shape or a picture shape.
The following are examples of graphical shapes

R I

The following are examples of picture shapes.

PM Designer provides many graphical shapes for you to choose. For details, see Section
4.3.3 Selecting a Graphical Shape. The color or the pattern of a graphical shape is
dependent on the state of the associated object. You need to specify the color or pattern
settings of a graphical shape for each state of the associated object. For details,

see Section 4.3.1 Selecting a Color and Section 4.3.2 Selecting a Pattern.

If you want an object to have a picture shape, check the item Picture Shape in the General
Page of the object’s property dialog box. You can select a picture from the picture
database or import a picture from a library file for the shape of an object. Any picture with
the format of BMP, JPG, or WMF can be a picture shape. When a picture is used as a
shape, the shape is state independent, i.e. the same look appears for all (object) states. If
you want a picture shape to display the object state and/or show the touch action, you
need to select a picture group as the shape. For details of picture groups, see Section
2.1.3.3 Picture Groups

To know how to set a shape, see Section 4.3.4 Setting up the Shape of an Object.

Inner Label

An inner label is a label inside the associated object. It has the same number of states as
the associated object. You need to specify the text settings and the picture settings of an
inner label for each (object) state. Inner labels are language dependent. You need to
specify the text of an inner label for each language too. Note that not all objects can have
inner labels and some objects can just have text or a picture in their inner label.

To know how to set an inner label, see Section 4.3.5 Label Settings.

VFTA (Visual Feedback for
Touch Action)

A button or switch can give the operator one of the following visual feedback when it is
touched:

Visual Feedback Description

Sunken Shifts the inner label to the lower-right corner by one or two pixels.

Back Fills the area inside the border of the shape with the shape’s FG
Color.

Outline Outlines the object with the shape’s FG Color.

External Label

An external label is a label outside but attached to the associated object. Unlike inner
labels, external labels are state independent. They have the same look for all (object)
states. However, external labels are language dependent. You need to set the text of an
external label for each language. External labels are touch insensitive. Touching an
external label will not activate the associated object. Note that not all objects can have an
external label.

To know how to set an external label, see Section 4.3.8 External Label Settings.
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The following table shows the common appearance components that each object type can have:

Shape Inner Label - !
) xterna
Object Types i i VFTA
] yp Graphical Picture Text Picture Label
Shape Shape
Bit Button, Toggle Switch, Screen Button, Word o o o o o o
Button, Multi-state Switch, Radio Button Group
Function Button, Keypad Button, Page Selector ° ° ° ° °
Step Button ° ° ° ° °
Bit Lamp, Multi-state Lamp, ° ° ° ° °
Message Display ° ° °
Picture Display ° ° °
Day-of-week Display ° °
Meter ° °
Slide Switch, Numeric Entry, Numeric Display,
Advanced Numeric Display, ASCIl Character ° °
Entry, ASCII Character Display, Bar Graph
Time Display, Date Display, Pie Graph, Line Chart,
Scatter Chart, Alarm Display, Historic Data
Display, Historic Trend Graph, Single Record Line °
Chart, Operation Log Display, Recipe Selector,
Recipe Table, Sub-link Table, Static Text, Table
Animated Graphic ]
The orders of drawing the common appearance components are shown in the following table with examples:
Step Draw Example 1 Example 2 Description
f_ﬁ I
1 Shape Described in Section 4.3.4
A picture group that supports | A graphical shape named
the pressed look SW_0023
Picture of Inner . . .
2 label @ (None) Described in Section 4.3.5.2
3 Egg of inner HELP START Described in Section 4.3.5.1
4 | VFTA (None) Back (FG Color is )
5 External label (None) mgm,]r Described in Section 4.3.8
Final Appearance 7 tiotar
(When untouched) D Ma. 1 START
Final Appearance f \ fatar
(When touched) x@ HELP | Mo, 1 START
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4.3.1. Selecting a Color

m Color Icons

In a dialog box, a color icon is associated with a property that requires a color. It shows the color of the current selection
and you can click it to bring up the Color palette. With the Color palette, you can select a color for the associated property.
The following is a Color icon showing that the current selection is yellow.

m Color Palette

With the Color palette, you can: 1) Select a color from a set of predefined colors, 2) Customize a set of user colors, and 3)
Select a color from a set of user colors.

Usually, you click a Color icon to bring up the Color palette. The following shows the pages of the Color palette.

[rl2[3[4] [1]2[3[4] [1[2[3[4] [1][2][3]4]
EEEEEEND EEEEEEN] S ENEEEEN EEENEEEN
O [T
EEEEEE MEEEEE A EEEEEEE EEEEE N

EERNCEEN
AEEEEEEEN
EfEEEEEN

[(IHMEEENENEN
EERONOON
EEEEERNCO

EEEEREREO
EEEEREEEN

EERfEEEN
EENEEEREO
EEENEECC ]

On page 1, the yellow block is outlined to indicate that it is the current selection. To select a color, click on that color block.
To select a page, click on that page’s number tab. To cancel the operation click on any position other than the color blocks
and the number tabs. Page 1, 2, and 3 contain the predefined colors. Page 4 contains the user colors. To customize user
colors, click | = | to bring up the Define Custom Color dialog box as shown below.

Deﬁne Custom Color E

VERS

Cuskom Colors:

ENENETN
ETTHE TN
EENENET:
EETENET
TTANNNEN
THEEAN
AOEE TN
TTHE TN

Sat: |2

Cl:ull:urIScnIu:I L m

Green:

Blue: EI

]
s

] [ Cancel

[ add to Custorn Colors ]
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4.3.2. Selecting a Pattern

m Pattern Icons

In a dialog box, a Pattern icon is associated with a property that requires a pattern. It shows the pattern of the current
selection and you can click it to bring up the Pattern palette. With the Pattern palette, you can select a pattern for the
associated property. The following is a Pattern icon showing that the current selection is the “big dashes”.

m Pattern Palette

With the Pattern palette, you can select a pattern from a set of predefined patterns. Usually, you click a Pattern icon to
bring up the Pattern palette as shown below.

S o
e % WNZNZ =

Il S

] - 1
o A T )
A et

gohidlll
: R D
o

FHEE

mm

The “big dashes” block is outlined to indicate that it is the current selection. To select a pattern, click on that pattern block.
To cancel the operation, click on any position other than the pattern blocks.

4.3.3. Selecting a Graphical Shape
m Shape Buttons

In an object’s property dialog box, you can click the shape button to bring up the Shape palette. With the Shape
palette, you can select a graphical shape as the shape of the associated object.

m Shape Palette
With the Shape palette, you can select a graphical shape for an object. Usually, you click to bring up the Shape
palette. The Shape palette contains several pages of graphical shapes. To select a graphical shape, click on that graphical

shape. To select a page, click on that page’s number tab. To cancel the operation, click the close button ﬂ to close the
Shape palette.

There are four sets of graphical shapes available for your applications. Each of them is suitable for certain kinds of objects.
The Shape palette shows the set that is suitable for the type of the concerned object. The four sets of shapes are shown
below.
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Graphical shapes for buttons and switches

Shape Paletie @ Shape Paletie @ Shape Palette

1 2 3 4 b 1 2 3 4 5 1 2 3

_

Shape Paletie @ Shape Paletie @
1 2 3 4 5 1 2 3 4 ]

Graphical shapes for data entry objects

Shape Palette @ Shape Palette @ Shape Palette @

1 2 3 1 2 3 1 2 3

]
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Graphical shapes for data display objects

Shape Paletie
1 2 3

3

Shape Paletie B|
1 2 3

Shape Palette E|
1 2 3

Graphical shapes for lamps

Shape Palette
1 2 3 4 5

3

Shape Palette g|
1 2 3 4 5

[ OC
FOC

Shape Palette E|
1 2 3 4 5

|
oo

Shape Palette
1 2

Shape Palette
1 2 3 4 5

&
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4.3.4. Setting up the Shape of an Object

This section describes how to set the shape of an object.

In order to give the operator a visual feedback for the touch action, most of the graphical shapes designed for the touch

operable objects can change their look when touched. They can make the edge or border look pressed or show the outline
with a different color.

The following examples are the shape settings of a bit button:

Example 1 Example 2
The graphical shape SW_0031 is selected. The graphical shape is a picture.
[]Picture Shape [ External Label Picture Shape [ External Label

WFTA | Surken % WFTA: | Dutline N

State Q-
Eglrgfr FG Colar: @] FG Color:
S 003 Pattern: BG Color:

The following table describes each property that may be required for the settings of an object’s shape.

Property Description

Picture Shape | Check this option if you want the object to have a picture shape instead of a graphical shape. This
option is available when the object can have a picture shape.

Click this button to specify the shape of the object. When the Picture Shape is checked, the
Select/Import from Library dialog box will display. Otherwise the Shape palette will display.
VFTA The type of VFTA (Visual Feedback for Touch Action).
Test VFTA Click this button to view the selected VFTA.
Border Color The border color of the graphical shape. Click the corresponding Color icon to specify the color.
Pattern The pattern that is used to fill the area inside the border of the graphical shape for the current

(object) state. To specify the pattern, click the corresponding Pattern icon and select a pattern from
the Pattern palette. This item is available when the area inside the graphical shape needs be
painted.

FG Color The color that is used to paint the black part of the pattern for the current (object) state. When the
solid white pattern is selected, this color is not used. When a picture shape is used, this color is used
for the outline mode with VFTA.

Example 1 Example 2

EEE? FG Calor: @ Eglrud::ar FG Calor: @]
Pattern: BG Color: Patterr: BG Color:

To specify the color, click the corresponding Color icon and select a color from the Color palette.
This item is available when the area inside the graphical shape needs be painted.

BG Color The color that is used to paint the white part of the pattern for the current object state. To specify the
color, click the corresponding Color icon and select a color from the Color palette. This item is
available when the area inside the graphical shape needs be painted.
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4.3.5. Label Settings

This section describes how to set up the inner label for the following types of objects:
Bit Button, Toggle Switch, Screen Button, Function Button, Word Button, Keypad Button, and Bit Lamp.

The property sheets of the above mentioned objects provide you the Label page to set up the inner label. If an object has
only one state, the Label page has the Text sub-page and the Picture sub-page for you to set up the text and the picture of
the inner label respectively. If an object has two states, the Label page has the following four sub-pages:

Sub-page For Setting
OFF Text Text of state 0 (Off)
OFF Picture Picture of state 0 (Off)
ON Text Text of state 1 (On)
ON Picture Picture of state 1 (On)

You can use the Label page to set the inner label of an object that can have at most two states.
The following is an example of the Label page.

The following table describes only the properties in

G || Label | ad d | Wizibilit .
EEE e il the Label page that are common to all it's sub-pages.
L L 1 ™ Border Spacing: |0 * The properties of each of its sub-pages are described
SEEEDE et v SR SR * in the specific section about that sub-page.
[]Uze the text of the first language for all other languages Property Description
Test | Picture Lanquade The language that you are setting
guag the text for.
START (] The margin (in pixels) to the
Border Spacing | border of the object’s shape for

Copy from Maote

Font 2

v L]

both the text body and picture.

Use the text of
the first
language for all
other

Check this item so the inner label
always shows the text of the first
language regardless of what the

current language is.

Font: languages

- Click this tab to bring up the Text

2 Blirl.

Colar: @ [ Blin Text tab sub-page.
Transparent i i i
e
Char. Spacing: |0 % Line Spacing: |0 % : _ pag =

B OFF Text tab Click this tab to bring up the OFF
Pasition Text sub-page.

o O O ON Text tab _IC_I|cIt< th|§ tab to bring up the ON
Shape BG Calor: C ® O ext sub-page.
O O O OFF Picture C]lck this tab to bring up the OFF
tab Picture sub-page.
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4.3.5.1. Text Sub-page Settings

You can use the Text sub-page, OFF Text sub-page, and ON Text sub-page to set up the text of the inner label for the
corresponding state and the current language. The language you are setting for is specified by the Language item in the

Label page.

The following are examples of the Text pages:

Text sub-page

ON Text sub-page

Label

General Advanced | Vizibility

Language: | Language 1 w : Border Spacing: |0

[] Usze the text of the first language for all ather languages

Text | Picture

START|

Copy from Mote

Font |Font 2

Calor: @

Tranzparent

1Bk

Char. Spacing: |0 % Line Spacing: |0 %

Shape BG Color: (@]

©

Pozition

w

(]

Gereral | Label | Advanced | Wisibility

F

Language: | Language 1 v |5 Border Spacing: |0 =

[] Use the text af the first language for all ather languages

OFF Text| OM Text

START] (]

OFF Picture | OM Picture

Copy to OFF State
v ()

Copy from Mote

Font |Font 1

Color: [E]

Transparent

[]Blink

Fs

Char. Spacing: |0 % Line Spacing: |0 |+
Pozition

#8841 4]
Shape BG Color: O @& O
O 0 O

The following table describes each property in the Text sub-page, OFF Text sub-page, and ON Text sub-page.

Property Description

Copy from Note Click this button to replace the current text by the text of Note in the General page.

Copy to ON State | Click this button to use the current text to replace the text of ON state.

Copy to OFF Click this button to use the current text to replace the text of OFF state.

State

Font The font of the text. You can use the drop-down list to select a font.
Click [:] to bring up the Font Templates dialog box and select a font for the text. You can
change the font templates before selecting a font in that dialog box.

Color The color of the text. To specify the color, click the corresponding Color icon and select a color
from the Color palette.

Blink Check this item so the text will blink.

Transparent Check this item to make the background of the characters transparent.

BG Color The background color of the text.

Line Spacing The distance (in pixels) between two adjacent lines of the text.

Character The distance (in pixels) between two adjacent characters of the text.

Spacing
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Continued
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Property Description
The alignment of the text.
Position The position of the text body.
C O O
o ® O
C O O
Shape BG Color The BG color of the object’s shape for the current state.

4.3.5.2. Picture Sub-page Settings

You can use the Picture sub-page, OFF Picture sub-page, and ON Picture sub-page to set up the picture of the inner label

for the corresponding state.

The following are examples of the Picture pages:

A

Picture sub-page

ON Picture sub-page.

General | Label | Advanced | “isibility

Language: | Language 1 w : Border Spacing: |0
[ ] Usze the text of the first language for all other languages

Tewt | Picture

w

General | Label | Advanced | “isibility

Language: |Language 1 W : Barder Spacing: |0 £
[] Use the text of the first language for all other languages

OFF Text | On Text | OFF Picture | OM Picture

Mame; | BlankBtnGrp w Mame: | BlankBinGmp “w
ks Transparent View: Transparent

T. Colar:

T. Colar:

= Flip/Rotate: | 0 v ” N Flip/Rotate: |0 v
[ Tone -. [+#] Tore
Toning Colar:
Fit to Ohjzct ] Fit to Object
Pozition Pozitior
O O O© Copy to OFF State ] o O O
C @ O O @ O
Shape BG Calar: o C O Shape BG Colar: o O O
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The following table describes each property in the Picture sub-page, OFF Picture sub-page, and ON Picture sub-page.

Property Description

Name The name of the picture. You can use the drop-down list to select a picture from the picture database.
Click to select a picture file. After the selection, the picture of the selected file is imported and
saved in the picture database.

Click to bring up the Select/Import from Library dialog box. Select a picture from a picture library
file. After the selection, the selected picture is imported and saved in the picture database.

gt?;t)g to OFF Click this button to use the current picture to replace the picture of OFF state.

ggg o ON Click this button to use the current picture to replace the picture of ON state.

Transparent Check this item to make parts of the picture transparent. The transparent parts are pixels whose
colors are the same as the specified transparent color. This item is available when the picture is not a
black and white picture.

T. Color The transparent color.

FG Color The color to paint the black part of a black and white picture. This item is available when the picture is
a black and white picture.

BG Color The color to paint the white part of a black and white picture. This item is available when the picture is
a black and white picture.

Flip/Rotate Specifies the method to flip or rotate the picture before drawing it. There are 8 options:

Method Description

0° Do nothing

90° Rotates the picture clockwise by 90 degree

180° Rotates the picture clockwise by 180 degree

270° Rotates the picture clockwise by 270 degree

X Flips the picture over X axis

90° & X Rotates the picture clockwise by 90 degree and flips it over X
Axis

Y Flips the picture over Y axis

90° &Y Rotates the picture clockwise by 90 degree and flips it over Y
Axis

Tone Check this item to tone the picture.

Toning Color The color to tone the picture.

Fit to Object Check this item so the picture can change its size automatically to just fit inside the border of the
object’s shape.

Position

© O O - . - .
0O ® O The position of the picture within the object.
C O O
ggiﬁe BG The BG color of the object’s shape for the current state.
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4.3.6. Text Settings

This section describes how to set up the text of the inner label for the following types of objects:

Multi-state Switch, Radio Button Group, Step Button, Page Selector, Multi-state Lamp, Message Display, and
Day-of-week Display.

The property sheets of the above mentioned objects provide you the Text page to set up the text of the inner label. The
following is an example of the Text page.

General

Tewt | Wisibility

Language:

Border Spacing; |0

Uze the text of the first lanquaage far all ather lanquages

il

Attribute

e
b,

[ Copy from state 0

]

Font: |Font 4

Tranzparent

v (-]
Colar: @ [ Bk

SH Text
1] Frinting zcreen. . Please wait
1 Failed to print screesn.
2 Irvvald file name
3 Failed to open file.
4 Failed to delete file
] Failed to rename file
% >
[ Mowe Up ] [Mwe Du:uwn]

-

Position

g
Cc ® O
C O O

Shape BG Color:

Failed to apen file.

You can view the texts and the picture names of all the
states here. You can select a state from the list. The
text of the selected state becomes the current text.

Line Spacing: |0 &

The following table describes each property in the Text page.

Char. Spacing: |0 =

e

3

The current text, i.e. the text of the
current state and language. You
view and edit the current text here.

Property

Description

Language

The language that you are setting the text for.

Border Spacing

The margin (in pixels) to the border of the object’s shape for the text body.

Use the text of the
first language for all
other languages

Check this item so the inner label always shows the text of the first language regardless of
what the current language is.

Move Up Click this button to move the current text (and picture) up in the list and thus the associated
state number of the current text (and picture) is decreased by one.
Move Down Click this button to move the current text (and picture) down in the list and thus the associated
state number of the current text (and picture) is increased by one.
Continued
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Property

Description

Copy to all states...

Click this button to use the text of state 0 to replace the text of all other states.

Copy from state O...

Click this button to use the text of state 0 to replace the current text.

Font The font of the current text. You can use the drop-down list to select a font.
Click [3 to bring up the Font Templates dialog box and select a font for the current text.
You can change the font templates before selecting a font in that dialog box.
Color The color of the current text. To specify the color, click the corresponding Color icon and
select a color from the Color palette.
Blink Check this item so the current text will blink.
Transparent Check this item to make the background of the text transparent.
BG Color The background color of the text.
The alignment of the text.
Position
C O O iy
0O 6 O The position of the text body.
C O O
Shape BG Color The BG color of the object’s shape for the current state.
Line Spacing The distance (in pixels) between two adjacent lines of the text.

Character Spacing

The distance (in pixels) between two adjacent characters of the text.
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4.3.7. Picture Settings
This section describes how to define the picture settings for the following types of objects:
Multi-state Switch, Radio Button Group, Step Button, Page Selector, Multi-state Lamp, Picture Display, and Animated

Graphic.

The property sheets of the above mentioned objects provide you the Picture page to define the picture settings of the
objects. The following is an example of the Picture page.

General | Test

Ficture | Wisibility

SH  Test

MO G

Picture Hame

chd
] chll

chb

You can view the picture names and the texts of all
the states here. ¥ou can select a state from the list.
The picture of the selected state becomes the
current picture.

The following table describes each property in the Picture page.

Border Spacing: (0 | &
Aftribute
Ficture:
chb w
[ ] Tranzparent
Flip/Ratate: |0 hd
[]Tone
[]Fit to Object
Fozition
#0400 4
C ® O
C O O

Shape BG Calor:

Click [Mave Up] to move the current picture {and
text] up in the list and thus the associated state
number of the current picture (and text) is decreased
by one.

Click [Mave Down] to move the current picture (and

text) down in the list and thus the associated state

number of the current picture (and text) is increased
by one.

Property Description

Picture The name of the current picture. You can use the drop-down list to select a picture from the picture
database.
Click =lto select a picture from a file as the current picture. After the selection, PM Designer imports
the picture of the selected file and saves the picture in the picture database.
Click to bring up the Select/Import from Library dialog box. Select a picture from a picture library
file as the current picture. After the selection, PM Designer imports the selected picture from the
selected library and saves the picture in the picture database.

Continued
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Property Description
Transparent Check this item to make parts of the current picture transparent. The transparent parts are pixels
whose colors are identical to the specified transparent color. This item is available when the current
picture is not a black and white picture.
Transparent The transparent color.
Color
FG Color The color to paint the black part of a black and white picture. This item is available when the current
picture is a black and white picture.
BG Color The color to paint the white part of a black and white picture. This item is available when the current
picture is a black and white picture.
Flip/Rotate Specifies the method to flip or rotate the current picture before drawing it. There are 8 options:
Method Description
0° Do nothing
90° Rotates the picture clockwise by 90 degree
180° Rotates the picture clockwise by 180 degree
270° Rotates the picture clockwise by 270 degree
X Flips the picture over X axis
90° & X Rotates the picture clockwise by 90 degree and flips it over X Axis
Y Flips the picture over Y axis
90° &Y Rotates the picture clockwise by 90 degree and flips it over Y Axis
Tone Check this item to tone the current picture.
Toning Color The color to tone the current picture.
Fit to Object Check this item so the current picture can change its size automatically to just fit inside the border of
the object’s shape.
Position The position of the current picture within the object.
C O O
©C ® O
C O O
Shape BG The BG color of the object’s shape for the current state.
Color
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4.3.8. External Label Settings

This section describes how to set up the external label for the following types of objects:

Bit Button, Toggle Switch, Screen Button, Slide Switch, Word Button, Multi-state Switch, Radio Button Group, Step
Button, Numeric Entry, Numeric Display, Advanced Numeric Display, ASCII String Entry, ASCII String Display, Bit
Lamp, Multi-state Lamp, Message Display, Picture Display, and Bar Graph.

You can use the External Label page in an object's property sheet to set up the external label of that object. The following
is an example of the External Label page.

General | Label | Advanced | Visibility | Extermal Label

Plate Style: | Outlined w

Poszition Calar

O Top Border: @ Plate:

(%) Left ) Right
) Bottom Test: @

Language: | Language 1 it :

Font: |Font 1 4 [:]

Text:

Tank #1 [Z]
Temperature

Spacing

Border: (0 3 Lire: |0 & Character: (0 3

The following table describes each property in the External Label page.

Property Description
Plate Style Specifies the plate type of the external label. There are four plate types as shown
below:

Plate Type Example

Transparent, T;:;frfim 9999 ]
Flat, Tenpee | 9999 |
Outlined Tenpeue || 9999 |
Raised Tenpenue || 9999 |
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Continued

Property

Description

Position

Specifies the position of the external label relative to the object. There are four
positions as shown below:

Position Example

Tank #1
Teraperature

=

Top

Tank #1
Lef e || 9999 |

Right 999.9 | i

999.9 J

Tark #
Teruperature

Bottom

Color

Border

The border color of the plate. To specify the color, click the corresponding Color icon
and select a color from the Color palette.

Plate

The color of the plate. To specify the color, click the corresponding Color icon and
select a color from the Color palette.

Text

The color of the text. To specify the color, click the corresponding Color icon and
select a color from the Color palette.

Language

The language that you are setting the text for.

Font

<Drop-down List>

The font of the text for the current language

[J

Click this button to bring up the Font Templates dialog box and select a font for the
text. You can change the font templates before selecting a font in that dialog box.

Text

<Edit Box>

The text for the current language.

]

Click this button to bring up the Text Source dialog box and select a string for the
current text. You can change the text database before selecting a string in that dialog
box.

The alignment of the text.

Spacing

Border The distance (in pixels) between the plate border and the text body.
Line The distance (in pixels) between two adjacent lines of the text.
Character The distance (in pixels) between two adjacent characters of the text.
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4.4. Setting up Objects

4.4.1. States of Objects

When an object has multiple states, its appearance automatically has the same number of states. You need to specify the
settings of the shape and the inner label of an object for each state. Usually the state of an object is determined by the
value of the variable it monitors. An object that monitors a bit has state 0 (off) and state 1 (on). An object that monitors a
word or a double-word can have up to 256 states.

4.4.1.1. State Types

You need to specify the state type for an object so the object knows how to determine its state. The following table
describes each of the four state types.

State Type | For How to decide the state
Bit Bit Variable The state is the value of the variable.
Example:

1)The state of $U1.3 is 0 when $U1.3 is O (off).
2)The state of WX3.fis 1 when WX3.fis 1 (on).

Value Word Variable, The state is the value of the variable. The valid states are from 0 to 255.
Double-word Variable | Example:

1)The state of $U200 is 123 when $U200 is 123.

2)The state of WX20 is 0 when WX20 is 0.

3)The state of $N300 is invalid when $N300 is 999.

LSB Word Variable, The state is the number of the least significant bit of the variable’s value that is 1
Double-word Variable | (on). For a word variable, the valid state are from 0 to 16 and state 16 means all

the bits are 0. For a double-word variable, the valid state are from 0 to 32 and
state 32 means all the bits are 0.

Example:

1)The state of $U200 is 1 when $U200 is 246H.
2)The state of WX20 is 19 when WX20 is 80000H.
3)The state of $N300 is 16 when $N300 is 0.

Custom Word Variable, When you configure an object with the Custom state type, you assign each valid
Double-word Variable | state a unique number which is called a state value. The assigned state values
will be used to determine the state of the object. If the variable’s value is equal to
one of the state values, the corresponding state of that state value is the state of
the object. If the value is equal to none of the state values, the state is invalid.

Example:

An object monitors $U100 and its state type is Custom. There are three valid
states and you assigned 300, 200, and 100 to state 0, 1, and 2 respectively. The
state is 2 when $U100 is 100 and the state is 0 when $U100 is 300.

4-59 CHAPTER4 DESIGNING SCREENS



4‘? - -
PM Designer Operation Manual 4

4.4.1.2. Setting the Custom States of an Object

In the General page of the object's property dialog box, with the Custom state type selected, click the
[ Custorn State Walue. .

] button to bring up the Custom State Value dialog box as the example shown below.

Multistate Switch X Custom State Value X
General | Tewt || Advanced | Visibily | Value [ oK ]
|0 | MS0000 Mote: | | ] 100
1 150
3 290
STl g Test YFTA
Border 4 300
Calar FG Calor: @] c 400
GF 0041 Pattern: BG Caolar:
— B A00
State T Control T
ate Type ontrol Type - £
Oivalue ) LSE () Buttan () Drop-down List
g 200
(& List () Throw-up List
g 1000
Data Type: |1E-BitUnsignedInteger v|
Wiite Address: | $1J300 BE
Tatal States: (9 |5 [ Cuztom State Value... ] >

You can assign a positive integer for each state in that dialog box. To edit the value, click the row of that state on its value
column.

You can use the Move Up button and the Move Down button to adjust the position of state values. To move up or move
down the state values, you need to make a selection first. To select a state, click the header column. To select multiple
rows, click the header column and use Ctrl+Click to add a row to the selection.
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4.4.2. Operation Options of Objects

The following table explains operation options which can be added to an object to make it more informative, secure, and

useful.

Terminology

Definition

Enabling and disabling the
touch operation

The touch operation can be enabled and disabled either by a specified bit or by the
current user level. You can choose to display the touch operation disabled sign on the
button when the touch operation is disabled.

If the touch operation is to be enabled by a bit, you need to specify that bit and the bit
value that enables the touch operation.

If the touch operation is to be enabled by the current user level, you need to specify the
lowest user level that is required to enable the touch operation.

Select and set this feature in the Advanced page of the Bit Button dialog box.

Requiring the minimum hold
time

The touch operation will not be activated until the button is pressed and held down for
the specified Minimum Hold Time.

Select and set this feature in the Advanced page of the Bit Button dialog box.

Requiring the operator
confirmation

A confirmation dialog box displays when the button is activated to about to set a bit.
The button will proceed to set that bit if the operator selects “Yes” to confirm the
operation. The touch operation will be cancelled if the operator selects “No” to reject
the operation or the operator does not respond within the Maximum Waiting Time.

This feature is available for the following operations:
Set ON, Set OFF, Set ON Pulse, Set OFF Pulse, and Invert.

Select and set this feature in the Advanced page of the Bit Button dialog box.

Notifying a bit of the touch
operation

The notification is performed after the touch operation is done. You need to specify the
bit to be notified and the bit value to be used for the notification.

Select and set this feature in the Advanced page of the Bit Button dialog box.

Logging the touch operations

The time and data when the touch operation occurs, the new value that is written to the
bit, and the predefined text can be recorded in the operation log with this feature.

Select and set this feature in the Advanced page of the Bit Button dialog box.

Showing and hiding an object

The visibility of an object can be controlled either by a specified bit or by the current
user level, i.e. an object can be shown and hidden dynamically by any of those two
methods.

If the visibility is to be controlled by a bit, you need to specify that bit and the bit value
that shows the object.

If the visibility is to be controlled by the current user level, you need to specify the
lowest user level that is required to show the visibility.

Note 1: When an object is invisible, the touch operation is automatically disabled.

Note 2: It is allowed to simply set an object invisible. The touch operation is still
enabled with this setting.

Select and set this feature in the Visibility page of the object setting dialog box.
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4.4.3. Address Settings

This chapter describes the terms, rules, and methods to address data.

4.4.3.1. Terminologies for Data Accessing

The following table explains variables, addresses and tags.

Terminology

Definition

Internal memory

The memory space in the target panel that can be accessed by the panel application. For
example, the user memory $U, the non-volatile memory $N, the system memory $S, and
the recipe memory $R are all parts of the internal memory.

Internal variable

An address or a tag referring to an address of a space in the internal memory.

Internal bit variable

An internal variable that refers to a bit in the internal memory.

For easy to read, we usually use “internal variable” instead of “internal bit variable” when
referring to a bit if there is no ambiguity.

Internal word variable

An internal variable that refers to a word in the internal memory.

The variables can also be used to refer to a double-word, a block of bytes (byte array), a
block of words (word array), and a block of double-words (double-word array).

For easy to read, we usually use “internal variable” instead of “internal word variable”
when referring to a word or a block of memory space if there is no ambiguity,

External memory

The memory spaces or the collections of addressable devices in the controllers that can
be accessed by the panel application through communication links.

External variable

An address or a tag referring to an address of a space in the external memory.

External bit variable

An external variable that refers to a bit in the external memory.

For easy to read, we usually use “external variable” instead of “external bit variable” when
referring to a bit if there is no ambiguity.

External word variable

An external variable that refers to a word in the external memory.

The variables can also be used to refer to a double-word, a block of bytes (byte array), a
block of words (word array), and a block of double-words (double-word array) if the access
unit of the associated addresses is word. If the access unit is double-word, you can only
use the variable to refer to a double-word or a block of memory space with a length of a
multiple of 4 (bytes).

For easy to read, we usually use “external variable” instead of “external word variable”
when referring to a word or a block of memory space if there is no ambiguity,

Variable

An internal variable or an external variable.

Bit variable

An internal bit variable or an external bit variable.

Word variable

An internal word variable or an external word variable.

Double-word variable

An internal variable or an external variable that refers to a double-word.

Byte array variable

An internal variable or an external variable that refers to a byte array.

Word array variable

An internal variable or an external variable that refers to a word array.

Double-word array variable

An internal variable or an external variable that refers to a double-word array.

Tag

A name that stands for an address of the internal memory or the external memory. It also
specifies the data type and scan rate of the data in the memory location it refers to.
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4.4.3.2. Address Input Keypad

With the address input keypad, you can enter an address easily. Usually, you click to bring up the address input
keypad as shown below.

Property Description
» Link Click the down arrow and select a link from the drop down list.
l PLC Click the down arrow and select a value between 0 and 255 or
Address | an indirect address between [$I0] and [$I15] as the PLC
Address. If the indirect address is used, the plc address can be
dynamic changed.
Location | Click the down arrow and select an item from the drop down list
" Type as the location type.
— -
Address | Specify the address.
Input
keypad Buttons | Description
sithibrazs Tupud Loyl BX Clears all the texts in the address field.
ink (1 [57-300 MPI Fort] v Deletes all selected texts, if any, or the text
_ character to the left of the cursor in the address
2 w | o DBEwW (12 field
Coflafl1]l2]l3]lCLR " ESC Cancels the address input and escapes the
5 BS X -
@B@ ENT Checks and enters the address if valid.
BREB0EE . . .
Others Click to specify the address. Only available
D @ when the Address field holds the input focus.
ick the help button to see how to specify word or bit devices
2] Click the help button t how t d or bit d
and their addresses for the specified link in the following popup
dialog.
Word Device [Simatic 57-300 (MPI Port)) E|
Word Device  Addresz Range Size Comment
Cn r 0~E5534 Wwhord
DBm.DEDR m: 17255; m 0~BB532; n=4q 32 bitz DBm.DEDN
DBm.DBWN m: 17255; n: 0™65534; n=2q ‘Ward DB DEBWn
DEDn r. 0~EBE3Z; n=4q 32 bitz
DBEWR ne 0~ER534; n=2q Wwiord
IDn r. 0~EBE3Z; n=4q 32 bitz
["AfH r. 0~EB634: n=2q “Whard
DN r; 0~EB53Z; n=4q 32 bitz
[ A r. 0~EB534: n=2q “Whard
[0n r; 0~EB53Z; n=4q 32 bitz
w'n n: 07EB534: n=2q Ward
Tn r 0~E5534 Wwhord
Yhn r. 0~EBE3Z; n=4q 32 bitz
Wik ne 0~ER534; n=2q Wwiord
< >
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4.4.3.3. Selecting Tags

To select a tag, you can click to bring up the Select Tag dialog box as shown below.

Select Tag

Link: | todBus w |

= & ModBus - wWord Device A
= Data
A ContaPezziParz Cancel
ContaPezzivita
StatoCazzoneS

Percentuales All the predefined word or bit tags for the
CadenzaT ranster selected link are listed. To use a tag, you
Praduttivita can double click the tag you want or select a
ttﬂlmpiahtﬂ tag and then click the OK button.

Selettore

TipaCicla

= VizMNrPezaiFile5H
= Caszoni Tag group
=¥ BarCaszoneli

A BarCazzoneSk

A StatoCazzoneli

A StatoCazzoneSk

A Percentualel

A PercentualeSi

= [Jtabd ax0

=@ [JtaMax5x w

B

ik

A 4

DEUUUEUUD

v

Selected tag

A 4

Taog: |Se|ettu:ure |

Address: |4nnau1

A 4

The address for the selected tag

Note: All the listed tags and tag groups are created in the Tags Editor. To create a tag, please see Section 2.3 Working with
Tags.
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4.4.4. Scale Settings
This section describes how to set up the scale for the following types of objects:

Slide Switch, Bar Graph, Circular Bar Graph, and Meter.

The following are examples of scales used in different kinds of objects.

Slide Switch Circular Bar Graph
100 e
Major
Marks ticks =4 2a
B8 i@
Minor Axis Bar Graph
ticks @ 25 S8 75 1@@

Em

You can use the Scale page in an object's property sheet to set up the scale of that object. The following is an example of
the Scale page of the bar Graph.

Generall Scale |F. Marker | B. Marker | Advanced | Yisibility

Scale
Pozition

& Top " Bottom

Color: @

Mumber of Major Ticks: |5 &

MHumber of Sub Divizions:
iz

ki arks
Font (&) GxB (812

[ ] Dynamic Fange

kdinimum: IZI b awirnam:
Total Digits:
Fractional Digits:
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The following table describes each property in the Scale page.

Property Description
Scale Check this item if you want the object to have a scale.
Position Specifies the position of the scale in the object. The position is relative to the part of the

object that displays the monitored variable. There are six positions shown below:

Position Example Position Example
@ 25 5@ 75 1@@ B
Top Emm | | '
B 25 G5B 75 168
166 188
7E 75
Left = Right 4
25 25
& @
4@ £
49 5@
Inner 20 @8 Outer 28 5@
@ 198
@ i@

Color

The color of the scale. To specify the color, click the corresponding Color icon and select a
color from the Color palette.

Number of Major Ticks

The number of major ticks. The minimum you can specify is two.

Number of Sub The number of divisions between two adjacent major ticks. The minimum you can specify is
Divisions one.
Axis Check this item if you want the scale to have an axis.
Marks Marks Check this option if you want the scale to have marks.
Font The font of the marks.
Dynamic Check this option if you want the minimum and maximum of the marks to be controlled by
Range the dynamic range parameter block of the associated object at runtime.
Minimum The minimum of the marks. It is a 32-bit integer.
Maximum The maximum of the marks. It is a 32-bit integer.
Total Digits The total digits to be displayed for the marks.
Fractional The number of fractional digits for the marks. For example, when the Maximum is 5000, the
Digits Total Digits is 4, and the Fractional Digits is 2, the mark for the Maximum will be 50.00.
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4.4.5. Advanced Settings

This section describes how to define the advanced settings for the following types of objects:

Bit Button, Toggle Switch, Screen Button, Function Button, Slide Switch, Word Button, Multi-state Switch, Radio
Button Group, Step Button, Advanced Numeric Display, ASCII String Entry, and Recipe Selector.

You can use the Advanced page in an object's property sheet to define the advanced settings of that object.

The following are examples of the Advanced page for different objects:

For an advanced numeric display.

For a bit button.

General | Flange | Advanced | Wisibity | Output Macro

Touch Operation Control
[[]Enabled by Eit

Enabled by Uzer Lewvel

Lowest Enabling User Level: |5

[¥] Timeout
Timeout Time: | 20 | seconds
Matification
Bit: |$U9.0
O perator Confirnation

b aimnum Waiting Time: |5 »

[] Operation Logging

Show Dizabled Sign

W

Signal (& Level () Pulse
State: () 0OMW (33 OFF

zeconds

General | Label

Touch Dperation Contral
Enabled by Bit

Control Bit: w304

[JEnabled by Uzer Lewvel

Finimum Hold Time: | 3

Operator Confirmation

b axirnurn W aiting Tinne:

[ Matification

Operation Logging

Message: Start pump #3

Advanced | Vigihility

Show Dizabled Sign

Enabling State: &3 OM () OFF

w | zecond(z)

10w | zecond(z)

The following table describes each property in the Advanced page.

Property Description
Touch Enabled by Bit Check this option so the touch operation of the numeric entry will be enabled and
Operation disabled by the specified bit.
Control Control Bit Specifies the bit that enables and disables the touch operation.
Click to enter a bit address. Click to select a bit tag.

Enabling State | Specifies the state (On or Off) that enables the touch operation.

Enabled by Check this item so the touch operation of the numeric entry will be enabled and

User Level disabled by the current user level.

Lowest Specifies the lowest user level that is required to enable the touch operation.

Enabling User

Level

Show Disabled | Check this option so the touch operation disabled sign will be shown on the numeric

Sign entry when the touch operation is disabled.

Continued
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Property Description
Timeout Timeout Check this option so the data entry will be cancelled if the numeric keypad does not
receive any input within the specified time.

Timeout Time | Specifies the maximum time that the numeric keypad will wait to get a new input. If
there is no input within the specified time, the numeric keypad will be closed and the
data entry will be cancelled.

Notification Notification Check this option so the numeric entry will notify the specified bit after it finishes
outputting the entered value to the destination variable.

Signal Select one of the following signal for the notification:

Signal Description
Level Set the specified bit to the specified state.
Pulse Send a positive pulse to the specified bit.

Bit Specifies the bit that receives the notification.

State Specifies the state (On or Off) that is used for the natification.

Operator Operator Check this option if you want the operator to confirm what he/she enters for the

Confirmation

Confirmation

numeric entry. The Confirmation box will be displayed when a value is entered for
the numeric entry. If the operator selects “Yes” in the Confirmation box, the numeric
entry will write the entered value to the specified variable. If the operator selects “No”
or the operator does not respond within the specified time period (Maximum Waiting
Time), the numeric entry will cancel the data entry operation.

Maximum Specifies the maximum time that the numeric entry will wait for the operator's
Waiting Time confirmation. The data entry will be cancelled if the operator does not respond within
this time.
Operation Operation Check this option so the following three items will be recorded in the operation log
Logging Logging when the numeric entry outputs the entered value.
There are three recorded items:
1) The time when the operation is performed
2) The entered value
3) The predefined operation message
Message Enter the operation message of the first language here.

L]

Click this button to bring up the Operation Message dialog box that you can edit the
operation message for all the languages.

Minimum Hold Time

Available when the object is a button or switch. The touch operation of the button will
not be activated until the button is pressed and held down for the specified time
period (Minimum Hold Time).
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4.4.6. Visibility Settings

In the Visibility page of an object's property sheet, you can define how to show and hide that object. You can also modify
the position and size of an object with the Visibility page.

The following are examples of the Visibility page:

The option “Controlled by Bit” is checked The option “Controlled by User Level” is checked
Wizihility Wigibility
[ Irwisible [T Irvisible
Controlled by Eit [ Contralled by Bit
Cortral Bit; |M10.0
Visible State; & OM (O OFF
|:| Controlled by User Level Cantrolled by User Level

Lowest Yisible User Level: |5 %

Dimenzion Dirmenzion
Left: |160 % Width: |31 & Left: |160 & Width: (31 3

Top: (158 & Height: | 34

4

Top: |158 |2 Height: | 34

4

The following table describes each property in the Visibility page.

Property Description
Invisible Check this option so the object will be invisible always.
Note: The touch operation is still enabled with this setting.
Controlled | Controlled by Bit Check this option so the object will be shown and hidden by the specified bit.
by Bit Control Bit Specifies the bit that will show or hide the object.
Click to enter the bit address. Click to enter the bit tag.
Visible State Specifies the state (On or Off) that makes the object visible.
Controlled | Controlled by Check this option so the object will be shown and hidden by the current user level.
by User User Level
Level Lowest Visible Specifies the lowest user level that is required to show the object.
User Level
Dimension | Left Specifies the X coordinate of the object’s upper-left corner on the screen.
Top Specifies the Y coordinate of the object’s upper-left corner on the screen.
Width Specifies the width (in pixels) of the object.
Height Specifies the height (in pixels) of the object.
Click this button to redraw the object with the new settings.
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5.1. Changing Bit State Using Bit Buttons

You can touch a bit button to change the state of the specified bit.

5.1.1. Basic Operations

A bit button can be configured to perform the following operations:

Operation Description
Set ON Sets the specified bit to On when the button is pressed.
Set OFF Sets the specified bit to Off when the button is pressed.

Sets the specified bit to On when the button is pressed and then sets the bit to Off to generate a

SetON Pulse positive pulse with the specified pulse width.

Sets the specified bit to Off when the button is pressed and then sets the bit to On to generate a

Set OFF Pulse negative pulse with the specified pulse width.

Sets the specified bit to On when the button is pressed and sets the bit to Off when the button is
released.

Note: Pressing and releasing a momentary button quickly might generate a pulse that is too short
to be detected by the controller. To avoid this problem, specify a sufficient minimum pulse width for
the operation so the setting of the bit to Off is delayed if necessary to generate a pulse that is
always detectable.

Momentary ON

Sets the specified bit to Off when the button is pressed and sets the bit to On when the button is
Momentary OFF | released.
Note: See the note above.

Invert Inverts the state of the specified bit when the button is pressed.

Note: You can configure a bit button to operate a bit of a word or a bit of a double-word. In these cases, you need to
specify the number of the bit to be operated.
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5.1.2. Operation Options

The following operation options can be selected for a bit button to make it more informative, secure, and useful. You need
to select and set those options in the Bit Button property sheet.

Option

Description

Monitor

The bit button can be configured to monitor a bit. When this option is selected, the state of the
button is controlled by the monitored bit. With the monitored bit, you can control the color and label
of the bit button.

ON Macro, OFF
Macro

An ON Macro is a macro that is run when the associated button is activated to set a bit to 1 (On).
An OFF Macro, on the contrary, is a macro that is run when the associated button is activated to set
a bit to 0 (Off). The following table shows the macros that each bit button operations can support.

Operation ON Macro OFF Macro

Set ON °

Set OFF °

Set ON Pulse .

Set OFF Pulse °
Momentary ON ° °
Momentary OFF ° °
Invert

Select these options in the General Page. Specify and edit the ON macro in the ON Macro page.
Specify and edit the OFF macro in the OFF Macro page.

Note: When an ON macro or OFF macro is specified, the associated bit setting operation is not
performed until the macro is completely executed. So it is important to keep ON and OFF macros
as short as possible in order not to delay the bit setting operation.

Touch Operation
Control

The touch operation can be enabled or disabled either by a specified bit or by the current user level.
Select and set this option in the Advanced page.

Minimum Hold
Time

The touch operation of the button will not be activated until the button is pressed and held down for
the specified time period (Minimum Hold Time). Set this option in the Advanced page.

Operator
Confirmation

This option is available for the following bit button operations:

Set ON, Set OFF, Set ON Pulse, Set OFF Pulse, and Invert.

The Confirmation box will display when the button is touched. If the operator selects “Yes” in the
Confirmation box, the button will proceed to perform its operation. If the operator selects “No” or the
operator does not respond within the specified time period (Maximum Waiting Time), the button will
stop performing its operation.

Select and set this option in the Advanced page.

Notification The button can be configured to notify a bit of the completion of the bit setting operation when the
button is pressed. Select and set this option in the Advanced page.

Operation Each touch operation of the button can be recorded in the operation log. Select and set this option

Logging in the Advanced page.

Invisible The button can be invisible and still touch operable. Select this option in the Visibility page.

Visibility Control

The button can be shown or hidden either by a specified bit or by the current user level. Select and
set this option in the Visibility page.
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5.1.3. Settings

You can complete all the settings of a bit button in the Bit Button property sheet. This sheet contains the following seven
pages. Some of the pages appear only when they are needed.

m General
Described in Section 5.1.4.

m Label
Described in Section 4.3.5.

m Advanced
Described in Section 4.4.5.

m Visibility
Described in Section 4.4.6.

m External Label
Described in Section 4.3.8.

m  On Macro
Described in Section 14.2.6.

] OFF Macro
Described in Section 14.2.6.
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5.1.4. General Settings

This section describes how to define the general settings for the bit buttons in the General page of the Bit Button property
sheet. The following is an example of the General page.

Bit Button X
General | Label | advanced | Visibiity | External Label | OM Macro

10 Mate: |Bit button example

[ Picture Shape External Label

WETA: | Sunken A"
Eg{gﬁr FG Colar: @
Sw_0021 Pattem: BG Color:

Operation
(O 5etON (O SetOFF (O SetOM Pulse () Set OFF Pulse
{(#) Momentary ON () Momentary OFF (O Invert

Address Type: | Bit “

‘Wwiite Address | PN

Minimum Pulze width: [0.05 % | second
kW onikar Monitor Address identical bo Wite Address
tonitor Address:

OM Macra [ OFF Macro

[ (] 4 ][ Cancel H Help

The following table describes each property in the General page.

Property Description
ID The object’s identifier. It is generated when the object is created. The identifier is unique within
the screen where the object is on. The format of the ID’s for the bit buttons is BBnnnn.
Note You can type a note for the bit button.
Shape settings For details about the following properties, see Section 4.3.4 Setting up the Shape of an Object.
Picture Shape, , VFTA, , Border Color, Pattern, FG Color, BG Color
External Label Check this option if you want the bit button to have an external label. Set up the external label in

the External Label page.

Click this button to change the object state to 1 (On) so you can view and set the object
appearance for state 1 (On).

Click this button to change the object state to 0 (Off) so you can view and set the object
appearance for state 0 (Off).

Continued
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Property

Description

Operation

Select the operation for the bit button. There are 7 choices: Set ON, Set OFF, Set ON Pulse,
Set OFF Pulse, Momentary ON, Momentary OFF, and Invert.

For details, see Section 5.1.1 Basic Operations

Write
Address

Address
Type

Specifies the type of variable in the Write Address field. The bit buttons support the following
three variable types:

Variable Type Description

Bit The variable is a bit variable.

Word The variable is a word variable. You need to specify which bit of
the word variable that is to be operated. Specify the bit number

(0~15) in the Bit Number field.

Double-word The variable is a double-word variable. You need to specify which
bit of the double-word variable that is to be operated. Specify the

bit number (0~31) in the Bit Number field.

Write
Address

Specifies the bit variable to be operated when the Address Type is Bit.
Specifies the word variable that contains the bit to be operated when the Address Type is Word.

Specifies the double-word variable that contains the bit to be operated when the Address Type
is Double-word.

Click this icon to bring up the Address Input Keypad and specify the desired address for the
Write Address field.

Click this icon to bring up the Select Tag dialog box and select the desired tag for the Write
Address field.

Bit
Number

Specifies which bit of the variable specified in Write Address field is to be operated.

Minimum Pulse
Width

The minimum width of the pulse that the Momentary ON and Momentary OFF operations must
generate. There are six choices available: 0.05, 0.1, 0.2, 0.3, 0.4, and 0.5 second.

Pulse Width The width of the pulse generated by the Set ON Pulse and Set OFF Pulse operations. There
are six choices available: 0.05, 0.1, 0.2, 0.3, 0.4, and 0.5 second.

Monitor Check this option if you want the bit button to monitor a specified bit and display its state.

Monitor Address Specifies that the Monitor Address is identical to the Write Address. With this item checked, you

identical to Write don't need to specify the Monitor Address again. This item is available when the option Monitor

Address is checked.

Monitor Monitor Specifies the bit variable to be monitored when the Address Type is Bit.

Address | Address

Specifies the word variable that contains the bit to be monitored when the Address Type is
Word.

Specifies the double-word variable that contains the bit to be monitored when the Address Type
is Double-word.

(&0

Click this icon to bring up the Address Input Keypad and specify the desired address for the
Monitor Address field.

Click this icon to bring up the Select Tag dialog box and select the desired tag for the Monitor
Address field.

ON Macro Check this option if you want the button to have an ON macro. Specify and edit the ON macro
in the ON Macro page. This option is available when the bit button operation is Set ON, Set ON
Pulse, Momentary ON, or Momentary OFF.

OFF Macro Check this option if you want the button to have an OFF macro. Specify and edit the OFF
macro in the OFF Macro page. This option is available when the bit button operation is Set
OFF, Set OFF Pulse, Momentary ON, or Momentary OFF.

Key The hard key that is used to operate the bit button. This item is available only when the target
panel has hard keys.
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5.2. Toggling Bit State Using Toggle Switches

You can touch a toggle switch to toggle the state of the specified bit.

The difference between a toggle switch and a bit button performing Invert operation is described below:
1) Atoggle switch performs the toggle operation by writing the inverse state of the monitored bit to the destination bit.
2) A bit button performs the Invert operation by inverting the destination bit directly regardless of the monitored bit.

5.2.1. Settings

You can complete all the settings of a toggle switch in the Toggle Switch property sheet. This sheet contains the following
seven pages. Some of the pages appear only when they are needed.

m General
Described in Section 5.2.2.

m Label
Described in Section 4.3.5.

m Advanced
Described in Section 4.4.5.

m  Visibility
Described in Section 4.4.6.

m External Label
Described in Section 4.3.8.

m  On Macro
Described in Section 14.2.6.

m OFF Macro
Described in Section 14.2.6.
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5.2.2. General Settings

This section describes how to define the general settings for a toggle switch.

Toggle Switch X
General | Label | Advanced | Visibilty | External Label | ON Macio

D Maote:

[ ] Picture Shape Esternal Label

WETA: | Sunken W
State:
oo Fei Coor: (ML)

Sy 0031 Fattern: BG Colar:

Wiite Address: [ $U0.0

b anitar Address identical to write Address

t anitar Address:

OM bacra [ ] OFF Macro

] ] [ Cancel ] [ Help

The above is an example of the General page of the Toggle Switch property sheet.

The following table describes each property in the General page.

Property Description

D The object’s identifier. It is generated when the object is created. The identifier is unique within the
screen where the object is on. The format of the ID’s for toggle switches is TSnnnn.

Note You can type a note for the object.

For details about the following properties, see Section 4.3.4 Setting up the Shape of an Object..
Shape settings -
Picture Shape, , VFTA, LT=YFTA | Border Color, Pattern, FG Color, BG Color

Check this option if you want the object to have an external label. Set up the external label in the
External Label page.

External Label

Continued

5-7 CHAPTERS5 BUTTONS AND SWITCHES




PM Designer Operation Manual

Property

Description

Click this button to change the object state to 1 (On) so you can view and set the
object appearance for state 1 (On).

Click this button to change the object state to 0 (Off) so you can view and set the
object appearance for state 0 (Off).

Write
Address

Write Address

Specifies the bit variable to be operated.

Click this icon to bring up the Address Input Keypad and specify a bit address for the
Write Address field.

Click this icon to bring up the Select Tag dialog box and select a bit tag for the Write
Address field.

Monitor Address identical to

Specifies that the Monitor Address is identical to the Write Address. With this item
checked, you don’t need to specify the Monitor Address again. This item is available

Write Address when the option Monitor is checked.
Monitor Address | Specifies the bit variable to be monitored.
. Click this icon to bring up the Address Input Keypad and specify a bit address for the
Monitor Monitor Address field.
Address
Click this icon to bring up the Select Tag dialog box and select a bit tag for the Monitor
Address field.
Check this option if you want the button to have an ON macro. Specify and edit the
ON Macro .
ON macro in the ON Macro page.
OFEE Macro Check this option if you want the button to have an OFF macro. Specify and edit the
OFF macro in the OFF Macro page.
Key The hard key that is used to operate the object. This item is available only when the

target panel has hard keys.

CHAPTER 5 BUTTONS AND SWITCHES 5-8

5




PM Designer Operation Manual

5.3. Changing Screen Using Screen Buttons

You can touch a screen button to open or close a screen.

5.3.1. Basic Operations

A screen button can be configured to perform one of the following screen switching operations:

Operation

Description

Open Screen

Opens the specified screen.

Previous Screen

Closes the current main screen and opens the previous main screen.

Note: The panel can display many window screens but only one normal screen at a time so a
normal screen is also called a main screen. The panel can remember up to 32 previously
opened main screens.

Close & Open Screen

Closes the window screen where the screen button is on and opens the specified screen.

Close Screen

Closes the window screen where the screen button is on.

5.3.2. Operation Options

The following operation options can be selected for a screen button to make it more informative, secure, and useful. You
need to select and set those options in the Screen Button property sheet.

Options

Description

Change User Level

The button can be configured to change the current user level.

Acknowledge Alarm

The button can be configured to acknowledge the associated alarm of the screen where it is
on. You can configure an alarm to display an (alarm) screen and the associated alarm of a
screen is the alarm that displays the screen.

Indicate Screen

The button can be configured to indicate that the specified screen is opened. The indication is

Already Opened done by exchanging the button’s FG color with its text color.
You can specify a macro that will be run when the screen button is activated to perform its
operation. Select this option in the General page. Specify and edit the macro in the Macro
Macro page.

Note: The screen switching operation will not be performed until the macro is completely
executed. So it is important to keep the macro as short as possible to not delay the operation.

Touch Operation
Control

The touch operation can be enabled or disabled either by a specified bit or by the current user
level. Select and set this option in the Advanced page.

Minimum Hold Time

The touch operation of the button will not be activated until the button is pressed and held
down for the specified time period (Minimum Hold Time). Select and set this option in the
Advanced page.

Notification

The screen button can be configured to notify a bit of the completion of the screen switching
operation. Select and set this option in the Advanced page.

Operation Logging

Each touch operation of the button can be recorded in the operation log. Select and set this
option in the Advanced page.

Invisible

The button can be invisible and still touch operable. Select this option in the Visibility page.

Visibility Control

The button can be shown or hidden either by a specified bit or by the current user level. Select
and set this option in the Visibility page.
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5.3.3. Settings

You can complete all the settings of a screen button in the Screen Button property sheet. This sheet contains the following
six pages. Some of the pages appear only when they are needed.

m General
Described in Section 5.3.4.

m Label
Described in Section 4.3.5.

m Advanced
Described in Section 4.4.5.

m  Visibility
Described in Section 4.4.6.

m External Label
Described in Section 4.3.8.

m Macro
Described in Section 14.2.6.
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5.3.4. General Settings

This section describes how to define the general settings for a screen button.

Screen Button

X

General |La|:|e| Advanced || Yisibility

ID:I:I Nu:ute:l

[ ]Picture Shape [ ] External Label

WETA: | Sunken w

TestWFTA
Caor FG Color: (Il
S 0131 Fattern: BG Color:

Operation
(%) Open Screen ) Previous Screen
(") Cloze and Open Screen () Cloze Screen

Screen: | 3 L | | Screen 3 w

Change User Level

Mew Uszer Level: £

[ ] Acknowledge Alam []Indicate Screen Already Opened
[]Macmo
kenu Screen Pozition: | Screen Left Side w

Activation: () Button Down (3 Button Up

[ ()4 H Cancel H Help

The above is an example of the General page of the Screen Button dialog box.
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The following table describes each property in the General page.

Property Description
The object’s identifier. It is generated when the object is created. The identifier is unique
ID within the screen where the object is on and is unchangeable. The format of the ID’s for
screen buttons is SB####.
Note You can type a note for the object.

For details about the following properties, see Section 4.3.4 Setting up the Shape of an

Shape settings Object. Picture Shape, , VFTA, LT=tYFTA | Border Color, Pattern, FG Color,

BG Color

Check this option if you want the object to have an external label. Set up the external label
in the External Label page.

External Label

Specifies the operation that you want the screen button to perform. There are four choices:
Operation Open Screen, Previous Screen, Close and Open Screen, and Close Screen. For details,
see Section 5.3.1 Basic Operations.

Screen Specifies the screen to be opened.

<Check . _

Box> Check this option if you want the button to change the current user level.
Change
User Level New

User The new user level to replace the current user level.

Level

Check this option if you want the button to acknowledge the associated alarm of the screen

Acknowledge Alarm where the button is on.

Indicate Screen Already Check this option if you want the button to indicate the specified screen is already open.

Opened
Macro Check this option if you want the button to have a macro. Specify and edit the macro in the
Macro page.
Button - S . .
Down Specifies that the touch operation is activated when the button is pushed.
Activation 5
Ut:)tton Specifies that the touch operation is activated when the button is released.
Key The hard key that is used to operate the object. This item is available only when the target panel has
hard keys.

Continued
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Property Description
Menu Select one of the following 6 positions for the specified menu screen to show up. This field will be showed
Screen up only when the specified screen is a menu screen.
Position Position Description
Screen The menu screen slides into the view b !
Left Side horizontally from the left side of the screen. ! : Screen
i I'I.I'Ier’lnu I
Screen The menu screen slides into the view [ [ [ }
Right Side | horizontally from the right side of the screen. Screen :
T Menu i
Button Left | The menu screen appears by the left side of T
Side & the button and slides downward into the E |
Downward | view. Men Bution
Button Left | The menu screen appears by the left side of 1‘
Side & the button and slides upward into the view. |
Upward
Bution
: henm !
Button The menu screen appears by the right side o }
Right Side | of the button and slides downward into the ! !
& view. et
Downward T |
Button The menu screen appears by the right side T
Right Side | of the button and slides upward into the
& Upward view. |
Buiton
: Menu !
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5.4. Performing Built-in Function Using Function Buttons

You can touch a function button to perform the specified built-in function provided by the target panel.

5.4.1. Basic Operations

Category Operation Description
Setting up Increase Increases either the brightness or the contrast of the display depending on the
Panel Brightness/Contrast PM model. Not all PM models support this operation. Check the hardware
manual for details.
Decrease Decreases either the brightness or the contrast of the display depending on
Brightness/Contrast the PM model. Not all PM models support this operation. Check the hardware
manual for details.
Save Saves the setting of either the brightness or the contrast of the display
Brightness/Contrast depending on the PM model. Not all PM models support this operation. Check
the hardware manual for details.
Enter Panel Setup Exits the application and enters the panel setup mode.
Mode
End Transparent Ends the transparent communication.
Communication
Show Real Time Displays the settings of Real Time Clock so you can change the settings.
Clock
Turn Backlight Off Turns off the backlight of the display. To turn on the backlight, touch the
screen. Not all PM models support this operation. Check the hardware manual
for details.
Setting up Log In Displays the password keypad so you can enter a password to change the
Application current user level.
Log Out Changes the current user level to 0.

Show Password
Table

Displays the password table so you can change the passwords. The password
table only lists the passwords whose user level is equal to or less than the
current user level.

Acknowledge Alarm

Acknowledges the associated alarm of the screen that the button is on.

Change Language

Change the current language to the specified language.

Show File Selection
Box

Displays the File Selection box for the specified purpose. The following table
lists the five purposes:

Purpose Description
Open to Open the specified file for reading. The file must exist.
Read (Note)
Openlcreate Open the specified file for reading. A new file is created
to Write when the specified file does not exist. If the specified file

exists, it will be over written. (Note)

Openlcreate Open the specified file for appending data. A new file is
to Append created when the specified file does not exist. (Note)
Delete Delete the specified file.
Rename Rename the specified file.

You can specify the File Extension Name that will limit the File Selection Box
to list only the files of the specified type. The specified extension name can
only have ASCII characters and at most 3 characters.

Note: You need to specify the File /0O Control Block Address which is an
internal variable that receives the result of the file open operation. You can
specify a macro that will be run when the specified file is opened successfully.
It is important to close an opened file by the macro command CLOSE_FILE
when you finish the operation on it, or the file data will be lost.

Continued
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Category Operation Description

Saving Data Save Recipe Data Saves the data of the specified recipe block in a text file. The file can be read

to File (.txt file) by any text editor, Microsoft Excel, and the target panel.
Save Recipe Data Saves the data of the specified recipe block in a file using the PRD format.
(.prd file) The file can be read by the PM RecipeEditor and the target panel.
Save Logged Data Saves the data collected by the specified data logger in a text file. The file
(.txt file) can be read by any text editor, Microsoft Excel, and the target panel.
Save Logged Data Saves the data collected by the specified data logger in an LDF file. The file
(.Idf file) can be read by the target panel only.
Save Alarm History Saves the alarm history in a text file. The file can be read by any text editor,
(.txt file) Microsoft Excel, and the target panel.
Save Alarm Counts Saves the alarm counts in a text file. The file can be read by any text editor,
(.txt file) Microsoft Excel, and the target panel.
Save Operation Saves the operation history in a text file. The file can be read by any text
History (.txt file) editor, Microsoft Excel, and the target panel.
Save Line Chart Data | Saves the data collected by the specified line chart in a text file. The file can
(.txt file) be read by any text editor, Microsoft Excel, and the target panel.
Save Scatter Chart Saves the data collected by the specified scatter chart in a text file. The file
Data (.txt file) can be read by any text editor, Microsoft Excel, and the target panel.
Save Application Saves the application configuration data that was downloaded to the target
Configuration Data panel before in a PLF file. The file can be used by PM Designer.
(.plf file)
Save System and Saves the system programs and the application runtime data in a PRP file.
Application to File The file can be used by PM Designer and compatible PM panels.
(.prp file)

Loading Load Recipe Data Loads the data of the specified recipe block from a text file.

Data from (.txt file)

File

Load Recipe Data
(.prd file)

Loads the data of the specified recipe block from a PRD file.

Load Logged Data
(.1df file)

Loads the data of the specified data logger from a LDF file.

Load Line Chart Data
(.txt file)

Loads the data of the specified line chart from a text file.

Load Scatter Chart
Data (.txt file)

Loads the data of the specified scatter chart from a text file.

Transferring

Write Recipe to

Writes the current recipe, which is determined by the current recipe block and

Data Controller the current recipe number, to the specified controller. The controller and the

destination address are specified in the settings of the recipe block.

Read Recipe from Updates the current recipe, which is determined by the current recipe block

Controller and the current recipe number, by reading a recipe from the specified
controller. The controller and the source address are specified in the settings
of the recipe block.

Save Recipe Data to Saves the data of the specified recipe block to the target panel’s flash ROM.

Flash ROM The option “Need space in flash ROM to save backup” must be selected in
the settings of the recipe block to make this operation available.

Load Recipe Data Loads the data of the specified recipe block from the target panel’s flash

from Flash ROM ROM. The option “Need space in flash ROM to save backup” must be
selected in the settings of the recipe block to make this operation available.

Continued
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Category Operation Description
Printing Print Screen Prints the screen where the button is on. The printed area is specified in the
Screen settings of the screen properties.
Print Screen to File Prints the screen where the button is on to a file with the BMP format of 256
(256-color .bmp) colors. The printed area is specified in the settings of the screen properties.
Print Screen to File Prints the screen where the button is on to a file with the BMP format of 64K
(64K-color .bmp) colors. The printed area is specified in the settings of the screen properties.
Print Screen to File Prints the screen where the button is on to a file with the BMP format. The
(True-color .bmp) color resolution is the same as the target panel’s display. The printed area is
specified in the settings of the screen properties.
Print Screen to File Prints the screen where the button is on to a file with the JPG format. The
(.ipg) printed area is specified in the settings of the screen properties.
Clearing Clear Logged Data Clears the data of the specified data logger.
Data Clear Logged Data Clears the data of all the data loggers.
(Al
Clear Alarm History Clears the alarm history.
Clear Alarm Counts Resets the alarm counts to O.
Clear Operation Clears the operation history.
History
Running Restart Application Restarts the application.
Application Update System and Updates the system programs and the application runtime data from a PRP
Application From File | file. The original system programs and the application runtime data are
(-prp) replaced by the new ones.
Boot from File (.prp) Load-and-runs the system programs and the application runtime data from a
PRP file. The original system programs and runtime data are intact. The
loaded system programs and the runtime data will be lost after power off.
Multimedia Play Sound Plays the specified sound file.
Stop Playing Sound Stops playing the current sound file
Take Picture Takes a picture from the specified USB camera.
Adjusting Zoom In Makes the viewing range of the associated object one half smaller so the
Viewing object shows less content with more detail.
Range Zoom Out Makes the viewing range of the associated object twice larger so the object
shows more content with less detail.
Restore to Normal Restores the viewing range to the original setting.
View
Scrolling Scroll Left Scrolls the content displayed by the associated object to the left.
Content Scroll Right Scrolls the content displayed by the associated object to the right.
Scroll Up Scrolls the content displayed by the associated object to the top.
Scroll Down Scrolls the content displayed by the associated object to the bottom.

Scroll Page Left

Scrolls the content displayed by the associated object to the left by one page.

Scroll Page Right

Scrolls the content displayed by the associated object to the right by one
page.

Scroll Page Up

Scrolls the content displayed by the associated object to the top by one
page.

Scroll Page Down

Scrolls the content displayed by the associated object to the bottom by one
page.

Scroll to Left End

Scrolls the content displayed by the associated object to the left end.

Scroll to Right End

Scrolls the content displayed by the associated object to the right end.

Scroll to Bottom End

Scrolls the content displayed by the associated object to the bottom end.

Scroll to Top End

Scrolls the content displayed by the associated object to the top end.

Continued
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Category Operation Description

Changing Select Next Data Selects the next data entry object on the screen where the button is on.

Data Entry Object
Select Previous Data | Selects the previous data entry object on the screen where the button is on.
Entry Object
Increase Value by Activates the selected data entry object to set its specified variable to the
One value that is obtained by increasing the value of its monitored variable by

one.

The operation is available for multi-state buttons whose property “Activation”
is set to “Indirect”. The operation is available for numeric entries whose
property “Data Entry” is set to “On-screen Keypad and/or Function Keys”.

Decrease Value by Activates the selected data entry object to set its specified variable to the
One value that is obtained by decreasing the value of its monitored variable by
one.

The operation is available for multi-state buttons whose property “Activation”
is set to “Indirect”. The operation is available for numeric entries whose
property “Data Entry” is set to “On-screen Keypad and/or Function Keys”.

5.4.2. Operation Options

The following operation options can be added to a function button to make it more informative, secure, and useful. You
need to select and set these options in the Function Button property sheet.

Options Description

Macro You can specify a macro that will be run when a file is successfully opened. Select this
option in the General page. Specify and edit the macro in the Macro page.

Touch Operation Control | The touch operation can be enabled and disabled either by a specified bit or by the current
user level. Select and set this option in the Advanced page.

Minimum Hold Time The touch operation of the button will not be activated until the button is pressed and held
down for the specified time period (Minimum Hold Time). Set this option in the Advanced
page.

Operator Confirmation The Confirmation box will display when the button is touched. If the operator selects “Yes”

in the Confirmation box, the button will proceed to perform its operation. If the operator
selects “No” or the operator does not respond within the specified time period (Maximum
Waiting Time), the button will stop performing its operation.

Select and set this option in the Advanced page.

Notification The button can be configured to notify a bit when the specified operation is performed
successfully. Select and set this option in the Advanced page.

Operation Logging Each touch operation of the button can be recorded in the operation log. Select and set this
option in the Advanced page.

Invisible The button can be invisible and still touch operable. Select this option in the Visibility page.

Visibility Control The button can be shown or hidden either by a specified bit or by the current user level.

Select and set this option in the Visibility page.
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5.4.3. Settings

You can complete all the settings of a function button in the Function Button property sheet. This sheet contains the
following five pages. Some of the pages appear only when they are needed.

m General
Described in Section 5.4.4.

m Label
Described in Section 4.3.5.

m Advanced
Described in Section 4.4.5.

m  Visibility
Described in Section 4.4.6.

m Macro
Described in Section 14.2.6.
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5.4.4. General Settings

This section describes how to define the general settings for a function button.

Function Button

X

General | |abel | Advanced | Wisibility | b acro
10 Maote:

[] Picture Shape

VFTA: [Surken v
soter [ ro conr (W
i Patterr: BG Color

Operation: | Show File Selection Box v
Purpoze;
Opendcreate to wiite w

File Extenzion Hame:
bt

File [/0 Contral Block Address:

$L1000
b acra

] ][ Cancel ][ Help

The above are an example of the General page of the Function Button dialog box.

The following table describes each property in the General page.

Property Description

ID The object’s identifier. It is generated when the object is created. The identifier is
unique within the screen where the object is on. The format of the ID’s for
function buttons is FBnnnn.

Note You can type a note for the object.

Shape settings For details about the following properties, see Section 4.3.4 Setting up the Shape

of _an Object. Picture Shape, , VFTA, LT=YFTA | Border Color,

Pattern, FG Color, BG Color

Continued
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Property

Description

External Label

Check this option if you want the object to have an external label. Set up the external
label in the External Label page.

Operation Specifies the operation that you want the function button to perform. About the
available operations, see Section 5.4.1 Basic Operation.
ID, Associated The ID of the object associated with the selected operation.
Purpose, Object ID
or Data Logger The ID of the data logger associated with the selected operation.
Language
Line Chart The ID of the line chart associated with the selected operation.
Recipe Block The ID of the recipe block associated with the selected operation.
Scatter Chart The ID of the scatter chart associated with the selected operation.
Purpose The purpose for the Show File Selection Box operation.
Language The language for the Change Language operation.
Sound The ID of the sound for the Play Sound operation.
Camera ID & | The camera ID and the picture file type for the Take Picture operation.
Picture Type
Filename, | Default The default filename for the selected operation. The name can only have ASCII
Extension | Filename characters and at most 80 characters.
nMaeThec;d File Extension | The file extension name for the selected operation. The name can only have ASCII

Name

characters and at most 3 characters.

Method

The method for the Play Sound operation.

Filename Selectable

Check this item so the File Selection box will display for the operator to select a file.
The selected file will be used for the selected operation.

File 1/0 Specifies the internal variable to receive the result of the file open operation. The
Control memory block requires 44 words.
Block A,
Address Word ' Description '
<Edit Box> 0,1 A 32-bit word to store the handle of an opened file
2,3 A 32-bit word to store the size (in byte) of the file
4~43 A byte array to store the filename and the extension name of the opened
file; the maximum length of the filename and the extension name is 80
characters
Click this icon to bring up the Address Input Keypad and specify an internal address
for this property.
. Click this icon to bring up the Select Tag dialog box and select an internal tag for this
property.
Macro Check this option if you want the button to have a macro. Specify and edit the macro in
the Macro page.
Key The hard key that is used to operate the object. This item is available only when the

target panel has hard keys.
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5.5. Selecting Word Value Using Slide Switches

You can touch the knob of a slide switch and move the knob to select a desired value. The selected value is written to the
specified variable when you release the knob.

5.5.1. Basic Operations

Selected Value

Scale

The above are two examples of slide switches. The right one shows a slide switch whose knob is being touched.

You specify the variable to be controlled, the minimum of the variable, and the maximum of the variable for a slide switch.
The variable is monitored and its value combined with the specified minimum and maximum determines the knob position
of the slide switch. You can touch and move the knob to select a desired value. The selected value is shown when the knob
is being held. When you release the knob, the selected value is written to the specified variable.

You can choose one of the following four directions for a slide switch:

Direction Description

Upward The knob can move vertically. The knob is at the top end when the variable value is equal to or greater
than the specified maximum. The knob is at the bottom end when the variable value is equal to or less
than the specified minimum. When the variable value is between the maximum and minimum, the knob is
at a proportional position between the top end and the bottom end.

Downward | The knob can move vertically. The knob is at the bottom end when the variable value is equal to or
greater than the specified maximum. The knob is at the top end when the variable value is equal to or
less than the specified minimum. When the variable value is between the maximum and minimum, the
knob is at a proportional position between the bottom end and the top end.

Leftward The knob can move horizontally. The knob is at the left end when the variable value is equal to or greater
than the specified maximum. The knob is at the right end when the variable value is equal to or less than
the specified minimum. When the variable value is between the maximum and minimum, the knob is at a
proportional position between the left end and the right end.

Rightward | The knob can move horizontally. The knob is at the right end when the variable value is equal to or
greater than the specified maximum. The knob is at the left end when the variable value is equal to or
less than the specified minimum. When the variable value is between the maximum and minimum, the
knob is at a proportional position between the right end and the left end.
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5.5.2. Operation Options

The following operation options can be added to a slide switch to make it more informative, secure, and useful. You need to
select and set these options in the Slide Switch dialog box.

Options Description
Scale The switch can have a scale. Select and set this option in the Scale page.
Touch Operation The touch operation can be enabled and disabled either by a specified bit or by the current
Control user level. Select and set this option in the Advanced page.
Notification The switch can be configured to notify a bit when a change to the specified variable is

performed. Select and set this option in the Advanced page.

Operation Logging Each change to the specified variable can be recorded in the operation log. Select and set
this option in the Advanced page.

Visibility Control The switch can be shown or hidden either by a specified bit or by the current user level.
Select and set this option in the Visibility page.

5.5.3. Settings

You can complete all the settings of a slide switch in the Slide Switch dialog box. This dialog box contains the following five
pages. Some of the pages appear only when they are needed.

m General
Described in Section 5.5.4.

m Scale
Described in Section 4.4.4.

m Advanced
Described in Section 4.4.5.

m  Visibility
Described in Section 4.4.6.

m External Label
Described in Section 4.3.8.
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5.5.4. General Settings

This section describes how to define the general settings for a slide switch.

Slide Switch

x)

General | Scale | Advanced | Visibility

1D: Mate:

[ External Label

Border Color:
BG Color @

GF_00z2

Direction
@ Upward (O Downsard (O Leftward () Rightward

Data Type: 16-Bit Unzigned Integer  w

Wiite Address: (U700

[] Dynamic Fange

Minimurm; |0 Magirmurm: {100

K.nob

Barder Colar: BG Colar:

[ K ][ Cancel ][ Help ]

The above is an example of the General page of the Slide Switch dialog box.

The following table describes each property in the General page.

Property Description
ID The object’s identifier. It is generated when the object is created. The identifier is unique
within the screen where the object is on. The format of the ID’s for slide switches is
SWnnnn.
Note You can type a note for the object.

Shape settings

For details about the following properties, see Section 4.3.4 Setting up the Shape of an

Object. , Border Color, BG Color

External Label

Check this option if you want the object to have an external label. Set up the external
label in the External Label page.

Direction Specifies the direction of the slide switch. For details, see 5.5.1 Basic Operation.
Data Type The data type of the variable to be controlled by the object.

Write Write Address Specifies the variable to be controlled by the object.

Address

Click this icon to bring up the Address Input Keypad and specify an address for this field.

Click this icon to bring up the Select Tag dialog box and select a tag for this field.
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Property Description
Dynamic | Dynamic Range | Check this option so the minimum and the maximum of the variable will be specified at
Range runtime. When this option is selected, the minimum and maximum of the marks for the
scale of the slide switch can be specified at runtime too. The data that specifies the
above two ranges should be set and arranged correctly in a memory block called the
dynamic range parameter block. You need to specify the dynamic range parameter
block for the slide switch in the Dynamic Range Parameter Block field.
Dynamic Range | Specifies the variable that stores the dynamic range parameter block for the slide
Parameter switch when the Dynamic Range is selected.
Block -
Click to enter an address for this field. Click to select a tag for this field.
The following table shows the data arrangement of the parameter block when the data
type is 16-bit and the scale of the slide switch is not dynamic.
Word Parameter
0 The minimum of the variable
1 The maximum of the variable
The following table shows the data arrangement of the parameter block when the data
type is 16-bit and the scale of the slide switch is dynamic.
Word Parameter
0 The minimum of the variable
1 The maximum of the variable
2,3 The minimum of the mark for the scale; 32-bit integer number
4,5 The maximum of the mark for the scale; 32-bit integer number
The following table shows the data arrangement of the parameter block when the data
type is 32-bit and the scale of the slide switch is not dynamic.
Word Parameter
0,1 The minimum of the variable
2,3 The maximum of the variable
The following table shows the data arrangement of the parameter block when the data
type is 32-bit and the scale of the slide switch is dynamic.
Word Parameter
0,1 The minimum of the variable
2,3 The maximum of the variable
4,5 The minimum of the mark for the scale; 32-bit integer number
6,7 The maximum of the mark for the scale; 32-bit integer number
Minimum The minimum of the variable to be controlled.
Maximum The maximum of the variable to be controlled.
Knob Border Color The border color of the knob. To specify the color, click the corresponding Color icon
and select a color from the Color palette.
BG Color The color inside the border. To specify the color, click the corresponding Color icon and
select a color from the Color palette.
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5.6. Setting Word Value Using Word Buttons

You can touch a word button to set a value to the specified variable.
5.6.1. Basic Operations

A word button can be configured to perform one of the following operations:

Operation Description

Set Constant Writes the specified constant to the specified variable.

Enter Value Allows you to enter a value to change the specified variable.

The Numeric Keypad displays when the button is pressed and released. After a value is entered with
the keypad, the buttons checks if the value is within the range of the specified minimum and
maximum. If the value is valid, the button writes the entered value to the specified variable. If the
value is invalid, the operator has to enter another value or quit the operation.

Enter Allows you to enter a value to change the specified variable. The keypad shows the input with a string
Password of asterisk so others can not know the input value.

The Numeric Keypad displays when the button is pressed and released. The keypad shows the
operator input with a string of asterisk so others do not know the input value. After a value is entered
with the keypad, the buttons checks if the value is within the range of the specified minimum and
maximum. If the value is valid, the button writes the entered value to the specified variable. If the
value is invalid, the operator has to enter another value or quit the operation.

Add Increases the specified variable by the specified constant. If the result of the increase is greater than
the specified maximum, the variable is set to the maximum.

Subtract Decreases the specified variable by the specified constant. If the result of the decrease is less than
the specified minimum, the variable is set to the minimum.

5.6.2. Operation Options

The following operation options can be added to a word button to make it more informative, secure, and useful. You need
to select and set these options in the Word Button dialog box.

Options Description
Touch Operation The touch operation can be enabled or disabled either by a specified bit or by the current
Control user level. Select and set this option in the Advanced page.
Minimum Hold Time The touch operation of the button will not be activated until the button is pressed and held
down for the specified time period (Minimum Hold Time). Set this option in the Advanced
page.

Operator Confirmation | The Confirmation box will display when the button is touched. If the operator selects “Yes” in
the Confirmation box, the button will proceed to perform its operation. If the operator selects
“No” or the operator does not respond within the specified time period (Maximum Waiting
Time), the button will stop performing its operation.

Select and set this option in the Advanced page.

Note that this option is not available for the Enter Password operation.

Notification The button can be configured to notify a bit of the completion of the specified operation.
Select and set this option in the Advanced page.

Operation Logging Each touch operation of the button can be recorded in the operation log. Select and set this
option in the Advanced page.

Invisible The button can be invisible and still touch operable. Select this option in the Visibility page.

Visibility Control The button can be shown or hidden either by a specified bit or by the current user level.

Select and set this option in the Visibility page.
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5.6.3. Settings

You can complete all the settings of a word button in the Word Button property sheet. This sheet contains the following five
pages. Some of the pages appear only when they are needed.

m General
Described in Section 5.6.4.

m Label
Described in Section 4.3.5.

m Advanced
Described in Section 4.4.5.

m  Visibility
Described in Section 4.4.6.

m External Label
Described in Section 4.3.8.

5.6.4. General Settings

This section describes how to define the general settings for a word button.

]

Word Button
Gereral | Label || Advanced | Visibiliy
10y Mote:

[]Picture Shape  [] External Label
WETA: | Sunken LT
Eg{gfr FG Colar: @
S 0021 Patterr: BG Colar:

Furniction
() Set Congtant () Enter Value {(*) Enter Pazzword
() Add ) Subtract

Data Type: 32-Bit Unzigned Int | »

wiite Address: | $U800
Minimurm: |0 Maximurn: | 4294957295
Total Digits: (10 & Fractional Digits: |0 3
Activation: (%) Button Up
0k, ] [ Cancel ] [ Help
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The above is an example of the General page of the Word Button property sheet.

The following table describes each property in the General page.

Property Description
ID The object’s identifier. It is generated when the object is created. The identifier is unique
within the screen where the object is on. The format of the ID’s for word buttons is
WBnnnn.
Note You can type a note for the word button.
Shape settings For details about the following properties, see Section 4.3.4 Setting up the Shape of an

Object. Picture Shape, , VFTA, LTetYFTA | Border Color, Pattern, FG

Color, BG Color.

External Label Check this option if you want the word button to have an external label. Set up the
external label in the External Label page.

Operation Specifies the operation that the word button performs. For details, see Section 5.6.1
Basic Operations.

Data Type The data type of the variable to be controlled.

Write Write Address Specifies the variable to be controlled.

Address Click this icon to bring up the Address Input Keypad and specify an address for this
property.

Click this icon to bring up the Select Tag dialog box and select a tag for this property.

Constant The constant for the specified operation.

Minimum The minimum for the specified operation.

Maximum The maximum for the specified operation.

Total Digits The number of digits to be displayed for the Minimum and the Maximum on the numeric
keypad.

Fractional Digits When the Data Type is 32-bit Floating Point, this property specifies the number of
fractional digits to be displayed for the Minimum and the Maximum on the numeric
keypad.

When the Data Type is not 32-bit Floating Point, this property specifies not only the
number of fractional digits to be displayed but also the number of least significant digits
to be displayed as the fractional part. With this feature, an integer can be shown and
entered as a fixed point number. When the Fractional Digits is nonzero, say N, the
entered value will be converted to an integer according to the following formula before
being output.

OutputValue = EnteredValue * (Nth power of 10)

Example:
Display Type Total Fractional | Entered Output
Digits Digits Value Value
32-bit Floating Point 4 2 12.34 12.34
32-bit Floating Point 4 2 123.4 Error!
16-bit Signed | 5 2 123.45 12345
Decimal
16-bit Signed | 5 2 -0.05 -5
Decimal
16-bit Signed | 5 2 3 300
Decimal

Activation | Button Down Select this item so the touch operation will be activated when the button is touched.

Button Up Select this item so the touch operation will be activated when the button is released.

Key The hard key that is used to operate the word button. This item is available when the
target panel has hard keys.
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5.7. Selecting Work Value Using Multi-state Switches

You can use a multi-state switch to change the state of the specified variable.

5.7.1. Basic Operations

A multi-state switch can be configured to perform as one of the following types of controls:

Control Type

Description

Button The multi-state switch is a push button. It changes the state of the specified variable to the next state
when it is touched. Note that the next state is not necessarily the current state plus one.
List The multi-state switch is a list box. It lists the text of all the states of Apnle A
the switch one state per line starting from state 0 as shown in the PP
right example. Banana
Grape
The text of the current state is highlighted. If the desired state is not in Hm]e}-*(lew
the view, you can use the scroll bar attached to the right side of the o :
: : : Kiwi fruit
list box to scroll the text. When you select a desired state by touching
its text, the list box writes the value of the selected state to the Peach
specified variable. Pear
Drop-down The multi-state switch is a drop-down list. It displays the text of the current state and a button with the
List down arrow symbol as shown in the following example.
| Honeydew ||
When the button is touched, the switch list displays a list box beneath itself as shown in the following
example.
| Honeydew ||
Apple A
Banana
Grape
Honeydew
Kiwi fruit
Peach b
The list box lists the text of all states of the switch one state per line starting from state 0. The text of
the current state is highlighted. If the desired state is not in the view, you can use the scroll bar
attached to the right side of the list to scroll the text. When you select a desired state by touching its
text, the switch writes the value of the selected state to the specified variable and closes the list box.
| Watermelon |1|| | Watermelon |:|‘
Honeydew
Kiwi fruit
Peach >
Pear
Star fruit
Watermielon
If you want to cancel the operation when the list box is showing, touch anywhere other than the text in
the list box.
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Control Type Description

Throw-up List | The multi-state switch is a throw-up list. It displays the text of the current state and a button with the
up arrow symbol as shown in the following example.

[Kiwi fruit (4|
When the button is touched, the switch list displays a list box above itself as shown in the following
example.

Kiwi fruit
Peach
| Kiwi fruit [«]
The list box lists the text of all states of the switch one state per line starting from state 0. The text of
the current state is highlighted. If the desired state is not in the view, you can use the scroll bar

attached to the right side of the list to scroll the text. When you select a desired state by touching its
text, the switch writes the value of the selected state to the specified variable and closes the list box.

| Banana E|

If you want to cancel the operation when the list box is showing, touch anywhere other than the text in
the list box.

5.7.2. Operation Options

The following operation options can be added to a multi-state switch to make it more informative, secure, and useful. You
need to select and set these options in the Multi-state Switch dialog box.

Options Description

Touch Operation The touch operation can be enabled and disabled either by a specified bit or by the current

Control user level. Select and set this option in the Advanced page.

Minimum Hold Time The touch operation of the switch will not be activated until the switch is pressed and held
down for the specified time period (Minimum Hold Time). Set this option in the Advanced
page.

Notification The switch can be configured to notify a bit of the completion of the specified operation.
Select and set this option in the Advanced page.

Operation Logging Each data change performed by the switch can be recorded in the operation log. Select and
set this option in the Advanced page.

Invisible The switch can be invisible and still touch operable. Select this option in the Visibility page.

Visibility Control The switch can be shown or hidden either by a specified bit or by the current user level.

Select and set this option in the Visibility page.
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5.7.3. Settings

You can complete all the settings of a multi-state switch in the Multi-state Switch dialog box. This dialog box contains the
following six pages. Some of the pages appear only when they are needed.

m General
Described in Section 5.7.4.

m Text
Described in Section 4.3.6.

m Picture
Described in_Section 4.3.7.

m Advanced
Described in Section 4.4.5.

m  Visibility
Described in Section 4.4.6.

m External Label
Described in Section 4.3.8.
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5.7.4. General Settings

This section describes how to define the general settings for a multi-state switch. The following is an example of the
General page of the Multi-state Switch property sheet.

Multistate Switch
General | Text | Advanced | Visibility

|D: [MS0000 M ate:

YFTA: | Sunken

State Type Contral Type
Civalue  (OLSB () Button () Diop-down List
(%) Custom %) List ) Thiow-up List

Data Type: | 16-Bit Unsigned Integer  +

Wiite Address: | $01900

Tatal States: (9 | Cusztorn State Yalue... l

Monitor Address identizal bo Write Address

3

State: |4 S TestWFTA

Boarder

Colar: FG Color: @]
GF_0041 Pattem: BG Color:

[ ok H Cancel H

The following table describes each property in the General page.

Property Description
ID The object’s identifier. It is generated when the object is created. The identifier is unique within
the screen where the object is on. The format of the ID’s for multi-state switch is MSnnnn.
Note You can type a note for the multi-state switch.

Shape settings

For details about the following properties, see Section 4.3.4 Setting up the Shape of an Object.

Picture Shape, , VFTA, LT=tYFTA | Border Color, Pattern, FG Color, BG Color

External Label

Check this option if you want the multi-state switch to have an external label. Set up the

external label in the External Label page.
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Property Description
State The current state of the multi-state switch that you can view and set the object appearance
for.
State Type The state type of the monitored variable. There are two options: Value and LSB. For details,

see Section 4.4.1.1 State Types

Control Type

Specifies the control type that the multi-state switch will perform as. There are three types
you can choose: Button, List, and Drop-down List, Throw-up List. For details, see Section
5.7.1 Basic Operations

Data Type The data type of the variables specified in this page.
Write Write Specifies the variable to be controlled.
Address Address

Click this icon to bring up the Address Input Keypad and specify an address for this
property.

Click this icon to bring up the Select Tag dialog box and select a tag for this property.

Total States Specifies the number of valid states that the monitored variable has.
Note: The last state is state N-1 when the Total States is N.
Next Specifies the method of calculating the next state for the Button control type.
State +1 The next state is the current state plus one when the current state is not the last state.

(Wrap) When the current state is the last state, the next state is state 0.

-1 (Wrap) | The next state is the current state minus one when the current state is not state 0. When the
current state is state 0, the next state is the last state.

+1/-1 With this method, the switch is either in the increasing mode or in the decreasing mode for

(Retreat) the next state calculation. The switch is in the increasing mode initially.

Assume the total states of the switch is N. When the switch is in the increasing mode, the
next state is the current state plus one if the current state is not the last state, i.e. state N-1.
If the current state is the last state, the switch changes its mode to the decreasing mode
and the next state is the current state minus one, i.e. state N-2. When the switch is in the
decreasing mode, the next state is the current state minus one if the current state is not
state 0. If the current state is state 0, the switch changes its mode to the increasing mode
and the next state is the current state plus one, i.e. state 1.
Activation Specifies how the multi-state switch is activated for the Button control type.

Direct The multi-state switch is activated when the button is touched.

Indirect The multi-state switch is activated when it is selected and a function button on the same
screen with the operation of “Increase Value By One” or “Decrease Value y One” is
touched.

Monitor Address Specifies that the Monitor Address is identical to the Write Address. With this item checked,
identical to Write you don't need to specify the same variable for the Monitor Address field.
Address

Monitor Monitor Specifies the variable to be monitored.

Address Address

Click this icon to bring up the Address Input Keypad and specify an address for the Monitor
Address field.

Click this icon to bring up the Select Tag dialog box and select a tag for the Monitor Address
field.

Key

The hard key that is used to operate the multi-state switch. This item is available when the
target panel has hard keys.
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5.8. Setting Word State Using Radio Button Groups

You can press a button of a radio button group to change the state of the controlled variable.

5.8.1. Basic Operations

A radio button group has as many radio buttons as the number of states it has. Each radio button corresponds to a state.
When a radio button is pressed, the value of that button’s associated state is written to the controlled variable. The state of
a radio button group is determined by the state of the controlled variable. A radio button is highlighted when that button’s
associated state is the current state.

e d OIOL - 1O

Controlled
Variahle

He— 0@

Controlled
Variahle

5.8.2. Operation Options

The following operation options can be added to a radio button group to make it more informative, secure, and useful. You
need to select and set these options in the Radio Button Group dialog box.

Options Description
Touch Operation The touch operation of the radio button group can be enabled and disabled either by a
Control specified bit or by the current user level. Select and set this option in the Advanced page.
Minimum Hold Time The touch operation will not be activated until a button of the radio button group is pressed

and held down for the specified time period (Minimum Hold Time). Set this option in the
Advanced page.

Operation Logging Each data change performed by the radio button group can be recorded in the operation log.
Select and set this option in the Advanced page.

Visibility Control The radio button group can be shown or hidden either by a specified bit or by the current user
level. Select and set this option in the Visibility page.
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5.8.3. Settings

You can complete all the settings of a radio button group in the Radio Button Group dialog box. This dialog box contains
the following six pages. Some of the pages appear only when they are needed.

m General
Described in Section 5.8.4.

m Text
Described in Section 4.3.6.

m Picture
Described in Section 4.3.7.

m Advanced
Described in Section 4.4.5.

m  Visibility
Described in Section 4.4.6.

m External Label
Described in Section 4.3.8.

5.8.4. General Settings

This section describes how to define the general settings for a radio button group. The following is an example of the
General page of the Radio Button Group property sheet.

Radio Button Group g|
General | Text Picture | Advanced | Vizibility
1D Mate:

[] Picture Shape [ External Label

WETA: | Sunken L™
State: |4 3
tor B Color

S 013
State Type State Order
(#1value ) LSB (#1 Left To Right () Right To Left
) Cuztom 3 Top To Bottom ) Bottor To Top
Data Type: [ 16-Bit Unsigred [nt A
wiite Address; |

Total States; |2 :

Current State

BG Color: E Text Color:

Button Spacing: 3 &

QE. ] [ Cancel ] [ Help
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The following table describes each property in the General page.

Property Description
ID The object’s identifier. It is generated when the object is created. The identifier is unique within
the screen where the object is on. The format of the ID’s for radio button groups is RBnnnn.
Note You can type a note for the radio button group.

Shape settings

For details about the following properties, Section 4.3.4 Setting up the Shape of an Object.

Picture Shape, , VFTA, LT=tYFT2 | Border Color, BG Color

External Label

Check this option if you want the radio button group to have an external label. Set up the
external label in the External Label page.

State

Specifies the current state of the radio button group. You can set the appearance of the button
associated with the current state.

Note: Although you can set the appearance for the button of the current state, you can not view
all the changes right away. This is because the button is highlighted with the BG color and the
text color set for the Current State. You can change the current state so the button is shown with
new settings instead of being highlighted.

State Type

The state type of the controlled variable. There are three options: Value, LSB, and Custom. For
details, see Section 4.4.1.1 State Types.

State Order

Specifies how to arrange the radio buttons. There are four kinds of order:

State Order Description

Left To Right The buttons are arranged in a row orderly with the button of state 0 at
the left most position.
Right To Left The buttons are arranged in a row orderly with the button of state O at

the right most position.

Top To Bottom The buttons are arranged in a column orderly with the button of state

0 at the top position.

Bottom To Top The buttons are arranged in a column orderly with the button of state

0 at the bottom position.

Data Type The data type of the variables specified in this page.
Write Write Specifies the variable to be controlled.
Address | Address

Click this icon to bring up the Address Input Keypad and specify an address for this property.

Click this icon to bring up the Select Tag dialog box and select a tag for this property.

Total States

Specifies the number of valid states that the controlled variable has.

The settings to highlight the button of the current state.

The color to replace the shape’s BG color for highlighting.

Current

State BG
Color
Text
Color

The color to replace the text color for highlighting.

Button Spacing

The distance in pixels between two adjacent radio buttons.

Custom State Value

Click this button to define the state value for each state when the State Type is Custom. For
details, see Section 4.4.1.2 Setting the Custom States of an Object.
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5.9. Customizing Keypad Using Keypad Buttons

A keypad button inputs a character to the keypad buffer or issues a command to the keypad buffer when it is pressed. You
can use keypad buttons to create your own keypads.

5.9.1. Operation Options

The following operation options can be added to a keypad button to make it more useful. You need to select and set these
options in the Keypad Button dialog box.

Options Description

Macro The keypad button can have a macro to execute when being pressed. Specify and edit the macro
in the Macro page.

Visibility Control The keypad button can be shown or hidden either by a specified bit or by the current user level.
Select and set this option in the Visibility page.

5.9.2. Settings

You can complete all the settings of a keypad button in the Keypad Button dialog box. This dialog box contains the
following four pages. Some of the pages appear only when they are needed.

m General

Described in Section 5.9.4.
m Label

Described in Section 4.3.5.
m Visibility

Described in Section 4.4.6.
m Macro

Described in Section 14.2.6.
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5.9.3. General Settings

This section describes how to define the general settings for a keypad button. The following is an example of the General
page of the Keypad Button property sheet.

Keypad Button El
General | Label | “isibility
|D: |EBOODI fake:

Ficture Shape

WETA: | Sunken “

FG Color: [E]

(%) Enter Character
Character: |9

() Enter Cormmand

[ tMacio

The following table describes each property in the General page.

Property Description

ID The object’s identifier. It is generated when the object is created. The identifier is unique within the screen
where the object is on. The format of the ID’s for the keypad buttons is KBnnnn.

Note You can type a note for the keypad button group.

Shape For details about the following properties, see Section 4.3.4 Setting up the Shape of an Object.

setings
Picture Shape, , VFTA, LT=t¥FT2& | Border Color, Pattern Color, FG Color, BG Color

Enter Select this item if the button is used to input the specified character to the keypad buffer.

Character

Character | Available when the Enter Character is selected. Specifies the character to be entered in the keypad
buffer.

Enter Select this item if the button is used to issue the specified command to the keypad buffer.

Command

Command | Available when the Enter Command is selected. Specifies the command to be issued to the keypad
buffer. There are four commands available:

Command Description

Enter Completes the data entry and sends the input string to the associated object or the
system.

Escape Cancels the data entry operation.

Clear Clears the keypad buffer.

Backspace | Removes the last character in the keypad buffer.

Key The hard key that is used to operate the keypad button. This item is available only when the target panel
has hard keys.

Macro Check this option if you want the button to have a macro. Specify and edit the macro in the Macro page.
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5.9.4. Creating your own keypads

You can create your own keypads using keypad buttons as the custom keypads for your application. The following is an
example of a custom numeric keypad.

Numeric Keypad [ x] Window Screen with a title bar and a close button

2375.48 | @ keypad Display

T
-9999.99 -. 9999.99
\‘| Allowable input range display

|

S ¢
/ Keypad Buttons

To create your own keypads, please do the follows:
1. Creating a window screen, please see Section 3.9.2 Creating and Opening Screens for details.
2. Creating a Character Display with the following settings to display characters when the keypad button is pressed.

_ o Character Display gl
o o
ID:I:I Mote; | |

[ Extemal Label

Border Color:
BG Calor:

GF_0032

Character Set: |-‘9*5':” [US] “w |
Used for keypad display Display asterizks [*] instead

tonitar Address: | |

Taotal Characters: |8 5

Font: |F0ﬂt_5 v |E] Text Calar; E
Alignment Code Size
Left  (® Center ) Right Bute Wiord
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3. Creating a Character Display with the following settings to display an allowable input range.

)

Character Display

u ] u] u]

g o g General | igibility

Note: ID: Mote:
Monitor Address:  $S230 [ Extemal Label
Total Characters: 24 (or less) Border Coior: |
Font: Any font BG Celor:
Alignment: Any (Center recommended) NO_BDR
Character Set: ASCII code (7 bits) Character Set | ASCI [US] v
Code Size: Byte [ Used for keppad display

Manitar Address: | FEREEN

Total Characters: |20 %

Fort: |Times Mew Roman [3 Text Color: | 4
Alignment Code Size

(iLeft () Center () Right &) Byte [ word

4. Creating keypad buttons to customize the keypad.

Setting up the Custom page of the General Setup dialog box to use the custom keypad instead of the built-in keypad.
Please see Section 3.1.2 Custom Settings for details.
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5.10. Scrolling Object Content Using Scroll Button Groups

You can use buttons of a scroll button group to scroll the content displayed by the associated object.

5.10.1. Basic Operations

A scroll button group with the horizontal button alignment can have the following buttons:

Button Example Description

Scroll To Right End > Scrolls the content displayed by the associated object to the right end.

Scroll Page Right Scrolls the content displayed by the associated object to the right by one page.

Scroll Right > Scrolls the content displayed by the associated object to the right.

Scroll Left < Scrolls the content displayed by the associated object to the left.

Scroll Page Left Scrolls the content displayed by the associated object to the left by one page.

Scroll To Left End » Scrolls the content displayed by the associated object to the left end.

Pause This is a toggle switch. It stops the auto-scrolling of the content displayed by the
| associated object when it is touched. When you touch it again, it resumes the

auto-scrolling operation.

A scroll button group with the vertical button alignment can have the following buttons:

Button Example Description

Scroll To Top End 'y Scrolls the content displayed by the associated object to the top end.

Scroll Page Up Scrolls the content displayed by the associated object to the top by one page.

Scroll Up A Scrolls the content displayed by the associated object to the top.

Scroll Down v Scrolls the content displayed by the associated object to the bottom.

Scroll Page Down Scrolls the content displayed by the associated object to the bottom by one
; page.

Scroll To Bottom . 4 Scrolls the content displayed by the associated object to the bottom end.

End

Pause This is a toggle switch. It stops the auto-scrolling of the content displayed by the
| associated object when it is touched. When you touch it again, it resumes the

auto-scrolling operation.
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5.10.2. Operation Options

The following operation option can be added to a scroll button group. You need to select and set this option in the Scroll
Button Group dialog box.

Options Description

Visibility Control The scroll button group can be shown or hidden either by a specified bit or by the current
user level. Select and set this option in the Visibility page.

5.10.3. Settings

You can complete all the settings of a scroll button group in the Scroll Button Group dialog box. This dialog box contains
the following two pages.

m General
Described in Section 5.10.4.
m  Visibility

Described in Section 4.4.6.
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5.10.4. General Settings

This section describes how to define the general settings for a scroll button group. The following is an example of the
General page of the Scroll Button Group property sheet.

Scroll Buttton Group @]
General | isibility

1D: Mote:

Border Color:

[
BG Color:
(-

Legend Colar:

St_0021

Button Alignment: () Hoizontal () Yertical

Agzociated Object ID: |HTDOO0DO  (w

End buttonz
Fage buttonz
Fausze buttan

Button Spacing: |4 &

[ 0k H Cancel H Help

The following table describes each property in the General page.

Property Description

ID The object’s identifier. It is generated when the object is created. The identifier is unique
within the screen where the object is on. The format of the ID’s for the scroll button
groups is SBNnnnn.

Note You can type a note for the scroll button group.

Shape settings For details about the following properties, Section 4.3.4 Setting up the Shape of an
Object. , Border Color, BG Color

Legend Color The color of the legend for every button of the scroll button group.

Button Horizontal The buttons of the scroll button group are aligned in a row.

Alignment Vertical The buttons of the scroll button group are aligned in a column.

Associated Object ID The ID of the object that you will use the scroll button group to scroll its content. You can

select the associated object from this drop-down list which shows the ID’s of the objects
on the same screen that support the scroll operation.

Start/End buttons Check this item when you want the scroll button group to include the buttons that scroll
the content to the start or to the end.

Scroll Page buttons Check this item when you want the scroll button group to include the buttons that scroll
the content each time by one page.

Pause button Check this item when you want the scroll button group to include the Pause button.

Button Spacing The distance in pixels between two adjacent buttons.

CHAPTER 5 BUTTONS AND SWITCHES 5-44



PM Designer Operation Manual

5.11. Scrolling Object Content Using Scroll Bars

You can use a scroll bar to scroll the content displayed by the associated object. The associated objects include Historic
Data Display, Historic Message Display, Historic Trend Display, Operation Log Display, Alarm Display, Recipe Table, and

Sub-link Table.

5.11.1. Basic Operations

Scroll Page Left
Scroll Left

Slide Bar

Scroll Up

Scroll Page Up

Slide Bar

Scroll Page Right

Scroll Right
Scroll Page Down

Scroll Down

A horizontal scroll bar has the following buttons:

Button Description
Scroll Right Scrolls the content displayed by the associated object to the right.
Scroll Page Right | Scrolls the content displayed by the associated object to the right by one page.
Slide Bar You can push and move the slide bar to scroll the content displayed by the associated object. The

content is scrolled to the same direction as you move the slide bar. The amount of the scrolling is
proportional to the displacement of the slide bar. The position of the slide bar in the scroll bar
indicates the position of the viewable part of the content. The height of the slide bar indicates how
much of the content is viewable.

Scroll Page Left

Scrolls the content displayed by the associated object to the left by one page.

Scroll Left

Scrolls the content displayed by the associated object to the left.

A vertical scroll bar has the following buttons:

Button

Description

Scroll Up

Scrolls the content displayed by the associated object to the top.

Scroll Page Up

Scrolls the content displayed by the associated object to the top by one page.

Slide Bar

You can push and move the slide bar to scroll the content displayed by the associated object. The
content is scrolled to the same direction as you move the slide bar. The amount of the scrolling is
proportional to the displacement of the slide bar. The position of the slide bar in the scroll bar
indicates the position of the viewable part of the content. The width of the slide bar indicates how
much of the content is viewable.

Scroll Page Down

Scrolls the content displayed by the associated object to the bottom by one page.

Scroll Down

Scrolls the content displayed by the associated object to the bottom.
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5.11.2. Operation Options

The following operation option can be added to a scroll bar. You need to select and set this option in the Scroll Bar property
sheet.

Options Description
Visibility Control The scroll bar can be shown or hidden either by a specified bit or by the current user level.
Select and set this option in the Visibility page.

5.11.3. Settings

You can complete all the settings of a scroll bar in the Scroll Bar property sheet. This sheet contains the following two
pages.

m General
Described in Section 5.11.4.
m  Visibility

Described in Section 4.4.6.
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5.11.4. General Settings

This section describes how to define the general settings for a scroll bar. The following is an example of the General page
of the Scroll Bar property sheet.

Scroll Bar E'
General | Visibility
10 M ate:

Type: (%) Horizontal ) Wertical

Agzociated Object (D hd

Bar Color:
Legend Color: @

] 4 ][ Cancel ][ Help

The following table describes each property in the General page.

Property Description

ID The object’s identifier. It is generated when the object is created. The identifier is unique
within the screen where the object is on. The format of the ID’s for the scroll bars is
SBRnnnn.

Note You can type a note for the scroll button group.

Type The type of the scroll bar. There are two types; horizontal and vertical.

Associated Object ID The ID of the object that you will use the scroll bar to scroll its content. You can select
the associated object from this drop-down list which shows the ID’s of the objects on the
same screen that support the scroll operation.

Bar Color The color of the scroll bar.

Legend Color The color of the legend for the buttons of the scroll bar.
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5.12. Stepping Through Word State Using Step Buttons

You can press a step button to writes the value of the button’s next state to the specified variable.
5.12.1. Basic Operations

Unlike most kinds of objects, a step button displays all the states at once with the current state highlighted instead of

displaying just the current state. A step button can let the operators know all the available states and what the next state
will be when they touch it.

State 0
State 1
2] —
Controlled State 3
Variable State 4
State
State 1
3 | — State 2
Controlled
Variable State 4

The state of a step button is determined by the value of the specified variable and the specified state type. When a step
button is pressed, it calculates the value of the next state and writes that value to the specified variable. The next state is

the current state plus one when the current state is not the last state. When the current state is the last state, the next state
is state 0.

5.12.2. Operation Options

The following operation options can be added to a step button to make it more informative, secure, and useful. You need to
select and set these options in the Step Button property sheet.

Options Description

Touch Operation The touch operation of the step button can be enabled and disabled either by a specified bit

Control or by the current user level. Select and set this option in the Advanced page.

Minimum Hold Time The touch operation will not be activated until the step button is pressed and held down for
the specified time period (Minimum Hold Time). Set this option in the Advanced page.

Operation Logging Each data change performed by the step button can be recorded in the operation log. Select
and set this option in the Advanced page.

Visibility Control The step button can be shown or hidden either by a specified bit or by the current user level.
Select and set this option in the Visibility page.
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5.12.3. Settings

You can complete all the settings of a step button in the Step Button property sheet. This sheet contains the following six
pages. Some of the pages appear only when they are needed.

m General
Described in Section 5.12.4.

m Text
Described in Section 4.3.6.

m Picture
Described in Section 4.3.7.

m Advanced
Described in Section 4.4.5.

m  Visibility
Described in Section 4.4.6.

m External Label
Described in Section 4.3.8.

5.12.4. General Settings

This section describes how to define the general settings for a step button. The following is an example of the General
page of the Step Button property sheet.

Step Button §|

General | Text Picture | Advanced | “izibility

1D Mote:
[C] External Label
WETA: | Sunken L
State: |0 S Test WFTA
Border )
Caolor: BG Color:
MO_BDR

State Type State Order

O Walue O LSE &) Left Ta Right ) Right To Left

) Custom {2 Top ToBottam ¢ Bottom Ta Top

Data Type: | 16-Bit Unsigred [nteger L

wwinke Address | EUT0

Total States: i :

Highlight Current State

EG Color: Text Colar: @
Separator Colar: E

k. l [ Cancel ] [ Help ]
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The following table describes each property in the General page.

Property Description
ID The object’s identifier. It is generated when the object is created. The identifier is unique within
the screen where the object is on. The format of the ID’s for the step buttons is STBnnnn.
Note You can type a note for this object.
Shape settings For details about the following properties, Section 4.3.4 Setting up the Shape of an Object.
, VFTA, , Border Color, BG Color
External Label Check this option if you want the object to have an external label. Set up the external label in the

External Label page.

State Select a state as the current state so you can set the BG Color for that state. You can also see
how the step button looks when the selected state is highlighted.
Note: The current state is always highlighted by the settings defined in the Highlight Current

State group, so you can not see the change of the BG color you made for the current state right
away. To see the change, select another state as the current state.

State Type The state type of the step button. The supported types are: Value, LSB, and Custom. For
details, see Section 4.4.1.1 State Types
State Order Specifies how to arrange the states on the step button. There are four kinds of order:
State Order Example
Left To Right
508152 (53|54
Right To Left
51|53 |52 |51|50
Top To Bottom State 0
State 1
State 2
State 3
State 4
Bottom To Top State 4
State 3
State 2
State 1
State 0
Data Type The data type for the variable in the Write Address field. The supported types are: 16-bit

Unsigned Integer, 16-bit BCD, 32-bit Unsigned Integer, and 32-bit BCD.

Continued
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Property Description
Write Write Specifies the variable to be controlled by the step button. This variable will also be monitored
Address | Address to decide the state of the step button.

Click this icon to bring up the Address Input Keypad and specify an address for this property.

Click this icon to bring up the Select Tag dialog box and select a tag for this property.

Total States

Specifies the number of states that the step button can display and process.

Separator Color

The color of the lines that are drawn between two states.

Highlight
Current
State

The settings to highlight the text of the current state.

BG Color | The color to replace the BG color of the current state.
Text The color to replace the text color of the current state.
Color

Custom State

Value...

Click this button to define the state value for each state of the step button when the State Type
is Custom. For details, see Section 4.4.1.2 Setting the Custom States of an Object.
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5.13. Displaying Window Screen as Information Page Using Page Selectors

In a page selector, you can press a tab to view the associated page (window screen).

5.13.1. Basic Operations

You can configure a page selector to contain up to 8 window screens. Each of the specified window screens is a page and
each page has an associated tab. You can specify the text and picture for each tab. At runtime, a page selector shows one
of the specified pages in its viewing area. You can select a desired page to view by pressing the associated tab.

=] [ Page A | PageB | Page C | PageD
“1#2 .'I Gerwsal | Tan | Pictas
Page Ha Scieen ... Screen Name - .
% > A 2 1 Paoes - Viewing Area
~=1#3 : L[z e .
2 4 =| PageC d
- B 5 x| FageD =
=
.| # Specify window screens as the pages
L] 4 ﬂ Run time
|
=] _Page A | PageB | Page C | PageD Page A | PageB | PageC | PageD
.“,J ‘ll
SER m U E
| [ess [
Window screens - # 4 (1 # !
Select Page C by pressing its tab Initial page - Page A

5.13.2. Settings

You can complete all the settings of a page selector in the Page Selector property sheet. This sheet contains the following
three pages.

m General
Described in Section 5.13.3.

m Text
Described in Section 4.3.6.

m Picture
Described in Section 4.3.7.
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5.13.3. General Settings

This section describes how to define the general settings for a page selector. The following is an example of the General
page of the Page Selector property sheet.

Page Selector E]
General | Tewt | Picture

ID: [PS0000 Mate: ||

] Picture Shape

WETA: | Sunken W
Tab: |3 |% Test WFTA
Border

GF 1521 Colar: @] BG Color:

Tab Position

& Top ) Battom 1 Left ) Right

Mumber of Pages: |4 e [ Specify Page...

Highlight Current Tab

BG Color: Text Color: @]

Tab Height: |24 &

Wiewig Srea Size

Width: 335 & Height: 134 &

I (1] 4 H Cancel H Help

The following table describes each property in the General page.

Property Description

ID The object’s identifier. It is generated when the object is created. The identifier is unique
within the screen where the object is on. The format of the ID’s for the page selectors is
PSnnnn.

Note You can type a note for this object.
Shape settings For details about the following properties, Section 4.3.4 Setting up the Shape of an Object.

Picture Shape, , VFTA, LT=YFT& | Border Color, BG Color

Tab Select a tab as the current tab so you can set the BG Color for that tab. You can also see
how the tabs look when the selected tab is highlighted.
Note: The current tab is always highlighted by the settings defined in the Highlight Current

Tab group, so you can not see the change of the BG color you made for the current tab
right away. To see the change, select another tab as the current tab.

Continued
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Property Description
Tab Position You can select Top/Bottom/Left/Right for the location of tab.
Number of Pages Specifies the number of window screens this page selector contains.
Specify Page... Click this button to open the Specify Page dialog box. You can specify the window screen
for each page in this dialog box.
Highlight The settings to highlight the text of the current tab.
_(?:t;rent BG Color | The color to replace the BG color of the current tab.
Text Color | The color to replace the text color of the current tab.
Tab Height The height of each tab.
Viewing Specifies the size of the viewing area.
Area Size Note: None of the specified window screens can be larger than the viewing area.
Width The width of the viewing area.
Height The height of the viewing area.
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6.1 Displaying Bit State Using Bit Lamps

6.1.1. Basic Operations
You can use a hit to control the appearance of a bit lamp.

A bit lamp has two states, i.e. state 0 (Off) and state 1 (On). You can set the appearance of a bit lamp for each of the two
states. At runtime, a bit lamp displays with the appearance settings corresponding to the state of the monitored bit.

The monitored hit The hit lamp

6.1.2. Operation Options

The following operation option can be added to a bit lamp. You need to select and set this option in the Bit Lamp property
sheet.

Options Description

Visibility Control The object can be shown or hidden either by a specified bit or by the current user level. Select
and set this option in the Visibility page.

6.1.3. Settings

You can complete all the settings of a bit lamp in the Bit Lamp property sheet. This sheet contains the following four pages.
Some of the pages appear only when they are needed.

m General
Described in Section 6.1.4.

m Label
Described in Section 4.3.5.
m Visibility

Described in Section 4.4.6.

m External Label
Described in Section 4.3.8.
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6.1.4. General Settings

This section describes how to define the general settings for a bit lamp.

Bit Lamp

x)

General | Label | Wisibility

D: [BLOOOD | Nete: | |
[ Picture Shape  [] Exterial Label
State:

Coor. PG Cobor [HLa)
GF_0042 Patterm: B Color: ([

Addrezz Type: | Double-word A |

Monitor Address: | |

Bit Murber: |12 %

] l [ Cancel ] [ Help

The above is an example of the General page of the Bit Lamp dialog box.

The following table describes each property in the General page.

Property Description
ID The object’s identifier. It is generated when the object is created. The identifier is unique
within the screen where the object is on. The format of the ID’s for the bit lamps is BLnnnn.
Note You can type a note for the object.
Shape settings For details about the following properties, see Section 4.3.4 Setting up the Shape of an

Object. Picture Shape, W, Border Color, Pattern, FG Color, BG Color

External Label Check this option if you want the bit lamp to have an external label. Set up the external
label in the External Label page.

Continued
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Property Description
Click this button to change the object state to 1 (On) so you can view and set the object
appearance for state 1 (On).
Click this button to change the object state to 0 (Off) so you can view and set the object
appearance for state 0 (Off).
Monitor Address Specifies the type of variable in the Monitor Address field. The bit lamps support the
Address Type following three variable types:
Variable Type Description
Bit The variable is a bit variable.
Word The variable is a word variable. You need to specify which bit of
the word variable that is to be monitored. Specify the bit number
(0~15) in the Bit Number field.
Double-word The variable is a double-word variable. You need to specify
which bit of the double-word variable that is to be monitored.
Specify the bit number (0~31) in the Bit Number field.
Monitor Specifies the bit variable to be monitored when the Address Type is Bit.
Address Specifies the word variable that contains the bit to be monitored when the Address Type
is Word.
Specifies the double-word variable that contains the bit to be monitored when the Address
Type is Double-word.
Click this icon to bring up the Address Input Keypad and specify the desired address for
the Monitor Address field.
Click this icon to bring up the Select Tag dialog box and select the desired tag for the
Monitor Address field.
Bit Number Specifies which bit of the variable specified in the Monitor Address field is to be
monitored.
6-3 CHAPTER6 LAMPS
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6.2. Displaying Word State Using Multi-state Lamps

6.2.1. Basic Operations
You can use a variable to control the appearance of a multi-state lamp.
A multi-state lamp can have up to 256 states. The maximum number of states that a multi-state lamp can have is

determined by the state type and the data type of the monitored variable. The following table shows the maximum in each
case.

16-bit Variable 32-bit variable
State | Bit 2 2
Type | vale | 256 256
LSB 16 33

You need to specify the number of states for a multi-state lamp and the number must not exceed the allowed maximum.
You can set the appearance of a multi-state lamp for each of its states. At runtime, a multi-state lamp displays with the
appearance settings corresponding to the state of the monitored variable. The state of the monitored variable is
determined by the state type and value of the variable.

State Type = Value State Type = L5B
1 » | S0 LI P | SO
| = ! N
[ [ b 51 2| e 4 51
| N l 2
2 | b 57 4 | e 4 52

w |4—
:
o |4—
-

Monitored Multistate Monitored Multistate
word |amp word |amp

6.2.2. Operation Options

The following operation option can be added to a multi-state lamp. You need to select and set this option in the Multi-state
Lamp property sheet.

Options Description
Visibility Control The object can be shown or hidden either by a specified bit or by the current user level.
Select and set this option in the Visibility page.
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6.2.3. Settings

You can complete all the settings of a multi-state lamp in the Multi-state Lamp property sheet. This dialog box contains the
following five pages. Some of the pages appear only when they are needed.

m General
Described in_Section 6.2.4.

m Text
Described in Section 4.3.6.

m Picture
Described in Section 4.3.7.
m Visibility

Described in Section 4.4.6.

m External Label
Described in Section 4.3.8.
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6.2.4. General Settings

This section describes how to define the general settings for a multi-state lamp. The following is an example of the General
page of the Multi-state Lamp property sheet.

Multistate Lamp EJ
General | Tewt | Picture | Wisibility
IC: ote:
[ Picture Shape ] External Label
State: s
R PG Coor: (L)
GF 0042 Patterr: BG Color:

Data Type: | 16-Bit Unsigned Int w
tanitar ddress: | $u201
Total States: |4 ES Sl UspE
() Walue
® LS8
[ ak. ] [ Cancel ] [ Help

The following table describes each property in the General page.

Property Description
ID The object’s identifier. It is generated when the object is created. The identifier is unique
within the screen where the object is on. The format of the ID’s for the multi-state lamps is
MLnnnn.
Note You can type a note for the object.

Shape settings

For details about the following properties, see Section 4.3.4 Setting up the Shape of an

Object, Picture Shape, % Border Color, Pattern, FG Color, BG Color

External Label

Check this option if you want the multi-state lamp to have an external label. Set up the
external label in the External Label page.

State Select a state as the current state of the multi-state lamp so you can view and set the
object appearance for that state.
Data Type The data type of the monitored variable. The supported data types include: 16-bit Unsigned

Integer, 16-bit BCD, 32-bit Unsigned Integer, and 32-bit BCD.

Monitor Monitor
Address | Address

Specifies the variable to be monitored.

Click this icon to bring up the Address Input Keypad and specify an address for the Monitor
Address field.

Click this icon to bring up the Select Tag dialog box and select a tag for the Monitor
Address field.

Total States

Specifies the number of states that the multi-state lamp can display.

State Type

The state type to decide the state of the monitored variable. The supported state types
include Value and LSB. For details, see Section 4.4.1.1 State Types
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6.3. Displaying Text Information Using Message Displays

6.3.1. Basic Operations
You can use a variable to select and display a predefined message with a message display.

A message display can have up to 256 states. Each state can have a predefined message. The maximum number of
states that a message display can have is determined by the state type and the data type of the monitored variable. The
following table shows the maximum in each case.

Type of Variable Maximum
State | Bit Bit 2
TypPe [value | 16-bit 256
32-bit 256
LSB 16-bit 17
32-bit 33

You need to specify the number of states for a message display and the number must not exceed the allowed maximum.
You can set the text (message) for each state. At runtime, a message display shows the message corresponding to the
state of the monitored variable. The state of the monitored variable is determined by the state type and value of the
variable.

Note: The differences between Message Display and Lamps are:

The lamps can display either text or picture or both of them, but message display can only display text. Both of the
message display and lamps can display predefined text by changing the value of the monitored variable. But only the
message display can perform as a marquee controlled by the value of the monitored variable and the specified running
speed.

6.3.2. Operation Options

The following operation option can be added to a message display. You need to select and set this option in the Message
Display dialog box.

Options Description

Marquee The displayed message scrolls automatically in the specified direction. When the displayed
message is not long enough to cover the whole display area, the message is duplicated to fill
the uncovered area in sequence.

Scrolling
Marquee
rquee Leftward Scrolling Marquee Leftwar
Upward
Scrolling
MAarninn
Visibility Control The object can be shown or hidden either by a specified bit or by the current user level. Select

and set this option in the Visibility page.
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6.3.3. Settings

You can complete all the settings of a message display in the Message Display dialog box. This dialog box contains the
following four pages. Some of the pages appear only when they are needed.

m General
Described in Section 7.9.4.

m Text
Described in Section 4.3.6.

m Visibility
Described in Section 4.4.6.

m External Label
Described in Section 4.3.8.

6.3.4. General Settings
This section describes how to define the general settings for a message display. The following is an example of the
General page of the Message Display property sheet.

Message Display ﬁl

Gereral | Test || wisibility

ID: Note

] Extemal Label
Border Color
State: no
Patterr:
FG Color

GF_0041 BG Color:

State Type

) Bit ) Value ) LSE

Data Type: | 16-Bit Unzigned Integer  »

Monitor Address: | $U0

Total States: |5 =

w
[Marquee G [¥] Marquee Running Speed: | 3 w |
Direction

(3 Leftveard ) Rightweard (&) Upward

[ Test can be scrolled by the vertical seroll bar or button

0k, H Cancel ][ Help
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The following table describes each property in the General page.

Property Description
ID The object’s identifier. It is generated when the object is created. The identifier is
unigue within the screen where the object is on. The format of the ID’s for the
message displays is MDnnnn.
Note You can type a note for the object.

Shape settings

For details about the following properties, Section 4.3.4 Setting up the Shape of an
Object. , Border Color, Pattern, FG Color, BG Color

External Label

Check this option if you want the message display to have an external label. Set
up the external label in the External Label page.

State Select a state as the current state of the message display so you can view and set
the Pattern, FG Color, BG Color for that state.

State Type The state type of the variable that controls the message display. The supported
state types include Bit, Value and LSB. For details, see Section 4.4.1.1 State
Types

Data Type The data type of the variable that controls the message display. The supported

data types include: Bit, 16-bit Unsigned Integer, 16-bit BCD, 32-bit Unsigned
Integer, and 32-bit BCD.

Monitor Address

Specifies the variable that controls the message display.

Click to enter an address for this field. Click to select a tag for this field.

Total States

Specifies the number of states of the message display.

Marguee Marquee

Select this item if you want the displayed message scrolls automatically.

Running Speed

The speed of scrolling. Select from 1 to 10; The speed of | is the slowest and the
speed of 10 is the fastest.

Direction

The direction of scrolling. The supported directions include Leftward, Rightward,
and Upward.

Text can be scrolled by the
vertical scroll bar or button

Select this option so you can scroll the content of the message display vertically
using the associated scroll buttons or scroll bar.

B c-rrere  Laves
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7.1. Numeric Entries

You can enter a value and change the specified variable using a numeric entry.

7.1.1. Operation Options

The following operation options can be added to a numeric entry. Select and set up the options in the Numeric Entry

property sheet.
Options Description

Scaling The value of the monitored variable will be displayed in a scaled manner. The following is the
scaling formula.

DisplayedValue = MonitoredValue * Gain + Offset

If the option is selected, the entered value will be scaled by the following formula with the
same coefficients (Gain and Offset) before it is output.

OutputValue = (EnteredValue — Offset) / Gain

Select and set this option in the Advanced page.

Note: The Gain and Offset are 32-bit floating point numbers. They have at most 6 significant
digits. The rounding and truncation errors may happen.

Range Check The numeric entry will verify the entered value according to the specified maximum and
minimum. If the entered value is not within the allowable range, the value will not be output.
Select and set this option in the Advanced page.

Note 1: When the scaling option is selected, the output value instead of the entered value is
verified.

OutputValue = (EnteredValue — Offset) / Gain

Note 2: When the scaling option is selected, the allowable maximum and minimum shown on
the numeric keypad are the scaled version of the specified maximum and minimum.
ScaledMaximum = Maximum * Gain + Offset

ScaledMinimum = Minimum * Gain + Offset

Touch Operation You can enable or disable the touch operation of the object by the specified bit or by the

Control current user level. Select and set up this option in the Advanced page.

Timeout If the keypad for the data entry receives no input for the specified time period, the data entry
operation will be cancelled.

Notification The Object will notify the specified bit of a successful data entry operation. Select and set up
this option in the Advanced page.

Operator Confirmation | When a value is entered by the operator, the Confirmation box will display for the operator
confirmation. If the operator selects “Yes”, the object will write the entered data to the
specified variable. If the operator selects “No” or the operator does not respond within the
specified time period (Maximum Waiting Time), the data entry operation will be cancelled.
Select and set up this option in the Advanced page.

Operation Logging The entered value and the time of the data entry will be recorded. Select and set up this
option in the Advanced page.

Visibility Control You can show or hide the object by the specified bit or by the current user level. Select and
set up this option in the Visibility page.
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7.1.2. Settings

You can complete all the settings of a numeric entry in the Numeric Entry property sheet. This sheet contains the following
four pages. Some of the pages appear only when they are needed.

m General
Described in Section 7.1.3.

m Advanced
Described in Section 7.1.4.

m Visibility
Described in Section 4.4.6.

m External Label
Described in Section 4.3.8.

7.1.3. General Settings

This section describes how to define the general settings for a numeric entry. The following is an example of the General
page of the Numeric Entry property sheet.

a [m]

Mumeric Entry
o 999999
J General | Advanced | Vigibility
10 Maote:
[] Transparent B ackground
[]External Label
Border Caolor:
DE_00z1 BG Color
Drata Type: 32-Bit Unsigned Integer w
Dizsplay Type: 32-Bit Unzsigned Decimal W
Wiite Address: |waD
[ ] Monitor address identical to wite address
Monitor Address: w100
Fort: |Font 3 A [:] Text Color: @
Total Digits: |6 5 Fractional Digits: |4 | &
Aligrment Justification Drata Entry
) Left (%) Zero Suppress (%) Pop-up Keypad
(%) Center () Leading Zeros On-zcreen Keypad
{1 and/or Function
3 Right () Leading Spaces Eeys
k. l [ Cancel ] [ Help ]
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The following table describes each property in the General page.

Property Description
ID The object’s identifier. It is generated when the object is created. The identifier is unique within the
screen where the object is on. The format of the ID’s for the numeric entries is NEnnnn.
Note You can type a note for the object.
Transparent Select this option if you want the object to have a transparent background.
Background
Shape For details about the following properties, see Section 4.3.4 Setting up the Shape of an Object.
settings
¢ , Border Color, BG Color.
External Check this option if you want the object to have an external label. Set up the external label in the
Label External Label page.
Data Type The data type of the destination variable and the monitored variable. The supported data types
include: 16-Bit Unsigned Integer, 32-Bit Unsigned Integer, 16-Bit Signed Integer, 32-Bit Signed
Integer, 16-Bit BCD, 32-Bit BCD, 32-Bit Floating Point, 16-Bit Signed BCD (LMB), 32-Bit Signed BCD
(LMB), 16-Bit Signed BCD (LMD), and 32-Bit Signed BCD (LMD).
Display Type The display type for the value of the monitored variable. The following table shows the available
display types for each data type.
Data Type Available Display Types
16-Bit Unsigned Integer 16-Bit Unsigned Decimal, 16-Bit Hexadecimal, 16-Bit Octal
32-Bit Unsigned Integer 32-Bit Unsigned Decimal, 32-Bit Hexadecimal, 32-Bit Octal,
Password
16-Bit Signed Integer 16-Bit Signed Decimal
32-Bit Signed Integer 32-Bit Signed Decimal
16-Bit BCD 16-Bit Unsigned Decimal
32-Bit BCD 32-Bit Unsigned Decimal
32-Bit Floating Point 32-Bit Floating Point
16-Bit Signed BCD (LMB) 16-Bit Signed Decimal
32-Bit Signed BCD (LMB) 32-Bit Signed Decimal
16-Bit Signed BCD (LMD) 16-Bit Signed Decimal
32-Bit Signed BCD (LMD) 32-Bit Signed Decimal
Write Address | Specifies the destination variable where the entered value will be written to.
Click to enter an address for this field. Click to select a tag for this field.
Monitor Specifies that the monitored variable is the same as the destination variable. With this item checked,
Address you don't need to specify the monitored variable in the Monitor Address field.
identical to
Write Address
Monitor Specifies the monitored variable.
Address :
Click to enter an address for this field. Click to select a tag for this field.
Font The font of the displayed value.
Text Color The color of the displayed value.
Total Digits The number of digits to be displayed.
Note: This property applies to the display of the initial value, the allowable minimum, and the
allowable maximum on the numeric keypad.
Continued
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Property Description
Fractional When the Display Type is 32-bit Floating Point, this property specifies the number of fractional digits
Digits to be displayed.

When the Display Type is not 32-bit Floating Point, this property specifies not only the number of
fractional digits to be displayed but also the number of least significant digits to be displayed as the
fractional part. With this feature, an integer can be shown and entered as a fixed point number. When
the Fractional Digits is nonzero, say N, the entered value will be converted to an integer according to
the following formula before being output.

OutputValue = EnteredValue * (Nth power of 10)

Example 1:

Display Type J:;tﬁls FraD(i:;ii(:;\al Justification Mc:;\ailt:;ed Dizgllz)éed
32-bit Floating Point 4 2 Zero Suppress 12.34 12.34
32-bit Floating Point 4 2 Zero Suppress 123.4 23.40
16-bit Signed Decimal | 5 2 Zero Suppress 12345 123.45
16-bit Signed Decimal | 5 2 Zero Suppress | -5 -0.05

Example 2:
Display Type I;’_cot_al Frat_:ti_onal Entered Output
igits Digits Value Value

32-bit Floating Point 4 2 12.34 12.34
32-bit Floating Point 4 2 123.4 Error!
16-bit Signed Decimal 5 2 123.45 12345
16-bit Signed Decimal 5 2 -0.05 -5
16-bit Signed Decimal 5 2 3 300

Note: This property applies to the display of the initial value, the allowable minimum, and the
allowable maximum on the numeric keypad.

Alignment The alignment of the displayed value. There are three types of alignment: Left, Center, and Right.
Justification The justification of the displayed value. There are three types of justification:
Option Description
Zero Suppress The leading digits will not display when they are 0.
Leading Zeros All digits will display.
Leading Spaces The leading digits will display as blank character when they are 0.
Data Entry Specifies how to enter a value for the numeric entry at runtime. There are two options:
Option Description
Pop-up Keypad You can bring up the keypad by pressing the numeric entry and enter
a value with the keypad.
On-screen Keypad You can move the cursor by using the function buttons with the
and/or Function Keys | operation of Select Next Data Entry Object or Select Previous Data
Entry Object to select the numeric entry. If there is an on-screen
keypad you can enter a value for the numeric entry right away. You
can also use the function buttons with the operation of Increase Value
By One or Decrease Value By One to change the value of the
destination variable.

Note: When On-screen Keypad and/or Function Keys option is selected, you can only enter a value for
the numeric entry with the input focus. To set the input focus on the corresponding object, you need to
click the object first.
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7.1.4. Advanced Settings for Numeric Entries

This section describes how to define the advanced settings for the numeric entries. The following is an example of the
Advanced page of the Numeric Entry property sheet.

General | Advanced | \isibilib

Scaling R ange Check,
Gain:  |1.08 [ ] ariable Fange
QOffzet: [0 bim: 1000

b | 2600

Touch Operation Control
Enabled by Bit Show Dizabled Sign

Control Bit: w74

Enabling State: (&) ON () OFF
[ ]Enabled by User Level

Timeout

Timeout Time: |20 | seconds

[¢] Natification Signal: &) Level () Pulse
Bit. |wa.0 State: (3)ON () OFF

Operator Confirmation

b awirnum Yfaiting Time: |5 | zeconds

Operation Logging

Meszage: | Tank #1 High lirmit [:

The following table describes each property in the Advanced page.

Property Description
Scaling Scaling Check this option if you want the value of the monitored variable to be displayed in a
scaled manner. The following is the scaling formula.
DisplayedValue = MonitoredValue * Gain + Offset
If this option is selected, the entered value will be scaled by the following formula with
the same coefficients (Gain and Offset) before it is output.
OutputValue = (EnteredValue — Offset) / Gain
Note: The Gain and Offset are 32-bit floating point numbers. They have at most 6
significant digits. The rounding and truncation errors may happen.
Gain The Gain of the scaling formulas.
Offset The Offset of the scaling formulas.
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Property Description
Range Range Check this option if you want the numeric entry to verify the entered value according to
Check Check the specified minimum and maximum. If the entered value is not within the allowable
range, the entered value will not be output.
Note 1: When the scaling option is selected, the output value instead of the entered
value is verified.
OutputValue = (EnteredValue — Offset) / Gain
Note 2: When the scaling option is selected, the allowable maximum and minimum
shown on the keypad are the scaled version of the specified maximum and minimum.
ScaledMaximum = Maximum * Gain + Offset
ScaledMinimum = Minimum * Gain + Offset
Variable Check this option if the minimum and maximum are specified by the designated
Range variables at runtime.
Min. Specifies the minimum when the Variable Range is not selected.
When the Variable Range is selected, this property specifies the variable that stores the
minimum at runtime. Click to enter an address. Click to select a tag.
Max. Specifies the maximum when the Variable Range is not selected.
When the Variable Range is selected, this property specifies the variable that stores the
maximum at runtime. Click to enter an address. Click to select a tag.
Touch Enabled by | Check this option so the touch operation of the numeric entry will be enabled and
Operation Bit disabled by the specified bit.
Control Control Bit Specifies the bit that enables and disables the touch operation.
Click to enter a bit address. Click to select a bit tag.
Enabling Specifies the state (On or Off) that enables the touch operation.
State
Enabled by | Check this item so the touch operation of the numeric entry will be enabled and
User Level disabled by the current user level.
Lowest Specifies the lowest user level that is required to enable the touch operation.
Enabling
User Leve
Show Check this option so the touch operation disabled sign will be shown on the numeric
Disabled entry when the touch operation is disabled.
Sign
Timeout Timeout Check this option so the data entry will be cancelled if the numeric keypad does not
receive any input within the specified time.
Timeout Specifies the maximum time that the numeric keypad will wait to get a new input. If
Time there is no input within the specified time, the numeric keypad will be closed and the
data entry will be cancelled.
Notification Notification Check this option so the numeric entry will notify the specified bit after it finishes
outputting the entered value to the destination variable.
Signal Select one of the following signal for the notification
Signal Description
Level Set the specified bit to the specified state.
Pulse Send a positive pulse to the specified bit.
Bit Specifies the bit that receives the notification.
State Specifies the state (On or Off) that is used for the notification.

Continued
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Property

Description

Operator
Confirmation

Operator
Confirmation

Check this option if you want the operator to confirm what he/she enters for the
numeric entry. The Confirmation box will be displayed when a value is entered for the
numeric entry. If the operator selects “Yes” in the Confirmation box, the numeric entry
will write the entered value to the specified variable. If the operator selects “No” or the
operator does not respond within the specified time period (Maximum Waiting Time),
the numeric entry will cancel the data entry operation.

Maximum Specifies the maximum time that the numeric entry will wait for the operator’s
Waiting Time | confirmation. The data entry will be cancelled if the operator does not respond within
this time.
Operation Operation Check this option so the following three items will be recorded in the operation log
Logging Logging when the numeric entry outputs the entered value.
There are three recorded items:
1) The time when the operation is performed
2) The entered value
3) The predefined operation message
Message Enter the operation message of the first language here.

L]

Click this button to bring up the Operation Message dialog box that you can edit the
operation message for all the languages.
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7.2. Numeric Displays

You can use a numeric display to show the value of the specified variable.

7.2.1. Operation Options

The following operation options can be added to a numeric display. Select and set up the options in the Numeric Display
property sheet.

Options Description

Scaling The value of the monitored variable will be scaled by the following formula before it is
displayed.

DisplayedValue = MonitoredValue * Gain + Offset

Select and set this option in the Advanced page.

Note: The Gain and Offset are 32-bit floating point numbers. They have at most 6 significant
digits. The rounding and truncation errors may happen.

Range Display You can specify a low limit and a high limit for the numeric display. The limits can be
constants or variables. At runtime, when the value of the monitored variable is below the low
limit, the numeric display shows the value with the text color and the BG color set for the low
limit. When the value of the monitored variable is over the high limit, the numeric display
shows the value with the text color and the BG color set for the high limit.

Visibility Control You can show and hide the numeric display by the specified bit or the current user level.
Select and set this option in the Visibility page.

7.2.2. Settings

You can complete all the settings of a numeric display in the Numeric Display property sheet. This sheet contains the
following four pages. Some of the pages appear only when they are needed.

m General
Described in Section 7.2.3.

m Advanced
Described in Section 7.2.4.

m  Visibility
Described in Section 4.4.6.

m  External Label
Described in Section 4.3.8.
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7.2.3. General Settings

This section describes how to define the general settings for a numeric display. The following is an example of the General
page of the Numeric Display property sheet.

0 0 | 1
Numeric Display |
o Langl o -9993 o

d ! L Leneral | Advanced | Visibility | External Label

D Note: ||

[] Transparent B ackground

External Label

Border Color:
HO_BDRA BG Color:

Data Tope: 32-Bit Signed Integer W

Monitor &ddress:  [WE

Font: | Trebuchet M5 b [:]
Alignment Juztification

Text Caolar:

i L [E ) Left (%) Zero Suppress

Taotal Digits: |4 & (&) Center ) Leading Zeros

) Right ) Leading Spaces

Fractional Digits: |0 &

[ ()4 ] [ Cancel ] [ Help
The following table describes each property in the General page.
Property Description

ID The object’s identifier. It is generated when the object is created. The identifier is unique within
the screen where the object is on. The format of the ID’s for the numeric displays is NDnnnn.

Note You can type a note for the object.

Transparent Select this option if you want the object to have a transparent background.

Background

Shape settings For details about the following properties, see Section 4.3.4 Setting up the Shape of an Object..
, Border Color, BG Color

External Label Check this option if you want the object to have an external label. Set up the external label in the
External Label page.

Data Type The data type of the monitored variable. The supported data types include: 16-Bit Unsigned
Integer, 32-Bit Unsigned Integer, 16-Bit Signed Integer, 32-Bit Signed Integer, 16-Bit BCD, 32-Bit
BCD, 32-Bit Floating Point, 16-Bit Signed BCD (LMB), 32-Bit Signed BCD (LMB), 16-Bit Signed
BCD (LMD), and 32-Bit Signed BCD (LMD).

Continued
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Property Description
Display Type The display type for the value of the monitored variable. The following table shows the available
display types for each data type.
Data Type Available Display Types
16-Bit Unsigned Integer 16-Bit Unsigned Decimal, 16-Bit Hexadecimal, 16-Bit Octal
32-Bit Unsigned Integer 32-Bit Unsigned Decimal, 32-Bit Hexadecimal, 32-Bit Octal
16-Bit Signed Integer 16-Bit Signed Decimal
32-Bit Signed Integer 32-Bit Signed Decimal
16-Bit BCD 16-Bit Unsigned Decimal
32-Bit BCD 32-Bit Unsigned Decimal
32-Bit Floating Point 32-Bit Floating Point
16-Bit Signed BCD (LMB) 16-Bit Signed Decimal
32-Bit Signed BCD (LMB) 32-Bit Signed Decimal
16-Bit Signed BCD (LMD) 16-Bit Signed Decimal
32-Bit Signed BCD (LMD) 32-Bit Signed Decimal
Monitor Address Specifies the monitored variable.
Click to enter an address for this field. Click to select a tag for this field.
Font The font of the displayed value.
Text Color The color of the displayed value.
Total Digits The number of digits to be displayed.

Fractional Digits

When the Display Type is 32-bit Floating Point, this property specifies the number of fractional
digits to be displayed.

When the Display Type is not 32-bit Floating Point, this property specifies not only the number of
fractional digits to be displayed but also the number of least significant digits to be displayed as
the fractional part. With this feature, an integer can be shown as a fixed point number.

Example:

Display Type ch;tlatls FraD?;i;::al Justification Mc:;lailtl?;ed Dif,zll?éed
32-bit Floating Point 4 Zero Suppress 12.34 12.34
32-bit Floating Point 4 Zero Suppress 123.4 23.40
16-bit Signed | 5 2 Zero Suppress 12345 123.45
Decimal
16-bit Signed | 5 2 Zero Suppress -5 -0.05
Decimal
Alignment The alignment of the displayed value. There are three types of alignment: Left, Center, and Right.
Justification The justification of the displayed value. There are three types of justification:

Option Description

Zero Suppress The leading digits will not display when they are 0.

Leading Zeros All digits will display.

Leading Spaces The leading digits will display as blank character when they are 0.

»
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7.2.4. Advanced Settings

This section describes how to define the advanced settings for a numeric display. The following is an example of the
Advanced page of the Numeric Display property sheet.

General | Advanced | Visibility | Esternal Label

Scaling
Gain:  |1.14

Offzet: |0

Range Dizplay
[]*ariable Range
Lows Limit:  |-300
High Limit: | 500
High Color Lo Calar

Text Color: @] Text Color:
BG Color: E BG Color: @]

The following table describes each property in the Advanced page.

Property Description
Scaling | <Check Box> Check this option if you want the value of the monitored variable to be displayed in a
scaled manner. The following is the scaling formula.
Displayed Value = Monitored Value * Gain + Offset

Note: The Gain and Offset are 32-bit floating point numbers. They have at most 6
significant digits. The rounding and truncation may happen.

Gain The Gain of the scaling formula.
Offset The Offset of the scaling formula.
Range <Check Box> Check this option if you want the numeric display to display the value with different
Display color when the value is below the specified low limit or over the specified high limit.
Variable Range Check this option if the low limit and high limit are specified by the designated

variables at runtime.

Low Limit Specifies the low limit when the Variable Range is not selected.
When the Variable Range is selected, this property specifies the variable that stores

the low limit at runtime. Click to enter an address. Click to select a tag.

High Limit Specifies the high limit when the Variable Range is not selected.
When the Variable Range is selected, this property specifies the variable that stores

the high limit at runtime. Click to enter an address. Click to select a tag.
High Text Color | The text color for the high limit.

Color "BG color | The shape’s BG color for the high limit.

Low Text Color | The text color for the low limit.

Color BG Color The shape’s BG color for the low limit.
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7.3. Advanced Numeric Displays

7.3.1. Advanced Features
An advanced numeric display provides the following advanced features:
1) You can specify an arithmetic expression or a macro for the object to calculate the display value.

2) You can specify an arithmetic expression or a macro for the object to convert the operator entered value to the output
value.

3) You can specify up to 10 ranges for the object to display.

7.3.2. Operation Options

The following operation options can be added to an advanced numeric display. Select and set the options in the Advanced
Numeric Display property sheet.

Options Description

Range Display The advanced numeric display can support up to 10 fixed ranges or 3 variable ranges. You
can define the text color, the BG color, and the lower bound for each range. At runtime, the
advanced numeric display uses the color settings for the range to which the value belongs to
display the value.

Range Check The advanced numeric display will verify the entered value according to the specified
maximum and minimum. If the entered value is not within the allowable range, the value will
not be output. Select and set this option in the Range page.

Note: If the output expression or the output macro is defined, the converted value stored in
the variable $W instead of the entered value is verified.

Touch Operation You can enable and disable the touch operation of the advanced numeric display by the
Control specified bit or the current user level. Select and set this option in the Advanced page.
Timeout The keypad displayed for the advanced numeric display will be closed and the data entry

operation will be cancelled after the keypad receives no input for the specified time period.

Notification The advanced numeric display will notify the specified bit when it finishes outputting the
entered value. Select and set this option in the Advanced page.

Operator Confirmation | The Confirmation box will be displayed when a value is entered for the advanced numeric
display. If the operator selects “Yes” in the Confirmation box, the advanced numeric display
will write the entered value to the specified variable. If the operator selects “No” or the
operator does not respond within the specified time period (Maximum Waiting Time), the
advanced numeric display will cancel the data entry operation.

Select and set this option in the Advanced page.

Operation Logging The time, the entered value, and the predefined operation message will be recorded when
the advanced numeric display outputs the entered value. Select and set this option in the
Advanced page.

Visibility Control You can show and hide the advanced numeric display by the specified bit or the current user
level. Select and set this option in the Visibility page.
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7.3.3. Settings

You can complete all the settings of an advanced numeric display in the Advanced Numeric Display property sheet. This
sheet contains the following seven pages. Some of the pages appear only when they are needed.

m General
Described in Section 7.3.4.
= Range

Described in Section 7.3.5

m Advanced
Described in Section 4.4.5.

m Visibility
Described in Section 4.4.6.

m  External Label
Described in Section 4.3.8.

m Display Macro
Described in Section 14.2.6.

m  Output Macro
Described in Section 14.2.6.

7.3.4. General Settings

This section describes how to define the general settings for an advanced numeric display. The following is an example of
the General page of the Advanced Numeric Display property sheet.

Advanced Numeric Display &l
General | Range | &dvanced | Visibiity | Output Macmo

10 Mote:

[] Tranzparent B ackground Fart: | Ter Can AT 3 [:]

Shape... CJExtemal Label Text Color: @
Barder Calar: Tatal Digits: |4 £
DE_oo BG Colar: Fractional Digits: |0 3

Aligrment

() Left (% Center ) Right

Data Type: | 16-Bit Unsigned Integer %

Dizplay Type: | 16-Bit Unsigned Decimal — »

Dizplay Juztification

() Monitor Address: (%) Zero Suppress
@) Expression: $0 = | [wB0+wE1 #w/B2+w/83]/4-20 O Leading Zeros
() Macmo  [FThe value to be displayed should be assigned to $D) () Leading Spaces

Operator [nput

Wiite Address [$w); (w4

Cutput
() Direct: $4 = $K [$K represents the keypad input]

() Expression:

@ Macra  [The value to be output should be azzigned to W)

QK H Cancel ” Help
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The following table describes each property in the General page.

Property Description
ID The object’s identifier. It is generated when the object is created. The identifier is unique
within the screen where the object is on. The format of the ID’s for the advanced numeric
displays is ANDnnnn.
Note You can type a note for the object.

Transparent Background

Select this option if you want the object to have a transparent background.

Shape settings

For details about the following properties, see Section 4.3.4 Setting up the Shape of an

Object, , Border Color, BG Color

External Label

Check this option if you want the object to have an external label. Set up the external label
in the External Label page.

Data Type The data type for the variables, arithmetic expressions, macros of the advanced numeric
display. The supported data types include: 16-Bit Unsigned Integer, 32-Bit Unsigned
Integer, 16-Bit Signed Integer, 32-Bit Signed Integer, 16-Bit BCD, 32-Bit BCD, 32-Bit
Floating Point, 16-Bit Signed BCD (LMB), 32-Bit Signed BCD (LMB), 16-Bit Signed BCD
(LMD), and 32-Bit Signed BCD (LMD).
Display Type The display type for the advanced numeric display. The following table shows the available
display types for each data type.
Data Type Available Display Types
16-Bit Unsigned Integer 16-Bit Unsigned Decimal,
16-Bit Hexadecimal,
16-Bit Octal
32-Bit Unsigned Integer 32-Bit Unsigned Decimal,
32-Bit Hexadecimal,
32-Bit Octal
16-Bit Signed Integer 16-Bit Signed Decimal
32-Bit Signed Integer 32-Bit Signed Decimal
16-Bit BCD 16-Bit Unsigned Decimal
32-Bit BCD 32-Bit Unsigned Decimal
32-Bit Floating Point 32-Bit Floating Point
16-Bit Signed BCD (LMB) | 16-Bit Signed Decimal
32-Bit Signed BCD (LMB) | 32-Bit Signed Decimal
16-Bit Signed BCD (LMD) | 16-Bit Signed Decimal
32-Bit Signed BCD (LMD) | 32-Bit Signed Decimal
Display | Monitor Select this option so the advanced numeric display will monitor the variable specified in the
Address Monitor Address field and display its value. When this option is selected, you need to
specify the monitored variable.
Click to enter an address for this field. Click to select a tag for this field.
Expression Select this option so the advanced numeric display will display the result of the arithmetic
expression specified in the Expression field. When this option is selected, you need to
specify the arithmetic expression that calculates the value to be displayed.
Click to enter an address for this field. Click to select a tag for this field.
Macro Select this option so the advanced numeric display will run the macro defined in the Display
Macro page before displaying the value of the internal variable $D. The macro can decide
the value to be displayed by saving the desired value in the internal variable $D.

Operator Input

Select this option so the advanced numeric display will allow the operator to enter values for
it.

Continued
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Property

Description

Write Address

Specifies the destination variable where the entered value will be written to when the Operator
Input is selected. Click to enter an address for this field. Click to select a tag for this field.

Output | Direct

Select this option so the advanced numeric display will write the entered value to the destination
variable specified in the Write Address field directly.

Expre-
ssion

Select this option so the advanced numeric display will write the result of the arithmetic expression
specified in the Expression field. When this option is selected, you need to specify the arithmetic
expression that calculates the value to be output. To use the entered value as an operand in the
expression, specify the internal variable $K for the entered value.

Click to enter an address for this field. Click to select a tag for this field.

Macro

Select this option so the advanced numeric display will run the macro defined in the Output Macro
page before writing the value of the internal variable $W to the destination variable. The macro can
decide the value to be output by saving the desired value in the internal variable $W. To use the
entered value in macro commands as a parameter, specify the internal variable $K for the entered
value.

Font

The font of the displayed value.

Text Color

The color of the displayed value.

Total Digits

The number of digits to be displayed.

Note: This property applies to the display of the initial value, the allowable minimum, and the
allowable maximum on the numeric keypad.

Fractional Digits

When the Display Type is 32-bit Floating Point, this property specifies the number of fractional
digits to be displayed.

When the Display Type is not 32-bit Floating Point, this property specifies not only the number of
fractional digits to be displayed but also the number of least significant digits to be displayed as the
fractional part. With this feature, an integer can be shown and entered as a fixed point number.
When the Fractional Digits is nonzero, say N, the entered value will be converted to an integer
according to the following formula before being output.

Output Value = Entered Value * (Nth power of 10)

Example 1:
Display Type B?éﬁls Erigic;'gonal Justification \I\;I;Egored Bgﬁfyed
32-bit Floating Point 4 2 Zero Suppress 12.34 12.34
32-bit Floating Point 4 2 Zero Suppress 123.4 23.40
16-bit Signed Decimal | 5 2 Zero Suppress 12345 123.45
16-bit Signed Decimal | 5 2 Zero Suppress -5 -0.05
Example 2:
Display Type T(_)tgl F(a_ctional Entered Output
Digits Digits Value Value
32-bit Floating Point 4 2 12.34 12.34
32-bit Floating Point 4 2 123.4 Error!
16-bit Signed Decimal 5 2 123.45 12345
16-bit Signed Decimal 5 2 -0.05 -5
16-bit Signed De